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1. CONCEPTUAL ISSUES

Chapter by: Ann Forsyth (major draft), Michael Oakes (statistics and sampling), Kathryn Schmitz
(measurement); fact checking by Joel Koepp (data), Jason Zimmerman (data).

Note, this chapter has had only minor revisions compared with versions 2.0 and 2.1. However, additional
information about data storage and sharing were included in Chapter 8 in version 2.2.

1.1. Protocol Purposes and Audiences

This manual provides protocols for measuring environmental variables associated with
walking. It reflects work in progress. This is version 2.2 of the manual. Version 3.0 will be
completed during the late summer of 2005.

The manual has four purposes.

e It records the methods for environmental measurement used in the Twin Cities Walking
Study so that the research team can replicate its own findings at a later date and so
different measurement staff share common definitions and processes. GIS systems are so
multifaceted that seemingly simple decisions made at one time have ramifications for
future work. Without a formal communications mechanism that makes such decisions
explicit and organizes them errors can be left unrecognized, compounding measurement
problems.

¢ The documents methods for replication. The funder of the Walking Study, the Robert
Wood Johnson Foundation (RWJF), expressed interest in documenting methods well
enough to have at least some measurements replicated across other RWJF study teams in
order to allow later meta-analysis.

e It provides a preliminary prototype for other such manuals that may be produced by
different teams. However, it is also possible for other teams to merely modify this
manual, with attribution.

¢ The manual aims to make GIS research methods and data sources less opaque,
particularly to public health researchers who have not used such data.

These four purposes correspond to the audiences for this manual: (1) the initial research team,
(2) other RWJF grantees, (3) other research groups doing this kind of environmental
measurement, and (4) researchers not particularly familiar with GIS but interested in
understanding the strengths and limitations of GIS-based measures of environmental features
potentially correlated with physical activity.

It responds to a general problem in the literature on measuring environmental features thought
to be associated with physical activity—that is, a lack of standards for how to define key
measurement variables. While there are notable exceptions that we cite in particular protocols,
researchers rarely provide detailed formulae for the calculations of specific variables or even
their detailed approach to conceptualization (e.g. was water included in the land area
calculations). Further, few publication venues are available for explaining the details of
measurement that are highly dependent on the capacities of specific Geographic Information
Systems software.
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1.2 Organization of the Protocols Manual

The manual is in six sections.

e Chapter 1, on conceptual issues, deals with the organization of the manual, how it was
produced, data sources, and measurement geographies.

e Chapter 2 includes protocols for measuring items that are not in themselves possible
measures of walkability, but that are components of such measures. An example is land
area.

e Chapters 3 though 6 look in turn at measurements of density, pedestrian infrastructure,
mixed use, and street patterns.

e Chapter 7, new in version 2.2, outlines some measures of variables related to the built
environment e.g. traffic and safety.

e Chapter 8 examines a number of crucial issues related to data storage and sharing.

e Appendices and references are at the end of the manual.

Protocols themselves take a specific format. Each one contains six main parts:

1. Basic Concept: This is a very rudimentary idea, often backed up by references to the literature
from which it is drawn. While it is very rudimentary, in journal articles it is quite common to
find it as the only type of description of a variable.

E.g. gross population density, without water, is the overall residential population
divided by the land area.

In this protocol manual, this section also cites sources as to why this variable is
important as a measure of the environment.

2. Basic Formula or Basic Definition or, in one case, Basic Procedure: This provides a more specific
formula or definition.

E.g. Population per Unit Land Area (without water) = Persons in housing units per unit
gross area excluding water.

3. Detailed Formula or Detailed Definition: This provides a more specific formula that includes
data sources or a more detailed definition.

E.g. Population per Unit Land Area (without water) = Persons in housing units as
measured in the US Census at the block level per unit land area excluding area of water
features as measured in the Ramsey County layer or the Metropolitan Council water
layer for areas outside Ramsey (with the nature of these layers explained, e.g. Ramsey
County includes all visible water).

4. Comments and Explanations. These include answers to more detailed questions that will likely
arise as measurements are made. This is also the location for warnings about potential sources
of error.

ENVIRONMENT AND PHYSICAL ACTIVITY: GIS PROTOCOLS VERSION 2.3, August 2005, WORK IN PROGRESS
University of Minnesota, Twin Cities Walking Study, Metropolitan Design Center



E.g. Where census blocks are cut by the end of the measurement geography, the
population is apportioned according to the percentage of land area falling inside and
outside the line.

The Ramsey County water layer includes all water visible in very high resolution digital
orthophotos, though not such features as swimming pools (see more detail in chapter
2)]. For the one area outside Ramsey County We used the Metropolitan Council’s 200
Water Feature Layer (again, more details are in chapter 2).

5. GIS Approach: This section outlines the big steps involved in making the measurement. An
expert GIS user could work from this list to perform the measures and would need to do so if
using software other than the ESRI ArcGIS suite of software.

6. GIS Steps. The GIS steps section, in smaller print, involves detailed GIS instructions using
ArcGIS 8 or ArcGIS 9 and designed to be comprehensible by someone who does not use GIS
every day (e.g. a principal investigator). The study team completed them for four main reasons:

e They mean that the team didn’t have to reinvent the wheel when going back to do
measurements a second time

e They allowed investigators and other GIS fellows, to discuss how well the GIS functions
actually represented the concepts being measured

e They allowed some measurements to be conducted by lower level users such as research
assistants (and principal investigators)

e They also allowed us to avoid some inconsistencies—for example when locating the
centroid of crescent shaped polygons, one function in ArcGIS 8 allows it to be outside
the polygon and one does not. Because we had recorded the exact function we used, we
were able to check that we had been consistent in this measurement.

It should be noted that these steps often indicate one of several ways to do measurements.

In addition, after version 1.0 of this manual was completed we were forced by university
policies to upgrade our GIS to ArcGIS 9. To do this we had to uninstall ArcGIS 8. This manual is
still largely based on ArcGIS 8 but will gradually be converted to ArcGIS 9.

Additional Information on this Version of the Manual
This is version 2.3 of the protocols. There are a number of refinements that we will undertake in
upcoming versions.

e Links to the Literature: These measures are based on a systematic review of the literature.
The sources, uses, and limits of variables and measurement approaches have been
tracked in our internal documentation. However, this version does not reflect all this
work. Later versions will be increasingly complete in this area or will refer to other
papers to be published by the Twin Cities Walking Study team.

e GIS Steps: We are continually experimenting with automating more steps.

e GIS Steps: Because this work in progress, at least some of the GIS steps have only been
tested once, by the person who wrote them, and feedback will be welcome. In addition,
some were developed for ArcGIS 8 and have not yet been converted to ArcGIS 9.
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1.3 The Context of the Manual: The Twin Cities Walking Study

The manual was written in the context of a research project measuring the walkability of
residential environments in the environmentally diverse northern sector of the Minneapolis-St.
Paul metropolitan area.

Partly in order to undertake additional environmental fieldwork in areas known to be
environmentally diverse, and partly due to recruitment logistics for the people in the study, the
research focused on 36 discrete focus areas, 0.5*0.5 miles (805805 meters) in size, selected for
variation along two dimensions hypothesized to be important for physical activity: (A) gross
population density (B) street pattern (measured as median block size).' The study sites were
selected to represent a subset of the most extreme areas—ranking high or low on each of these
two dimensions—nine sites with high density and small blocks, nine with high density and big
blocks, nine with low density and small blocks, and nine with low density and big blocks. Low
population density was set at below 5 persons per gross acre (12.4 per hectare) for a 0.5*0.5mile
(805*805 meter) area, high density we defined as 10 per acre (24.7 per hectare) and above. All
density calculations excluded the land area covered by water, an important issue in Minnesota.
Small median block size was defined as below 5 acres (2.0 hectares) which was related to
standard block sizes in the area. Large blocks were larger than 8 acres (3.2 hectares). Areas also
had to have at least 18.75 percent of their land area in residential land use and a population of at
least 200 (paragraph adapted from Forsyth et al 2004a).”

In each focus area, approximately twenty residents were recruited to wear a motion detector (an
accelerometer) for seven days, complete a seven-day travel diary, have their height and weight
measured, and answer a number of surveys dealing with demographic, attitudinal, and
socioeconomic issues (Forsyth et al 2004a). The final total was 717 and 20% had repeated the
measures. This is one of the first large studies to have very detailed objective physical activity
measurement and very detailed environmental measurement.

Several aspects of this study are important to understand when using this manual:

e Results yet to come: At the time of preparing this version (2.3) of these protocols, all data
collection is complete and much measurement of environmental variables but analysis is
not yet complete. That means that we do not yet know which of these measures matter.

e Utilitarian walking: The study focused on utilitarian walking—earlier research indicated
that such walking is most affected by environment (compared with recreational
walking, for example). While the study is measuring all kinds of walking and physical
activity though accelerometry (motion detection), surveys, and a travel and walking
diary, the environmental measures were selected through the lens of those features most
likely to be associated with utilitarian walking (working for transportation to work,
errands, etc). The main focus of the research is on the residential environment although
as data were collected on work environments, where applicable, many measures were
also applied to those environments.

e Four categories of measures: Based on a review of earlier research, the study proposed that
four kinds of variables might be associated with how much people walk: population
density, pedestrian infrastructure and amenities, mixed use or destinations, and street
pattern or connectivity. However, we are cast our net very widely in terms of actual
environmental measurements and will add more transportation related measures in a
later version. One of the results of the study will be better knowledge about which
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environmental variables are most correlated with measured walking and other physical
activity at what scales. However, the study is also measuring a variety of other variables
correlated with walking including those with a spatial component (traffic) and those that
are more purely social or psychological.

GIS data: The study area was selected because it had excellent GIS data. However, we
still faced some difficulties with less consistent data on the edge of the study sector, and
with specific topics such as street trees and sidewalks that were not collected
consistently. Specific data issues are discussed below.

Urban design inventory: As RWJF funding recipients, we promised to build on an earlier
round of RWJF funding to develop measurement instruments. Of the measurement
grants involving original data collection, one draft inventory was available at the time of
our data collection—the inventory by a team led by Marlon Boarnet and Kristen Day or
UC Irvine. The Twin Cities Walking Study team modified this inventory and the two
groups are currently combining inventories into what will be the Irvine-Minnesota
inventory (Forsyth et al 2004a; Day et al. 2005). This inventory is based on a sample of
road segments, for focus areas and a 0.25 mile (402 meter) buffer around them, and some
protocols deal with these sampled segments.

1.4 Steps in Developing the Manual

The Twin Cities Walking Study essentially consists of three overlapping teams: environmental
measurement; physical activity measurement; and statistics. This manual was developed
primarily by and for the environmental measurement team, though with input from and in
coordination with the other two teams. In addition, it enabled the three teams to communicate
clearly about environmental measurements.

The manual was developed in several steps:

Listing and revising the list of variables: A list of variables was developed based on
variables used in research to date. Additional variables were added related to those that
should be important according to the literature, modified by what data were available.
This was revised a number of times to reflect recent developments in the literature, the
availability of new data, developments in our own research, and to coordinate with
other RWJF grantees.

Creating the basic formulae: Where variables had been used by others, these sources were
reviewed and are cited. Drawing either on this literature, or working from first
principles or at a more conceptual level, the equivalent of the “basic concept” and “basic
formula” were developed (see section above). These two steps were mostly done by Ann
Forsyth, with useful input from Kathryn Schmitz and Michael Oakes. It should be noted
that this version does not contain citations for every instance of use of particular
measures. We will be incorporating them incrementally in subsequent versions but
cannot hope to find all uses. If readers have used some of these measures and want to be
cited, please email the editor of this manual.

Troubleshooting the details: At this stage the GIS technical team was brought on board to
develop more detailed methods for measuring the variables, trying them out on focus
and context areas as the final set of participant addresses was not yet known and many
of the buffer measures could not be developed (see below for an explanation of
measurement geographies). Operationalizing many of the measurements was not at all
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straight forward. The kinds of issues dealt with included those we outline in the
“detailed formula” and “comments and explanations” sections of the protocols. The
issues were discussed in weekly GIS team meetings that were partially minuted, emails,
and via research logs. These modes of recording are discussed in more detail in section
1.7. While Ann Forsyth had the final say on measurement, Jason Zimmerman and Joel
Koepp did very important work identifying problems and discussing how to
operationalize measurements in GIS.

e GIS Work: GIS strategies were then written by Jason Zimmerman and Joel Koepp, and
are in two forms. The GIS Approach section gives an overview of tasks, and the GIS Steps
are intended to be useable by moderately trained GIS users.

o Assembly and refinement: At this stage the protocols could be assembled, edited, and
refined. This version of the protocols is part of that development stage, allowing
protocols to be tested operationally and reviewed to ensure that the detailed
measurement steps fully reflect the concepts. The protocols can also be tested by others
who may also offer critiques.

Note, authorship is indicated in each chapter as a way of enhancing internal coordination in the
study team.

1.5 Data

Problems
There are a number of problems with available GIS data, apart from common errors (see
Forsyth et al. 2005a).

Geographies: Different environmental variables are measured using different geographies e.g.
parcels, blocks, street segments. Not all data are available for very small geographical areas—
for example much economic data is only released in aggregate form. However, it is possible to
have very small aggregations constructed—akin to census blocks.

Consistency: GIS data are not consistently collected across the United States or even within
municipalities. Where national data are available these protocols can be used directly. Where
this is not the case, care needs to be taken in transforming the data that do exist, collecting new
data, or limiting inappropriate comparisons where data cannot be matched.

Purpose: Most GIS data are not collected to answer questions about physical activity and the
built environment but are rather collected in order to manage infrastructure investments, collect
taxes, keep government records, and manage transit systems.

Accuracy: Different kinds of data are available at accuracy, many used for broad environmental
monitoring and not accurate enough for research into physical activity e.g. tree coverage data at
the 1-2 ha level.

Completeness: Many forms of data are only available for part of the environment—from urban
design inventories using a sample to traffic counts only available for major roads.

Time: Data are complicated to collect so are only available for certain times so it is common for
parcel data, roads, and aerial photos to come from slightly different times and thus be slightly
different to each other.
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Finally, where data are collected, they are not always freely available. Conducting a study such
as the Twin Cities Walking Study involved a number of separate data licensing agreements and
thousands of dollars in direct purchasing costs.

Specific data sources that we used included:

U.S. Census
WWW.CEeNsus.gov

Description: SF1 files at the block and block-group level and SF3 at the block group level.
Metadata: Metadata for census variables are available in a number of parts of the census web
site. For details on downloading large SF# files see
http:/ /www.census.gov /support/SE3ASCILhtml

MetroGIS
www.metrogis.org
www.datafinder.org

Description: This is the GIS group supported by the Metropolitan Council of the Twin Cities, a
state agency that does planning and analysis for seven counties at the core of the Twin
Cities metropolitan area. Their data include a number of useful layers complete with
metadata and accessible from http:/ /www.datafinder.org/catalog.asp. Not all data are
free and many require specific agreements to be made between the user and the data
owner:

General data (useful but not as detailed as Ramsey /I-35W data)

2000 Digital Orthophotos (2 foot per pixel resolution)

Generalized Land Use, 2000

Counties, Cities and Townships

MetroGIS Regional Parcel Dataset - Current (updated quarterly) (unavailable in 2004
due to a legal dispute but made available in 2005)

Water Features from 2000 Land Use Data (supplements Ramsey County water layer)

Parcels beyond Ramsey

Anoka County Parcel Layer
Dakota County Parcel Boundaries
Hennepin County Parcel Layer

The Lawrence Group (TLG) Data—Streets, Points of Interest, and Census

Census Geography 2000 — TLG Aligned; Blocks, Block Groups & Tracts This is the
MetroGIS endorsed version of the census data and the one we used. It has the census
geographies better aligned with the TLG road layer

TLG Landmarks — Areas of Interest

TLG Landmarks — Lines of Interest

TLG Landmarks — Points of Interest

TLG Street Centerline Edits Table

TLG Street Centerlines and Address Ranges

Buses
Bus Route Segments
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Bus Routes
Bus Service
Bus Shelters

Bus Stops
Transit Centers

Other
Regional Trails — Existing and Proposed

Metadata: Most are available linked to the data finder web site at
http:/ /www.datafinder.org / catalog.asp

Ramsey County, Cities in Ramsey County, and I-35W Corridor Coalition
http:/ /www.ramseygis.com / Webpages /
http: / /www.i35w.org / gis.html

City of New Brighton
Boulevard Trees
Sidewalks

City of Roseville
Sidewalks

City of St. Paul

Lighting (incomplete)
Park Property
Recreation Centers
Sidewalks (incomplete)
Street Trees (incomplete)

Description: We used local data from two overlapping sources—The I-35W Corridor Coalition,

a group of seven suburban municipalities that had cooperated to produce very
consistent GIS data. Six of the cities were in Ramsey County. Ramsey County had
created a data guide with much of the metadata. The I-35W Corridor Coalition had a
GIS consultant who provided other Corridor metadata via email. In general, Ramsey
County had a great deal of fairly well documented data, including very recent high
resolution digital orthophotos (resolution of one foot per pixel). However, the I-35W
Corridor Coalition had some already existing Excensus data (see below) and while
Corridor land uses were in broader categories than Ramsey County they were updated
more regularly.

The following list gives a sense of the sources available in Ramsey County, which has

produced a data guide (Roman 2001). The Coalition member in Anoka County

sometimes lacked some of these data layers (although in our case, only one focus area

fell in Anoka). Data include:

» Parcel boundaries: County assessors and surveyor’s records, updated monthly

» Physical features such as structures and water: Aerial photography, updated early
2002

» Digital Orthophotos: one foot per pixel photos from the county surveyor’s office,
2003
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» Land use data in six major land use classes (agriculture, industrial, commercial,
residential, exempt which includes many public buildings, and other). Each major
classification is further subdivided into between six and 50 detailed subclasses. For
example the commercial land uses include about 50 subclasses such as “office
building 1-3 stories,” “gas station,” “automotive service station,” community
shopping center,” “restaurant, cafeteria, and/or bar” and “flex industrial center”.
Some data subclasses are further subdivided and available at even more detailed
levels, for example “Dairy Queen” or “TGI Fridays”

Metadata: Some metadata are available via the Ramsey County Data User’s Handbook, on line
at http:/ /www.ramseygis.com / Webpages / Hand%20Book.html. The I-35W Corridor

Coalition has separate land use metadata (see Appendix 1A).

Excensus

http:/ /excensus.gritechnologies.com / about.pl

Description: The employment data that we used evolved over time. At first we proposed using
data from a private Twin Cities consulting firm, Excensus, that had created very small
area data sets, often updated annually, compiled from state, county, and local
government sources such as Minnesota postal files, and data from water utilities,
driver’s licenses and vehicle registrations, the school district census, and property
assessors. State employment data are also available but had to be aggregated and we
selected a 100*100m (1 hectare) grid cell for aggregating data.

For some complex reasons, Excensus generally used Dun and Bradstreet data for our
study, checked these data against other sources. We then used the original point files
and did not aggregate into 1 hectare cells.

Metadata: See Appendix 1B.

We also collected or mapped new data.

Digitized Street Trees, Street Lamps, and Sidewalks

Description: There were no consistent street tree, street lamp, and sidewalk data. Working from
the Ramsey County digital orthophotos we first digitized these for all study areas and
then field checked them. In a few cases we had data from cities but these also needed to
be checked and updated. Digitizing was done by research assistants but checking of all
data was done by a GIS Research Fellow.

Metadata: See Appendix 1C.

Irvine-Minnesota/Modified Boarnet-Day Inventory

Description: The research team used a 160+ question inventory to collect information about
urban design features and pedestrian infrastructure in 20% of street segments. The Twin
Cities Walking Study Team modified an inventory prepared by another team of
researchers from UC Irvine. More information is available in (Forsyth et al 2004a). The
two versions are currently being combined and will be available on the Active Living
Research site in 2005. They are currently available in draft form at
http:/ / webfiles.uci.edu/kday/public/index.html.

Metadata: See Forsyth et al. (2004a) and forthcoming publications.

ENVIRONMENT AND PHYSICAL ACTIVITY: GIS PROTOCOLS VERSION 2.3, August 2005, WORK IN PROGRESS 14
University of Minnesota, Twin Cities Walking Study, Metropolitan Design Center



1.6 Measurement Units

In the US there is a decision about Metric or Imperial / English units. Many people in GIS use
both as we did in the study, although we migrated from Imperial to Metric. We used a 0.5*0.5
mile square focus area largely because in the study area it matched the arterial grid. We used
feet in discussing many features that had been created in feet—from parcels to sidewalks. Miles
were used in many of the standard surveys used in the rest of the project, and in the travel diary
adapted from the National Household Travel Survey measures were in blocks and miles.

However, as we increasingly used measurements involving buffering of individuals, the
measurement geographies became so idiosyncratic that metric made as much sense to use.
Version 2.0 of these protocols is the first fully metric version (we hope!)

We were also saved by some easy correspondences that meant converting to metric meant that
measurements were close to those that had been developed in Imperial/ English units:

1 mile = 1609.3 meters (rounded to 1600 for measurements)

0.5 miles (half) = 804.7 meters (rounded to 800)

0.25 miles (quarter) = 402.3 meters (rounded to 400)

0.125 miles (eighth) = 201.2 meters (rounded to 200)

one sixteenth of a mile = 100.6 meters (rounded to 100)

1.7 Measurement Logistics

Another note concerns the organization and practices of measurement teams using these
protocols. The protocols were in part designed for the Twin Cities Walking Study team’s
internal use. They make explicit the myriad of decisions that go into even fairly simple
environmental measurement. In particular:

e They allow the investigators and GIS technical staff to communicate with each other so
that it is clear that measures conform to the concepts being tested.

e They also help communication among the investigators.

We hope the protocols will both allow measurements to be replicated more accurately and
streamline the technical process of measurement.

However, given the quite varied data availability and formats it is vital that the investigators
and GIS technical staff communicate about variations as decisions that seem small and
innocuous to GIS staff can alter measures in significant ways and concepts of interest to
investigators may not be simple to operationalize with different GIS data. These protocols were
one way of communicating about these issues, however, we also used (1) decision logs, (2)
emails, and (3) minutes. An excerpt from a decision log is on the next page. Emails were the
bases for some of the protocols. Minutes of weekly meetings focused on action items and major
decisions and were also emailed. Emailed minutes of weekly project meetings are a standard
procedure in the office.
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RWJF Decision Log — Jason Zimmerman
[Note, Jason worked one day per week during this period]

Week ending: GIS decisions made:

02.06.04 Will not try to convert New Brighton street light layer to GIS due to complexity of
conversion and time lost to process. Instead, will use printout as a reference
when digitizing layers from the orthophoto (data is from 1986 and would need to
be carefully checked anyway).

02.13.04 [None — prepared questions/issues related to GIS variables]

02.20.04 Census blocks used for calculations if center of block (centroid) falls within the
site area (both focus areas and context areas).

average census block size — selected all census blocks that had their centers
in the site areas; converted area (in meters) to acres by multiplying by
0.0002471; opened table in Excel and calculated average size

median census block size — selected all census blocks that had their centers
in the site areas; converted area (in meters) to acres by multiplying by
0.0002471; opened table in Excel and calculated median size

02.27.04 We decided on the following set of rules regarding access points:

1. The first set of access points will be created from the intersections of all
roads from the TLG data layer and the boundaries of the focus and
context areas.

2. The second set of access points will remove points that result from
intersections with Interstates as well as on- and off-ramps. It will also
remove one access point from each pair of points created by parkways
and other divided at-grade roads.

3. The third set of access points will remove the points in Set Two and
also remove marginal points that are just inside the edge of the site
boundary, do not extend into the site, and have no other roads with
access into the site within 330 feet.

Set One was created in ArcMap and the points counted automatically for both
the focus and context areas. Set Two was created by manually removing the
Interstate, ramp, and divided road points. For Set Three, a buffer of 330 feet
was created around each of the access point. Marginal points which did not
connect to a road with access to the site within this distance were removed
manually.

03.05.04 Revised decision about access points to remove Set Three, consideration of
marginal points, from the analysis. Because the site boundaries were created
based on a fixed grid system, a number of access points were left just inside or
just outside the site boundaries. This opened the door to many subjective
decisions about inclusion. It was decided that overall the number of these
access points actually counted would balance out and we would not worry
about trying to classify or analyze them further.

03.12.04 Method for determining road lengths:

1. Select 1* pass of non-contiguous polygons

2. Clip road layer to polygons (use selected features only)
3. Recalculate road lengths with XTools
4

Perform spatial join to assign 1Ds to road segments (if there are road
segments that are common to more than one polygon — as with the
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1.8 General Measurement Geographies

There are many possible measurement geographies for analyzing the walkability of an
environment. Which geographies are used depends on:
» Data availability (e.g. some data are available only in aggregated format)
» The nature of the variable (for example, if walking to a corner store is thought to be a
key motivation for walking for transportation, the distance to the nearest store may be
more important than the percentage of a buffer area taken up by corner stores)

Typical geographies include the following and these protocols focus on those that are
underlined:
“Objective” geographies independent of experience:
* Natural neighborhood, variously defined
* Existing measurement unit e.g. census tract, TAZ
» Large grid cell (e.g. 400-1600 meters)
»  Small grid cell (e.g. 100-200 meters)
» Straight line or airline buffer (at different radii, e.g. 100, 200, 400 meters)
» Network or street distance buffer (at different radii, e.g. 100, 200, 400 meters)
» Straight line or airline distance to nearest feature
=  Network or street distance to nearest feature
= Parcel of residence
Other geographies
» Perceived environment (from surveys/interviews)
» Experienced environment (from diaries, GPS)

The measurement geographies are described in more detail in Chapter 2.

Appendix 1D contains a matrix of measures by measurement geographies in the study.

1.9 Creating the Initial Focus/Context Area Study Geography for the Twin
Cities Walking Study

This section explains the key decisions we made in creating the study geography for the Twin
Cities Walking Study. This is important to include for two reasons. First, some people may wish
to replicate our approach. Second, even if study teams choose a quite different strategy for
selecting areas to study, understanding the scheme used in the Twin Cities Walking Study
provides useful background to this list of protocols. More detail about how we did the actual
work to select the focus and context areas is described in a protocol in chapter 2.

Major Decisions
Several major decisions shaped the overall study and in particular the selection of 36 0.5%0.5
mile (805*805 meter) square focus areas embedded in 1.0%1.0 mile (1609*1609 meter) context areas:
0 Deciding to focus on residential environments rather than, say, work environments
0 Deciding to concentrate on specific places rather than sampling people from across the
metropolitan areas
0 Using a grid to demarcate neighborhoods rather than using “natural” neighborhoods,
individually defined neighborhoods, census geographies, etc.
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0 Stratifying by density and street pattern, rather than other factors such as mixed use or
pedestrian infrastructure
0 Choosing which density and street pattern measures to use
The section concludes with some reflections on things we would do differently if doing it again.

Deciding to Look at the Residential Environment

Some people in the US conduct most daily activities in their neighborhoods, but more people
live their lives across a metropolitan area and daily walking activities are conducted in spatially
diverse locations linked by motorized transportation. This poses dilemmas for analyzing the
effects of environment. People from the same residential area may have vastly different levels of
physical activity, partly depending on the pedestrian orientation of the distant locations where
they work, shop, socialize, and recreate (Cervero and Gorham 1995). However, residential
environments are important locations as they are used by everyone, not just paid workers.

However, in order to capture larger activity patterns, we used a seven-day travel diary (with
format based on the National Household Travel Survey) in association with seven-days of
readings from an accelerometer. Individual-level surveys also asked for the address of the work
environment, allowing additional analysis of those places.

Deciding to Recruit from and Measure Specific Places Rather than Sampling People from Across the

Metropolitan Area.

We decided to focus on specific areas, rather than a random sample from across a larger area,

for three main reasons:

» Finding extreme areas: As outlined above, we looked at areas that were extreme in terms of
gross population density and median block size.

*  Urban Design and GIS fieldwork logistics: Because detailed measurements of environmental
characteristics involved collecting and checking data, having 36 consolidated focus and
context areas rather than a couple of hundred smaller cells made this data collection viable.

»  Recruitment and measurement: By focusing on 36 areas we could target recruitment better and
find a limited number of “neutral” places, such as community centers and libraries, in
which to conduct face to face interviews..

Using a Grid to Demarcate Neighborhoods Rather than using “Natural” Neighborhoods, Census
Geographies, etc.

Many earlier studies had examined neighborhoods defined as census tracts, or defined by such
features as arterial roads. Instead we created a 0.5*0.5 mile (805*805 meter) grid across the entire
area. The grid helped us get around some of the measurement and analysis problems associated
with the differences in size and shape of these other geographies. However, we are also using a
number of individualized geographies such as buffers around individuals for actual
measurements so that we were not stuck with the relatively coarse grid for all measurements.
We called the 36 0.5*0.5 mile (805*805 meter) grid cells that we ultimately selected for study our
“focus areas.” Areas of 1.0%1.0 miles (1609*1609 meters) surrounding the focus areas were called
“context areas.”

There were over 500 populated cells in the study area—of these we selected 36 (see more detail
in Chapter 2).

We chose 805805 meter squares as a workable size. The 0.25 mile(402 meter) and 0.5 mile (405
meter) radius from a nodal point is frequently used as a baseline for walkability. The focus and
context areas reflect this scale and the specific size was chosen for three reasons related to the
reasons for focusing on specific places mentioned above. This size of space bounds an area that
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is small enough to be the focus for a person’s pedestrian activity; large enough to have a
reasonable population to sample; and, for much of the study area, arterial roads are laid out on
a 0.5 or 1.0 mile (805 or 1609 meter) grid. This means that census blocks and block groups will
have boundaries that match these grids making census analysis easier. A central consideration
is that the amount of walking recommended for health benefits is 30 minutes on most days
(USDHHS 1996), which translates to about two miles (or approximately 3200 meters) per day.
However, since we are interested in walking for transportation in addition to walking for
walking sake, we chose not to evaluate elements of the physical environment that would allow
for a 30 minute, 3200 meter walking loop for the purpose of leisure time exercise. We assumed
that there would be multiple transportation trips per day and that the addition of some
transportation trips would contribute to, but may not fulfill completely, the accumulation of 30
minutes of brisk walking on most days.

Of course as Krizek (2003a; 2003b) points out, many commercial and civic uses are located at
intersections of arterials, and thus in measuring mixed use one commercial area could be
divided between four focus areas. However, these commercial and civic areas will still be
within the context measurement area, and within buffers around individuals, and so the effects
of these uses on walking will be considered explicitly in that analysis.

Stratifying by Density and Street Pattern, Rather than Other Factors such as Mixed Use or Pedestrian
Infrastructure

We knew that there were many environmental variables that may matter in utilitarian walking.
The study design selects two to stratify the sample: density (gross population density) and
street pattern (median census block area). This was to maximize variation. The logic is
described below.

Statistically, sampling is critical to both internal and external validity in observational designs.
Consider that in order to best estimate effect of socio-environmental contexts on walking, we
should randomly assign (randomly selected) people to a large number diverse contexts (or visa
versa) and observe walking behavior with perfect measures. Although such an experiment is
obviously not possible, the exercise reveals the importance of measurement error, variability
across neighborhood contexts, and the requirement that similar people reside in each (i.e.,
assignment mechanisms). Without control over assignment mechanisms, researchers must
appreciate that “like people” do not reside in diverse neighborhoods: the rich reside in one type
of neighborhood, the poor another; whites in one, blacks in another; urbanites in one, farmers in
another. In fact, it is such social stratification that defines neighborhoods, for the most part. This
means that the background characteristics of residents (composition) are typically confounded
with the contexts. It follows that our sampling goal was to maximize variability in contexts
while minimizing variability in resident’s background characteristics — a difficult (sampling)
problem indeed.

Conceptually, we were interested in the effects of four dimensions of context: density, street-
pattern, mixed-use, and pedestrian amenities or infrastructure. Units in each dimension may be
classified into high, medium, and low levels but to maximize variability our interest here rests
with only the high and low. We would have liked to sample neighborhoods in this space but
that would have meant that we needed data in all of the 2* = 16 cells of the sampling-matrix
cells. Given known levels of social stratification, there is a high probability that many of the cells
will have no, or very few, observable neighborhoods (Oakes and Rossi 2003; Oakes In Press-a).
The upshot of this confounding is that inferences are “off-support" of the data and rely on
strong assumptions. To avoid this, we will sampled 2-space defined on density and pattern (4
sampling-matrix cells), and measured mixed-use and amenities as any other covariate, such as
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with as percent white, percent poor, etc. This plan was to strike the proper balance between
internal and external validity. We may make inference in the 4-space, but only with appropriate
care and caution and an eye on actual observed data. By analyzing a number of measures of
mixed use and pedestrian infrastructure as variables (co-variates), rather than using them in the
sampling frame, this study could still examine the association of these characteristics with
walkability.

Details about how the final 36 areas were chosen are described in Chapter 2.

Our sampling plan may thus be characterized as a stratified cluster design, but unlike much
work in survey sampling we had direct interest in cluster (i.e., PSU or primary sampling unit)
effects. We staggered participant recruitment in each neighborhood to minimize any seasonality
effects.

From the environmental perspective, the stratification ensured that there would be variation on
many measures because some are correlated with the sampling frame variables (e.g. sidewalks
go with small blocks), and others are rather randomly distributed (e.g. street trees are in most
places).

Choosing which Density and Street Pattern Measures to Use

Once density and street pattern were selected for stratification we had to select one of the many
measures of each of these. We chose gross density over, for example the density on residential
parcels, because people walking through a neighborhood experience the whole environment,
not just the residential part of the environment.

We chose block size as an easy measurement of connectivity. Our major innovation here was to
use median block size—which is not totally straightforward in ArcGIS where average sizes are
far easier to calculate. This was because statistically medians are a preferred measure of central
tendency. In doing both measures we found significantly different distributions of means and
medians.
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Map on left shows average census block size for study area and on the right
the median. Maroon = 8+ acres (3.2+ hectares), Orange = 5-8 acres (2.0-3.2
hectares), Yellow = 0-5 acres (up to 2.0 hectares)

In particular we picked up a number of areas with mostly small blocks but one large land use
(e.g. a golf course or large industrial area) that gave them a medium average block size but a low
median bock size. They were thus included in our study.

Things We Would do Differently
There are a number of decisions that we would make differently next time.

Most importantly, we would not sample close to the edge of a county or other important data
collection unit. We sampled from all 500 eligible areas, but that meant some of our sampled
focus areas were right on the edge of a county, and the context area went into the next county.

This added to our data collection efforts as we had to buy parcel data and match land use codes.
While not overly onerous, it would have been simpler to avoid this.

1.10 Definitions of Terms
Context Area—1609*1609 meter area around a focus area, used for data collection.
Focus Area—805*805 meter area selected for study.

Study Area—the entire I-35W Corridor Coalition area plus St. Paul, from which 36 focus areas
were selected.

ENVIRONMENT AND PHYSICAL ACTIVITY: GIS PROTOCOLS VERSION 2.3, August 2005, WORK IN PROGRESS 21
University of Minnesota, Twin Cities Walking Study, Metropolitan Design Center



Study Site—a smaller area, generally a focus or context area.
Several terms have a specific meaning in ArcGIS and are frequently used:

Summarize the data: involves creating a variety of “summary” statistics including the
total sum of values but the same function can create a average, maximum, minimum,
standard deviation, and variance but not a median.

Spatial join: this is joining map layers when their underlying attribute tables don’t share
a common field—such as a parcel ID or census tract number--so they are joined based on
location.

Intersect or spatial intersect: this procedure “sandwiches” two distinct data layers
together, creating an output file combining the extent and features common to both
layers. It preserves all boundaries, shapes, and attributes from both layers, so in the
output a feature from one layer will typically be “cut” into multiple pieces by the
boundaries of features from the other layer.

Appendix 1E contains some other relevant information such as coordinate systems used.
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2. FUNDAMENTAL PROTOCOLS AND PROCEDURES

Chapter by: Ann Forsyth (drafting, conceptual issues and formulae, some comments and GIS approach
text); Joel Koepp and Jason Zimmerman (GIS Steps and the rest of the comments and GIS approach text).

Note, the main revision to this chapter following version 2.0 was to Protocol 2.8 where steps were added;
In version 2.2 additional information about sampling was added to Protocols 2.3.

Background
This chapter deals with issues fundamental either to other general measurements or to the Twin
Cities Walking Study. These generally involve measurements of areas.

2.1 Net Land Area (without water)

1. Basic Concept

While it is easy just to measure total or gross area in a study geography (see next protocol),
people generally do not walk on water. In locations with significant numbers of water bodies, a
more useful version of the land area calculation excludes significant water bodies. This is of
course particularly important in Minnesota which is just such a place, i.e. with many water
bodies, even in urban areas. In other locations, total area would be appropriate.

2. Basic Formula
Net Land Area (without water) = Area within defined geography minus water bodies.

3. Detailed Formula

Net Land Area (without water) = Area within defined geography minus water bodies as
interpreted by Ramsey County and the Metropolitan Council (for the one study site we had in
Anoka County).

4. Comments and Explanations

The water area was defined differently by Ramsey and Anoka Counties. Fortunately we only
had one focus (study) area in Anoka, and slivers of context areas in Anoka, Hennepin, and
Dakota, all without a great deal of water.

The definitions included:

Ramsey County: "This data set primarily contains open water areas including creeks,
lakes and rivers. Open water areas are derived from aerial photography observation
and interpretation utilizing stereo processing techniques. Vector line work was
originally stereo plotted from 2003 photography. All graphical lines contain a character
based a layer name that identify the different mapping features. The flight height for the
aerial photography utilized in this project is approximately 5000 feet [1,524 meters]. The
mapping scale for aerial photography utilized in this project is 1 inch equals 833 feet [1
meter equals 10,000 meters]. All features of this type photogrammetrically identifiable
within the Ramsey County coverage are included.”

URL: http:/ / www.datafinder.org/metadata/rams_water.htm
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The Metropolitan Council's 2000 Water Features layer: "It generally includes lakes larger
than 3 acres [1.2 hectares] and rivers wider than 200 feet [61.0 meters]. It may also
include some smaller open water features."

URL: http:/ / www.datafinder.org/metadata/hydro_luse2000.htm

5. GIS Approach
The GIS approach involves using the water layer to clip the study site polygons to end up with
net land area.

6. GIS Steps
The following procedures were completed using ArcMap (ArcInfo) 8.3.

To follow this protocol you will need:
1. Study site layer (polygon)
2. Water layer (polygon)
3. ET GeoWizards tool (available for free download at http://www. ian-ko.com)
4. XTools extension (available from the Downloads section of the ESRI website)

Determine Net Land Area (without water) for each Site:
1. Add the site layer and water layer to your Map Document.
2. Using the ET GeoWizards tool, remove any areas of water from the study sites (follow
instructions included with the software for installation).
Open ET GeoWizards
Under the “Geoprocessing” tab, select “Erase” and click on “GO”
Select your study site polygon layer as the layer to be erased
Give your output layer a name
Click on “Next”
Select your water polygon layer as the layer to erase with
Select either Dense or Normal data type (Dense works better for polygons with many
vertices)
Click on “Finish”
i. The new layer will be added to the Map Document
3. From the XTools menu, select “Table Operations” and then “Calculate Area, Perimeter, Length,
Acres, and Hectares” (follow instructions included with the extension for XTools installation).
a. Under “Select layer to measure”, select your new study site polygon layer
b. Under “Desired output units”, choose your units (depending on the study site size, try
Miles, Meters, or Feet, for example)
c. If you do not with to generate a parameter, such as Perimeter, Length, or Hectares,
deselect it now (leave Area and Hectares selected)
d. Hit “OK”
4. New fields called “Area” and “Hectares” will be created in the attribute table of your site
polygon layer with the areas of each polygon calculated in the units you chose (Area) and in
hectares (Hectares).
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2.2 Gross Area (including water)

1. Basic Concept

Land area is one of the most basic measurements. Area, including water, is a very gross
measure that is appropriate for places without coastlines, lakes, or similar water features.
However, because the Twin Cities has much water this is not used in these protocols.
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2. Basic Formula
Gross Area (including water) = Area within defined geography.

3. Detailed Formula
Same as above.

4. Comments and Explanations
Includes water, areas not in parcels, basically everything.

5. GIS Approach
This is a plain vanilla land area calculation.

6. GIS Steps
The following procedures were completed using ArcMap (ArcInfo) 8.3.

To follow this protocol you will need:
1. Study site layer (polygon)
2. XTools extension (available from the Downloads section of the ESRI website)

Calculate Land Area for each Site:
1. Add the site layer to your Map Document.
2. From the XTools menu, select “Table Operations” and then “Calculate Area, Perimeter, Length,
Acres, and Hectares” (follow instructions included with the extension for XTools installation).
a. Under “Select layer to measure”, select your new study site polygon layer
b. Under “Desired output units”, choose your units (depending on the study site size, try
Miles, Meters, or Feet, for example)
c. Ifyoudonot wish to generate a parameter, such as Perimeter, Length, or Hectares,
deselect it now (leave Area and Hectares selected)
d. Hit “OK”
3. New fields called “Area” and “Hectares” will be created in the attribute table of your site
polygon layer with the areas of each polygon calculated in the units you chose (Area) and in
hectares (Hectares).

2.3 Creating a Focus Area Sampling Grid and Sampling Extreme Areas
(followed by randomly sampling addresses)

1. Basic Concept
This procedure identifies potential focus areas for the study and obtains a random sample of the
most extreme areas, a strategy we used to guarantee environmental diversity.

This protocol is slightly different to others as it focuses on a procedure rather than a formula or
a definition.

2. Basic Procedure
This procedure:
= Places a 805805 meter grid over the entire study area.
0 There were a total of 780 of these. In future, we would eliminate all grid cells on
the edge of the study geography unless identical data are available outside of it.
» Finds those grid cells with more than 18.75% (30 acres if there is no water) of their parcel
land area in residential uses.
0 There were a total of 388 of these.
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» Calculates the population per hectare (without water) for each cell, with population in
blocks cut by the edge of a cell apportioned according to the land area on either side of the
boundary (e.g. if 40% of the land area is in the cell, it gets 40% of the block’s population).

0 See Chapter 3 for instructions on calculating population per hectare (without
water).

» Calculates the Median Block Size for blocks with a centroid within the cell (using the
modified census layer from TLG and Metro GIS—for description, see Chapter 1). Block
centroids are used so that each block is counted as a whole and each block is allocated to
only one grid cell.

0 See Chapter 6 for instructions on calculating Median Block Size.

» Arranges grid cells into a 3*3 matrix of low (up to 5 persons per acre /12.4 per hectare),
medium, and high (over 10 persons per acre/24.7 per hectare) population density and small
(under 5 acres/2.0 hectares), medium, and large (over 8 acres/3.2 hectares) blocks. These
cut-off points reflect the character of the study area and some of the literature on population
density where 10 persons per acre (the cut-off for “high” density, was the lowest cutoff we
could justify in terms of walkable areas—see Frank and Pivo (1994, 46), Hess et al (1999, 1).

» Eliminates grids cells with fewer than 200 people.

= Randomly selects nine grid cells to study from the four extreme cells of this matrix.

»  Checks that none of the cells will be undergoing large scale redevelopment during the study
period.

0 In the case of the Twin Cities Walking Study we checked with all the relevant
planning departments and two cells were each going to have hundreds of units
constructed during the period of the study (causing disruption to current
residents and changing the residential density and street pattern over the course
of the year). We excluded these areas and resampled.

3. Detailed Procedure
As above.

4. Comments and Explanations
Some steps require additional explanation.

In placing a 805*805 meter grid over the study area, we adjusted it to fit the arterial grid so that
for many of the grid cells the boundaries are roads. The logic behind this is explained in chapter
1 but was to do with simplifying some measurements. However, the actual arterial grid was
offset so our sampling grid needed to be broken and manipulated a little. The diagram below
shows these offsets. There were some minor overlaps and gaps, but quite minor.
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Study area showing 805*805 meter grid with offsets.

These grid cells were used for sampling the participants in the study. The basic procedure
includes:

Creating an address list of all residential parcels. As there is no land use code in the
Ramsey County assessor’s data for mixed use, we simply included parcels matching the
land use codes in the type R (residential) and M (multifamily) as found in LUC.DBF on

\ \Environment\GISdata\Ramsey County\Ramsey\CAMA \ParcelDataLookup)] The
specific parcel data base did not include separate addresses for properties with multiple
units under one ownership—typically rental units. The parcels could be identified
through and use type M (multifamily) and associated land use codes (401,402,403,404) In
this case we purchased more accurate address lists from a private vendor.

The revised address list for each focus area was then placed in a column in an Excel
spreadsheet. The random number generating function in Excel was used to generate
random numbers in the adjacent column. The two columns were then sorted and the
first 20 addresses (or whatever number was needed at that time) were selected.

Because we deliberately spread the individual level measures over 8 months, so that we
were not measuring in winter and so that people from each area were being measured in
spring through fall, we did multiple random selections for each phase without replacing
those who had been participants (or in some cases we had promised not to contact.
However, it would be equally appropriate to do one random sample at the beginning,
and just move down the list as more people were needed.
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5. GIS Approach
For density and block size measures, see other chapters referenced above. An ArcGIS tool,
Fishnet, was used to create a shapefile of grid squares in an appropriate projection.

6. GIS Steps
The following procedures were completed using ArcMap (ArcInfo) 8.3.

To follow this protocol you will need:
1. Alayer containing the maximum extent for analysis
2. Create Fishnet tool (available from ESRI’s ArcScripts website)

Create the grid cell shapefile:

1. Ensure that the data view is using the desired units for measurement by checking the lower right
corner of the status bar at the bottom of ArcMap.

2. Move the mouse to the lower left corner of the area for which grid cells will be created. Note the
coordinates.

3. Measure the approximate horizontal and vertical distances that need to be covered by the grid
and divide each distance by the intended size of each grid cell. This will yield the number of rows
and columns needed in the grid.

4. Click the Create Fishnet button that was added to the toolbar during the installation of the tool.

5. Enter the X-Y coordinates of the lower left corner recorded above.

6. Enter the number of rows and columns estimated above.

7. Enter the height and width of each grid cell

8. Choose a location and name for the output shapefile

9. Click the Edit button to select the coordinate system of the output shapefile.

10. Make sure it is set to product Polygons and click OK.

2.4 Measurement Geography Type 1: Grid Cell

1. Basic Concept

This measurement geography divides an area into equal square cells for sampling and
measurement. These protocols use three scales of grid cell: a focus area, a context area, and a
100m grid cell. The logic behind the first two is described in Chapter 1 and they are primarily
used to create the sample frame for the study and to guide data collection.

The small, 100*100m grid cells are used in measurement where data are only available in
aggregated form or where measures require grid cells for other reasons described in the
protocols for those measures (e.g. the land use dissimilarity index).

2. Basic Definition
The focus area is an area 0.5 by 0.5 miles/805*805 meters used as basic measure for sampling.

The context area is an area 1.01.0 miles/1609*1609 meters that buffers each focus area by 0.25
miles /402 meters on all sides.

3. Detailed Formula

Focus area = Area 0.5 by 0.5 miles/805*805 meters used as basic measure for sampling. The
basic focus area grid ignores water bodies but these are generally excluded from land
area calculations.
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Context area = Area 1.01.0 miles1609*1609 meters that buffers each focus area by 0.25
miles /402 meters on all sides. The basic context area grid ignores water bodies but these
are generally excluded from land area calculations. Used to collect data so that there can
be a 0.25 mile straight line buffer (at least) measured around all participants.

4. Comments and Explanations
None.

5. GIS Approach

The GIS approach is to use the Create Fishnet add-on for ArcGIS to create grid cells for one
study site. Convert the grid cell shapefile to graphics and copy the graphics to each study site,
aligning them as well as possible with each study site. Convert all the graphics into a new
shapefile and assign the correct study site ID to each group of grid cells.

6. GIS Steps
The following procedures were completed using ArcMap (ArcInfo) 8.3.

To follow this protocol you will need:
1. Alayer containing the maximum extent for analysis
2. XTools extension (available from the Downloads section of the ESRI website)
3. Create Fishnet tool (available from ESRI’s ArcScripts website)

Create the grid cell shapefile (this procedure assumes you are creating grid cells for a 1600m square study
site):

1. Ensure that the data view is using meters by checking the lower right corner of the status bar at

the bottom of ArcMap.

2. Move the mouse to the lower left corner of the study site for which grid cells will be created. Note
the coordinates. Click the Create Fishnet button that was added to the toolbar during the
installation of the tool.

Enter the X-Y coordinates of the lower left corner recorded above.

Enter 16 for the number of rows and columns.

Enter 100 for the height and width of each grid cell

Choose a location and name for the output shapefile

Click the Edit button to select the coordinate system of the output shapefile.
Make sure it is set to product Polygons and click OK.
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Save grld cells to graphics and duplicate:

Right click on the new grid cell layer in the Table of Contents and choose Conuvert Features to
Graphics

Select the graphic grid cells (all 256 of them) so they are highlighted

Right click and choose Group to combine the cells into one selectable graphic

Right click to Copy and Paste the graphic to other study sites

Align the graphics to each study site

Select all the graphics, right click and choose Ungroup

SCINESCRID

Create grid cell shapefile:
1. Open the XTools menu in the toolbar and choose Feature Conversions—>Convert Graphics to Shapes
2. Select the polygon features and hit OK
3. The new shapefile will be added to the ArcMap document
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2.5 Measurement Geography Type 2: Straight Line or Airline Buffer

1. Basic Concept

This measurement places a buffer around a point or polygon and the radius of the buffer is
equal at all points. This is useful in measuring the general context of a person. While the street
network buffer (see next protocol) focuses on street distances, pedestrians do not always walk
on streets and in some locations, the straight line or airline buffer may well capture parts of the
environment accessible to pedestrians through parks, parking lots, trails, and informal paths.

It should be noted that we also use very small buffers in defining intersections, largely to
eliminate classification errors from slightly offset intersections. This is complex to describe
briefly so see Chapter 6 for more detail.
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Straight line or airline buffers of three different radii (in this case 0.125, 0.25, and 0.5 miles or

201, 402, and 805 meters) around a hypothetical individual.

Buffers can also be created around polygons such as parks. The following diagram shows
straight line buffers of 0.25 miles /402 meters around parks in a suburban area of the Twin
Cities. In this case buffers around several parks have been merged to show areas within 0.25
miles/402 meters of any park (shaded) and beyond that distance (white). These maps are from
separate work on park access for the Trust for Public Land.
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Straight line or airline buffers of 0.25 miles (402 meters) shown in beige around parks shown in
green. Areas beyond that distance are in white.

2. Basic Definition
A straight line buffer is an area within “X” meters straight line distance of a point (or a

polygon).

3. Detailed Definition

A straight line buffer is an area within “X” meters straight line distance of a point (or a
polygon). In the case of this study with a sample based on residential environments, the straight
line distance is from a participant's home. More specifically, it is the straight line distance from
the residence on the participant’s parcel, located visually from aerial photos.

4. Comments and Explanations

This is a straightforward process in ArcGIS 8.3, using the Buffer Wizard. The software lets you
choose whether to keep the buffers distinct (one per feature) or merge them into one big feature.
For the parks analysis shown in the image above, the buffers could be merged together, as it
was not necessary to retain a relationship between an individual park and its buffer. For the
Twin Cities Walking Study, each buffer was tied to a participant’s home location, so the buffers
had to remain distinct.

Picking the starting point was a bit more time consuming in this process as we only partially
automated it but rather checked the geocoding from the parcel data base. The geocoding
process works with the length of the street segment and the address range associated with it,
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and just places points along the length of the line proportionally using the address and the
known range. In order to have the points in the correct place we used the parcel data (to match
exact addresses) and the orthophotos (to find the building locations) and manually shifted
points to reflect the actual location of participants. In a larger study, we would automate this
step to use the centroid of the parcel of residence. The manual placement of points makes the
most difference in larger or longer lots where the centroid may be some distance from the actual
house, affecting small buffers in particular.

In the picture to the left you can see the parcel centroid
marked with a green X, while the house sits at the back of the
parcel with a long driveway out to the road. In this picture the
distance from the point on the house out to the road is just
over 400m.

Buffering can be a large task. For instance, for census-based
measures it is important to intersect straight line buffers and
census blocks, that is to cut census blocks into sections that
overlap with each individual buffer. This is a large
processing task that requires two stages. First is the normal
intersect between a set of buffers and the census blocks.
Then, because of the buffers of participants in a limited
geographical area tend to overlap, the resulting file has to be
run through the Dissolve procedure in the GeoProcessing
Wizard. After intersecting census blocks with many
overlapping buffers, each buffer gets split into many pieces.
By dissolving this layer by both the unique ID of the buffer
and the unique census block ID, the file is put back together
into all the unique combinations of the two attributes. The
result is the equivalent of simply doing a spatial intersect
with non-overlapping buffers. The first step results in
extremely large files, for example intersecting 715 1600m
buffers and the approximately 6500 census blocks they touch
took nearly a half hour and generated a file containing 2.65
million records. In order to avoid the computer crashing, this
had to be broken up into six chunks of approximately half a
million records each because the dissolve tool would crash
trying to operate on more records than that. When all six
pieces were done, the append tool was used to merge them
back together—the final file contains 156,000+ records (i.e.
census blocks and parts of census blocks)

. 5. GIS Approach

Use the Buffer Wizard in ArcGIS to create one or more
buffers a specified distance or distances from a selected set of
features.

6. GIS Steps
The following procedures were completed using ArcMap (ArcInfo) 8.3.

To follow this protocol you will need:
1. Participant location layer (point) with unique ID field
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2. Census block layer (polygon) with field containing population

Create Participant buffers:
1. Under the Tools dropdown menu, select “Buffer wizard”.
2. In the Buffer Wizard window, under “The features of a layer” select your participant locations
layer and click on Next
Click “At a specified distance” and enter XX (your desired distance)
After “Distance units are:” select metfers
Click Next
After “Dissolve barriers between” select No
Give the layer a name and save as a new layer
Click Finish
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2.6 Measurement Geography Type 3: Network or Street Distance Buffer

1. Basic Concept

This kind of buffer uses the street network as the organizing geography. A buffer of 400 meters
would start by finding all points on the street network that are 400 meters from the starting
point and then joining the dots. Its basic idea is that people use the street network to move
about and something that is 400 meters as the straight line may be several times that far in an
area with a winding or discontinuous street pattern. The illustration below shows this for a 0.5
mile (805 meter) buffer around the same point as in the previous diagram. The network buffer is
significantly smaller than the straight line buffer.

805

Straight line versus network buffers for a radius of 0.5 miles or 805 meters around a
hypothetical individual.
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It is important to note that the network buffer is not always a better than a straight line buffer as
a measure of accessible areas. In some locations there may be many pedestrian paths and cuts-
though that are not streets. This means that it may be useful to test both kinds of buffers.

2. Basic Definition
A network buffer is an area within “X” meters street distance of a point (or a polygon).

3. Detailed Definition

A network buffer is an area within “X” meters street distance of a point (or a polygon) In the
case of this study with a sample based on residential environments, the street network distance
is from a participant's home. More specifically, it is the network distance from the house or
building on the participant’s parcel, where the building is located visually from aerial photos.
Where, due to the lack of cross streets these buffers are zero or very small, we created a work
around that created a minimum buffer size of 12,000 square meters.

4. Comments and Explanations

This is a little trickier to do in GIS than the straight line buffer. Currently Network Analyst, the
tool that creates network buffers, has not been released for ArcGIS so this must be done in
ArcView 3.3 and then re-imported into ArcGIS.

In addition, there are some added complications particularly for smaller buffers in street
patterns dominated by culs-de-sac. Network Analyst works by finding points on the network—
in this case the street—a specified distance along the network from the starting point. It then
joins these points into some kind of polygon. For 200 meter buffers in areas without many cross
streets, 200 meters might just result in a long, skinny line up and down a single street. This
results in a buffer that does not intersect with land use, street trees, or other items outside of the
road right of way. We could not find any direction for this in the literature so created a
minimum buffer for those of 15 meters on each side of the road center line for 185 (200 minus
15) meters each way or approximately 12,000 meters squared or 1.2 ha. Overall, approximately
60 buffers, or approximately 8 percent of buffers, received this minimum size. We in fact came
to this in two steps—we first ran minimum buffers on zero or almost zero network buffers, but
these minimums ended out to be bigger than some of the standard network buffers, given slight
curves in the road and the odd intersection, up to 12,000 square meters. So then we expanded
the number of minimum buffers to all those under 12,000 square meters. This also involved
moving starting points out to the right of way, where they were close (in two cases they were
far and were not moved).

We end up with 656 [check] unmodified features; 57 [check] that were edited by moving the
points out to the road and running them through Network Analyst, taking the resulting road
features, and buffering them by 15m; and 2 features set to have 200m network buffers of 0
square meters.

5. GIS Approach

Use the Network Analyst extension for ArcView 3.3 to determine a service area around a set of
point features. This requires lines features such as roads or trails which will become the
network used to calculate all possible routes of a specified distance from the selected points.

6. GIS Steps
The following procedures were completed using ArcView 3.3.

To complete this protocol you will need:
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1. Roads layer (polyline)
2. A set of features from which to buffer—in this example, participant locations (point)
3. The Network Analyst extension for ArcView

Prepare the view and data:

Add the roads theme and the participant theme to a new view

Go to the View menu and choose Properties

Set the map units and distance units appropriate for the coordinate system of the layers
In the view, select the participant theme, open the Theme menu, and select Table...

Go to the Table menu and select Start Editing

Go to the Edit menu and select Add Field

In the Field Definition window, name the field REPORTCOST

Choose the field type Number, then click OK

. In the theme’s table, click on the name of the newly added field (it should turn dark gray)
0. Go to the Field menu and choose Calculate...

1. Enter the buffer distance and click OK
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Calculate network buffers:
1. In the view, highlight the roads theme
2. Go to the File menu and choose Extensions
3. Scroll to Network Analyst, check the box, and click OK. There should now be a Network menu at
the top of the ArcView window
Go to the Network menu and choose Find Service Area
Check the radio button for Travel from site
Click the Load Sites button
When asked to choose a theme, select the participant locations theme and click OK
The Find Service Area window will now be titled Sareal and Snetl. Click the button in the upper
right with a picture of a grid and a black arrow on it.
When the processing finishes, the polygon theme Sareal will contain the network buffers
0. To export the features to a fresh shapefile, click on the Sareal theme, go to the Theme menu, and
choose Convert to shapefile
11. Choose a location and name for the output file and click OK.
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2.7 Measurement Geography Type 4: Straight Line or Airline Distance to
Nearest Feature

1. Basic Concept

If people walk at least partly in order to reach an important destination, such as a park or a
supermarket, then the distance to the closest example of a specific kind of destination is an
important issue.

2. Basic Definition
The straight line distance to the nearest feature is the distance to the closest X.

3. Detailed Definition
The straight line distance to the nearest feature is the distance to the closest X where X is a type
of destination.

4. Comments and Explanations

This measurement uses an ArcView extension called Nearest Features. It was developed by Jeff
Jenness, a wildlife biologist, and can be downloaded here:

http:/ /www.jennessent.com/arcview /nearest features.htm
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It is also possible to do this in ArcGIS 9, but we have not yet used that tool.

For determining the shortest distance from a participant to a business, the distance is between
the two points. When determining the nearest polygon feature, for example a park, the distance
is calculated between the participant and the closest vertex. Vertices are more useful
representations of access than centroids, particularly if the polygon feature (e.g., a park) is very
large or oddly shaped. In this case, the centroid may be located far from the nearest road.

5. GIS Approach

This calculation simply involves determining the straight line distance between an origin and
the closest of the possible destinations of the desired type (businesses, parks, etc). For non-point
destinations, this measurement requires a decision about what part of the feature to call the
endpoint of the shortest distance line—the centroid, vertex, or closest edge.

6. GIS Steps
The following procedures were completed using ArcView 3.3.

To complete this protocol you will need:
1. Roads layer (polyline)
2. A set of origin features—in this example, participant locations (point)
3. A set of destination features (point)
4. The Nearest Features extension for ArcView

Prepare the view and data:

Add the roads theme and the origin/destination themes to a new view

Go to the View menu and choose Properties

Set the map units and distance units appropriate for the coordinate system of the layers
Go to the File menu and choose Extensions

Find the Nearest Features extension and check the box to turn it on

Click OK
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Calculate distance to nearest feature
1. Click on the Nearest Features button in the toolbar
2. In the first dialog box, select the theme of origin features and the field in its table that contains a
unique ID
3. Click OK
4. In the next dialog box, select one or more destination themes (if you want to calculate the
distance to nearest feature for more than one kind of feature at a time), and for each theme choose
a field containing a unique ID
Click Add for each combination of feature and unique ID
Click OK when finished
In the next dialog box, enter the number of nearest features you want to find (1 = nearest feature,
2 = nearest and second-nearest features, etc) and check the boxes for Comparison Feature ID and
Distance to Centroid
8. Click OK
9. In the final dialog box, you may choose to draw lines connecting each origin and its nearest
destination (this will increase processing time)
10. Click OK to begin the processing

SUSCI

The output will be a table containing the unique ID of each origin feature, the unique ID of the nearest
destination feature, and the distance between them in the chosen units of the view.
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2.8 Measurement Geography Type 5: Network or Street Distance to
Nearest Feature

1. Basic Concept

As with the straight line distance, network or street distance is important as a measure of
accessibility of destinations. As stated in the previous protocol, if people walk at least partly in
order to reach an important destination, such as a park or a supermarket, then the distance to
the closest example of a specific kind of destination is an important issue.

However, the straight line distance may not be a realistic measure of the actual distance to the
nearest feature as people typically walk along streets and therefore the street distance is a more
accurate measure. It is important to note that it is not always better as in some areas there may
be many pedestrian paths and cuts-though that are not streets. This means that it may be useful
to test both kinds of distance measures.

2. Basic Definition
The street distance to the nearest feature is the distance to the closest X.

3. Detailed Formula

The network distance to the nearest feature is the distance to the closest X where X is a type of
destination and the closest X is the closest X in terms of street distance. There may well be closer
destinations of this type in straight line terms but barriers or street patterns make them further
along the network.

4. Comments and Explanations

This is also done using Network Analyst in ArcView 3.3 (see network buffers above) using a
function called Find Closest Facility. You can specify a point layer to use as your “facilities” and
then also a point to serve as your origin. It will then take the road network and calculate the
shortest path to a “facility” (and it can do this using travel costs as well if, for instance, certain
types of roads were considered more or less easy to use).

The basic function only works for a limited number of base points (12). In our case we had 715
valid participant addresses so needed to use an ArcView extension called Multiple Closest
Facilities. It can be downloaded from the ESRI website at

http:/ /arcscripts.esri.com/ details.asp?dbid=13125. For points that do not fall on the network,
there is a dialog box when using this extension that allows the user to decide how far away
from the network to search for points to use in the processing. Points outside that distance will
not be used.

5. GIS Approach

The approach for this measure is to load a set of origins and destinations. Then use the Find
Closest Facility feature in Network Analyst or the Multiple Closest Facilities extension to
calculate the network distance from each origin to the nearest destination.

6. GIS Steps
The following procedures were completed using ArcView 3.3.

To complete this protocol you will need:
1. Roads layer (polyline)
2. A set of origin features—in this example, participant locations (point)
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3. A set of destination features—in this example, employment locations (point)
4. The Network Analyst extension for ArcView
5. The Multiple Closest Facilities extension for ArcView

Calculate network distance to nearest facility
1. Start a new ArcView project and create a blank View
a. Open the View menu and choose Add Theme
b. Add the roads, origins, and destinations layers to the View
c. Open the View menu and choose Properties
d. Make sure the map units (meters, feet, etc.) match the units of the data layers
e. Open the File menu and choose Extensions
f.  Check the box next to the Multiple Closest Facilities extension and click OK
Open the Network Tools menu that has been added and choose Multiple closest facilities
In the dialog box that appears, select the origins layer in the From dropdown box
Select the unique ID of the origins layer in the From ID field dropdown box
In the To dropdown box, select the destinations layer
Choose the unique ID of the destinations layer in the To ID field dropdown box
In the Network dropdown box, select the roads layer
For Facilities to find, enter 1
Set the Cutoff Distance to 0
0. The Search Tolerance is a distance in the current map units that Network Analyst will search away
from the road features to find points. Make this number large enough so the process will not miss
any of the origin points
11. Click Travel to facility
12. Check the box for Create Join Table
13. Hit Process
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When the process ends, the extension will add a new polyline feature to the View consisting of the
network segments that trace the shortest path from each origin to its nearest destination. The table of the
new layer contains an Origin field with the unique ID of the origin layer, a Destin field with the unique
ID of the closest destination feature, and a Length field with the distance in the current map units
between the origin and the closest destination.

2.9 Measurement Geography Type 6: Parcel of Residence

1. Basic Concept

Recent work by Anne Vernez Moudon and her research team has found correlations between
features of the parcel of residence and walking, more of a correlation than some larger
geographies—in her case 1km and 3km buffers. This may be due to features of the parcel of
residence being a proxy for non-environmental features such as levels of car ownership or due
to the lack of intermediate scales in her analysis. We are using parcel of residence to check some
of these variables.

2. Basic Definition
The parcel in which a participant resides.

3. Detailed Formula
As above.

4. Comments and Explanations
None.
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5. GIS Approach
This merely involves selecting the parcel of residence.

6. GIS Steps
Steps are in other protocols.
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3. DENSITY

Chapter by: Ann Forsyth (drafting, conceptual issues and formulae, some comments and GIS approach
text) and Joel Koepp (GIS Steps and the rest of the comments and GIS approach text).

The only change between version 2.1 and Version 2.0 was some additional detail in protocol 3.3. For
version 2.3 an error was corrected in Protocol 3.4 (it does exclude water).

Background

Density is the number of units (people, trees, housing units etc) in a given area. Some
researchers propose that density is primarily a proxy for other variables that actually cause
walking and others propose it is more directly causal. Those on the proxy side argue that it is
highly correlated with older neighborhoods with gridded streets, mixed use, low income
people, etc. For those seeing a more direct link, density provides a critical mass of people and
places, a physical sense of community, auto congestion, and makes transit viable so people walk
to transit (for reviews see Ewing 1994; Steiner 1994; Cervero and Kockleman 1997; Handy 2003;
Audirac 1999).

There are many measures of density depending on what the density is of (residents, employees,
buildings) and the base land area (a parcel, a whole neighborhood) (Forsyth 2003, see Figure 3.1
below). A single home may be part of different measurement areas that give it different overall
densities depending on the scale of the measures (see Figure 3.2 below). Note, the figures use a
different terminology from the protocols, largely because the protocols are independent of size
of base area.

Not all density measures are reported in this section—for example, Chapter 4, on pedestrian
infrastructure, contains a number of density measures such as street tree density.

Figure 3.1 Selected Residential Density Definitions

Note: this uses a different terminology from the protocols, largely because the protocols are
independent of size of base area

Source: Forsyth 2003; Reprinted from Forsyth 2004a

Parcel or Site Density: dwelling units (DUs) or residential population (RP) divided by total
site/parcel area (all uses). This is often used by developers. It is easy to calculate with GIS but
also fairly simple by hand if there is only one parcel. However, since parcel boundaries are not
always visible on the ground this form of density can be hard to calculate from physical
observations.

Block Density: DUs or RP divided by block area measured to the curb. This is relatively easy to
measure from aerial photos and census data, and reflects a unit that is part of the experience of
place, the block. However, if the block is not surrounded by roads, for example where it abuts
open space, the boundaries can be less clear.

Net Neighborhood Residential Dwelling/Population Density: DU or RP divided by total land area
devoted to residential facilities. This is a calculation that involves defining both a neighborhood
and residential land within that neighborhood. Care must be taken in assigning land to
residential uses rather than, say, recreation--the key is to find equivalent elements in different
residential designs.
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Net Neighborhood Density (NND): DU or RP divided by the neighborhood area with the base
land area calculated to exclude city-wide uses in the neighborhood. Included in the
neighborhood land area are residential land, streets, and neighborhood type uses—schools,

parks, churches/synagogues/temples etc. and neighborhood shopping. Excluded are city-wide
businesses, public uses, high schools and colleges, major arterials, major regional parks, and

vacant and unusable land. These exclusions can be difficult to calculate (adapted from
Alexander 1993).

Gross Neighborhood Density (GND)/Gross Census Tract Density (GCTD): DU or RP divided by

the total neighborhood area. This is easy to calculate although it may be skewed by regional
uses such as regional parks. The Gross Census Tract Density is particularly useful as it is
available across the United States from census information and does not rely on local data.

City Density (CD): DU or RP divided by the entire developed area of the city or town. In built out
local government areas this is in practical terms the entire city. On the urban edge, it includes
only developed land, a more complex calculation (adapted from Alexander 1993). This is also a

gross density.

Metropolitan Density (MD): DU or RP for US Census Metropolitan Statistical Area divided by

total land area. This calculation includes undeveloped areas which will lower the overall figures,
but is nationally comparable. The US Census prepares such density figures. This is also a gross

density.

Figure 3.2 Comparison of Residential Density Measures for the Same Location
Source: Forsyth 2003

Site density 10 DUs per acre/25 per hectare
Block density 8 DUs per acre/20 per hectare
Net neighborhood residential density 10 DUs per acre/25 per hectare
Net neighborhood density 6 DUs per acre/15 per hectare
Gross neighborhood density 5 DUs per acre/12 per hectare
City density 4 DUs per acre/10 per hectare
Metropolitan density 3 DUs per acre/7 per hectare

3.1 Raw Population per Unit Land Area

1. Basic Concept

This is the most basic gross measure of population density, defined as the population of those
who reside in housing in the area. It should be noted that this measure is independent of scale

and could be used to measure the population per hectare of a small grid cell or an entire
metropolis (and therefore would have different names e.g. raw grid cell density, raw
metropolitan density).

Sources that have used this measure, typically at a neighborhood or census tract level, and that

will be more fully discussed in the next draft of this manual include Frank and Pivo (1994, 46),

Hess et al (1999, 1), Schimek (1996, 121), and Dunphy and Fisher (1996, 91).

Because the Twin Cities has a great many lakes, we generally used the next protocol, which

excludes water.

2. Basic Formula
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Raw Population per Unit Land Area = Persons in housing units per unit area with no
exclusions.

3. Detailed Formula
Raw Population per Unit Land Area = Persons in housing units as measured in the US Census

per unit area with no exclusions.

4. Comments and Explanations
Where census blocks are cut by the end of the measurement geography, the population is
apportioned according to the percentage of land area falling inside and outside the line.

5. GIS Approach

Use ArcGIS to intersect study sites with census blocks. Retain the original area of each census
block and then use XTools to update the areas after performing the intersect procedure. Find the
proportion of new area to original area and multiply the census population figure by that same
proportion. Finally, divide this apportioned population figure by the updated area.

6. GIS Steps
The following procedures were completed using ArcMap (ArcInfo) 8.3.

To follow this protocol you will need:
1. Study site layer (polygon) with unique ID field
2. Parcel layer (polygon)
3. Census block layer (polygon) with field containing population
4. XTools extension (available from the Downloads section of the ESRI website)

Determine the apportioned census population figure for each site:
1. Add the site layer and census block layer to your Map Document.
2. From the XTools menu, select “Table Operations” and then “Calculate Area, Perimeter, Length,
Acres, and Hectares” (follow instructions included with the extension for XTools installation).
a. Under “Select layer to measure”, select the census block layer
b. Under “Desired output units”, choose your units (depending on the study site size, try
Miles, Meters, or Feet, for example)
c. If you do not with to generate a parameter, such as Perimeter, Length, or Hectares,
deselect it now (leave Area and Hectares selected)
d. HitOK
3. New fields called “Area” and “Hectares” will be created in the attribute table of your new census
block polygon layer with the areas of each polygon calculated in the units you chose (Area) and
in Hectares (Hectares).
4. Open the GeoProcessing Wizard.
a. Choose Intersect two layers and click Next
b. Select your census blocks as the input layer
c. Select your study site layer as the overlay layer
d. Choose a name and location for the output layer
e. Click Finish
f.  The new layer will be added to the Map Document
5. Open the Attribute Table of the census block layer created in the previous step.
Click on Options and choose Add Field
Name the field OrigHect and make it of type Double
Back in the Attribute Table, right click on the name of the OrigHect field
Choose Calculate Values
In the Field Calculator, double click Hectares and click OK.
You have now copied the values from Hectares to OrigHect
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6. From the XTools menu, select “Table Operations” and then “Calculate Area, Perimeter, Length,
Acres, and Hectares” (follow instructions included with the extension for XTools installation).
a. Under “Select layer to measure,” select the clipped census block layer created in step 4
above
b. Under “Desired output units,” choose your units (depending on the study site size, try
Miles, Meters, or Feet, for example)
c. If you do not with to generate a parameter, such as Perimeter, Length, or Hectares,
deselect it now (leave Area and Hectares selected)
d. HitOK
7. This will overwrite the values in the Hectares field with the new correct values (since the shapes
have been clipped to the extent of the study site layer), yet the original number of hectares is
preserved in the OrigHect field.
8. To perform the population apportionment, open the Attribute Table of the clipped census block
layer again.
Click on Options and choose Add Field
b. Name the field PopSplit and make it of type Double
c. Backin the Attribute Table, right click on the name of the PopSplit field
d. Choose Calculate Values
e. In the Field Calculator, double click Hectares, then hit the / button, then double click
OrigHect, hit the * button, and finally double click the name of your Population field
f. HitOK
9. The result is a field called PopSplit that contains the same proportion of the original census
population figure as the proportion of the clipped census block area to the original area.

2

Perform final calculation
1. In the Attribute Table of the clipped census block layer, right click on the name of the site ID field
and choose Summarize

a. In the box beneath Choose one or more summary statistics..., click the + next to PopSplit
b. Check the box next to Sum
c. Choose a name and location for the output summary table
d. Click OK

2. Join this summary table into the study site layer table using the ID field
a. Add anew field of type double called PopPerHect
b. Right click on this new field and choose Calculate Values
c. In the Field Calculator, double click on the PopSplit field, then click the / button, and

finally double click on the Hectares field from the study site layer.

d. HitOK

The PopPerHect field now contains the total apportioned population per hectare for each study site.

3.2 Population per Unit Land Area (without water)

1. Basic Concept

In areas with many lakes, water provides an important barrier to walking. As the Twin Cities is
one such area, many of our calculations used this population density measure which is identical
to the one above except that it excludes water.

2. Basic Formula
Population per Unit Land Area (without water) = Persons in housing units per unit gross area
excluding water.

3. Detailed Formula
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Population per Unit Land Area (without water) = Persons in housing units as measured in the
US Census at the block level per unit land area excluding area of water features as measured in
the Ramsey County layer.

4. Comments and Explanations
Where census blocks are cut by the end of the measurement geography, the population is
apportioned according to the percentage of land area falling inside and outside the line.

5. GIS Approach

The approach to this measurement is to intersect census blocks with study sites, preserving the
original area of each block and then recalculating it after the spatial intersect procedure.
Calculate the apportioned population and divide it by the total area that has been recalculated
after removing the area of all water features.

6. GIS Steps
The following procedures were completed using ArcMap (ArcInfo) 8.3.

To follow this protocol you will need:

Study site layer (polygon) with unique ID field

Parcel layer (polygon)

Census block layer (polygon) with field containing population

Water features layer (polygon)

XTools extension (available from the Downloads section of the ESRI website)
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Determine the apportioned census population figure for each site:
1. Add the site layer and census block layer to your Map Document.
2. From the XTools menu, select “Table Operations” and then “Calculate Area, Perimeter, Length,
Acres, and Hectares” (follow instructions included with the extension for XTools installation).
a. Under “Select layer to measure”, select the census block layer
b. Under “Desired output units”, choose your units (depending on the study site size, try
Miles, Meters, or Feet, for example)
c. If you do not with to generate a parameter, such as Perimeter, Length, or Hectares,
deselect it now (leave Area and Hectares selected)
d. HitOK
3. New fields called “Area” and “Hectares” will be created in the attribute table of your new census
block polygon layer with the areas of each polygon calculated in the units you chose (Area) and
in hectares (Hectares).
4. Open the GeoProcessing Wizard.
g. Choose Intersect two layers and click Next
Select your census blocks as the input layer
Select your study site layer as the overlay layer
Choose a name and location for the output layer
Click Finish
The new layer will be added to the Map Document
5. Open the Attribute Table of the census block layer created in the previous step.
e. Click on Options and choose Add Field
f. Name the field OrigHect and make it of type Double
g. Back in the Attribute Table, right click on the name of the OrigHect field
h. Choose Calculate Values
i. In the Field Calculator, double click Hectares and click OK.
j.  You have now copied the values from Hectares to OrigHect
6. From the XTools menu, select “Table Operations” and then “Calculate Area, Perimeter, Length,
Acres, and Hectares” (follow instructions included with the extension for XTools installation).
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k. Under “Select layer to measure”, select the clipped census block layer created in step 4
above
l.  Under “Desired output units”, choose your units (depending on the study site size, try
Miles, Meters, or Feet, for example)
m. If you do not with to generate a parameter, such as Perimeter, Length, or Hectares,
deselect it now (leave Area and Hectares selected)
n. HitOK
7. This will overwrite the values in the Hectares field with the new correct values (since the shapes
have been clipped to the extent of the study site layer), yet the original number of hectares is
preserved in the OrigHect field.
8. To perform the population apportionment, open the Attribute Table of the clipped census block
layer again.
o. Click on Options and choose Add Field
Name the field PopSplit and make it of type Double
Back in the Attribute Table, right click on the name of the PopSplit field
Choose Calculate Values
In the Field Calculator, double click Hectares, then hit the / button, then double click
OrigHect, hit the * button, and finally double click the name of your Population field
t. HitOK
9. The result is a field called PopSplit that contains the same proportion of the original census
population figure as the proportion of the clipped census block area to the original area.
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3.3 Population per Developed Land Area (without water)

1. Basic Concept

This is a measure of resident population divided by the land area in parcels; that is, excluding
rights of ways, water bodies, and land not in parcels. It has been used by some as a slightly less
gross measure of population density.

Cervero and Kockelman (1997, 203) who used this measure, based it on data from a Association
of Bay Area Governments database that had dominant land uses at the 1ha level.

[Note we are checking this definition in relation to Cervero and Kockelman (1996, 8) and
McCann and Ewing (2003, 10). We are still considering whether to use it.]

2. Basic Formula
Population per Developed Land Area = Persons in housing units per unit land area in parcels.

3. Detailed Formula

Population per Developed Land Area = Persons in housing units as measured by the US census
at block level per unit land area in parcels that is excluding rights of ways, water bodies, and
land not in parcels. Where census blocks are cut by the end of the measurement geography, the
population is apportioned according to the percentage of land area falling inside and outside
the line.

4. Comments and Explanations
This requires access to both parcel data and census data.

Our parcel layer was modified to reflect the most detailed data with respect to water features. In
Ramsey County, this was a country water features shapefile. For the other counties involved,
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the best data came from the Metropolitan Council’s 2000 land use shapefile (selecting the Water
designation). These areas were erased from the parcel shapefile.

Our parcel data in Dakota County required two modifications at this point. Where a new(er)
highway had been built, the underlying parcels had not been removed from the parcel layer.
We manually removed the parcels that were within the road bed and coded those outside the
road bed but within the apparent right of way as vacant. Also, another area had been platted for
many roads but only one had been constructed. This road bed was isolated and removed — the
rest of the rights of way (unbuilt) were left coded as Open Space.

5. GIS Approach

The parcel layer (with areas of water removed as noted above) was intersected with the site
layer and the areas of the parcels recalculated to account for those that were split by the study
site boundaries. Since developed land was defined as all land excluding rights of ways, water
bodies, and land not in parcels, this parcel layer served as our developed land layer. Perform a
spatial intersect between the developed land layer and the measurement geographies. Use
XTools to update the area of the features in the resulting layer, then open its Attribute Table and
summarize it based on the measurement geography ID field, calculating the sum of the Area
field in the process. This will yield the total developed land area for each feature in the
measurement geographies.

6. GIS Steps
The following procedures were completed using ArcMap (ArcInfo) 8.3.

To follow this protocol you will need:
1. Study site layer (polygon) with unique ID field
2. Land use parcel layer (polygon)
3. Census block layer (polygon) with field containing population
4. XTools extension (available from the Downloads section of the ESRI website)

The basic steps are:
e Determine Net Land Area (without water) for each Site
o Intersect Parcels with Site Layer
o Calculate apportioned Census population for each Site
o Intersect Developed Land with Site Layer
o  Summarize Attribute Tables of intersected Census and Developed Land layers
o Calculate Population per Developed Land Area

Determine Net Land Area (without water) for each Site:
1. Follow the steps outlined in Protocol 2.1.

Intersect Parcels with Site Layer:
1. If the site layer does not have unique IDs or names for each site, create them now.
2. Using the GeoProcessing Wizard, intersect the land use parcel layer with the new (net area) site
polygon layer
Under the Tools menu, select “GeoProcessing Wizard”.
Select “Intersect two layers” and click on “Next”.
Under “Select the input layer to intersect:” choose your land use parcel layer.
Under “Select a polygon clip layer:” choose your site layer.
Give your file a name and hit “Finish”.
The parcels will now be clipped to the study site boundaries, have areas of water
removed, and be assigned the IDs associated with each study site. Note that parcels that
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exist in two or more overlapping study sites will now be represented by two or more
identical (except for ID number) rows in the attribute table).
From the XTools menu, select “Table Operations” and then “Calculate Area, Perimeter, Length,
Acres, and Hectares” (follow instructions included with the extension for XTools installation).
a. Under “Select layer to measure”, select your new land use parcel layer
b. Under “Desired output units”, choose your units (depending on the parcel size, try
Meters or Feet, for example)
c. Ifyoudonot with to generate a parameter, such as Perimeter, Length, or Hectares,
deselect it now (leave Area and Hectares selected)
d. Hit “OK”
New fields called “Area” and “Hectares” will be created in the attribute table of your new land
use parcel layer with the areas of each polygon calculated in the units you chose (Area) and in
hectares (Hectares).

Determine the apportioned census population figure for each site:

1. Add the site layer and census block layer to your Map Document.
2. From the XTools menu, select “Table Operations” and then “Calculate Area, Perimeter, Length,
Acres, and Hectares” (follow instructions included with the extension for XTools installation).
a. Under “Select layer to measure”, select the census block layer
b. Under “Desired output units”, choose your units (depending on the study site size, try
Miles, Meters, or Feet, for example)
c. If you do not with to generate a parameter, such as Perimeter, Length, or Hectares,
deselect it now (leave Area and Hectares selected)
d. HitOK
3. New fields called “Area” and “Hectares” will be created in the attribute table of your new census
block polygon layer with the areas of each polygon calculated in the units you chose (Area) and
in hectares (Hectares).
4. Open the GeoProcessing Wizard.
a. Choose Intersect two layers and click Next
b. Select your census blocks as the input layer
c. Select your study site layer as the overlay layer
d. Choose a name and location for the output layer
e. Click Finish
f.  The new layer will be added to the Map Document
5. Open the Attribute Table of the census block layer created in the previous step.
a. Click on Options and choose Add Field
b. Name the field OrigHect and make it of type Double
c. Backin the Attribute Table, right click on the name of the OrigHect field
d. Choose Calculate Values
e. In the Field Calculator, double click Hectares and click OK.
f.  You have now copied the values from Hectares to OrigHect
6. From the XTools menu, select “Table Operations” and then “Calculate Area, Perimeter, Length,
Acres, and Hectares” (follow instructions included with the extension for XTools installation).
a. Under “Select layer to measure”, select the clipped census block layer created in step 4
above
b. Under “Desired output units”, choose your units (depending on the study site size, try
Miles, Meters, or Feet, for example)
c. If you do not with to generate a parameter, such as Perimeter, Length, or Hectares,
deselect it now (leave Area and Hectares selected)
d. HitOK
7. This will overwrite the values in the Hectares field with the new correct values (since the shapes
have been clipped to the extent of the study site layer), yet the original number of hectares is
preserved in the OrigHect field.
8. To perform the population apportionment, open the Attribute Table of the clipped census block
layer again.
a. Click on Options and choose Add Field
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Name the field PopSplit and make it of type Double

Back in the Attribute Table, right click on the name of the PopSplit field

Choose Calculate Values

In the Field Calculator, double click Hectares, then hit the / button, then double click

OrigHect, hit the * button, and finally double click the name of your Population field

f. HitOK

9. The result s a field called PopSplit that contains the same proportion of the original census

population figure as the proportion of the clipped census block area to the original area.
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Determine total area of developed land for each site:
1. Add the site layer and developed land layer to your Map Document.
2. Open the GeoProcessing Wizard.
Choose Intersect two layers and click Next
b. Select your developed land as the input layer
c. Select your study site layer as the overlay layer
d. Choose a name and location for the output layer
e. Click Finish
f. The new layer will be added to the Map Document
3. From the XTools menu, select “Table Operations” and then “Calculate Area, Perimeter, Length,
Acres, and Hectares” (follow instructions included with the extension for XTools installation).
a. Under “Select layer to measure”, select the layer created in the previous step
b. Under “Desired output units”, choose your units (depending on the study site size, try
Miles, Meters, or Feet, for example)
c. If you do not with to generate a parameter, such as Perimeter, Length, or Hectares,
deselect it now (leave Area and Hectares selected)
d. HitOK
4. New fields called “Area” and “Hectares” will be created in the attribute table of your new parcel
polygon layer with the areas of each polygon calculated in the units you chose (Area) and in
hectares (Hectares).

o

Calculate population per developed land area:
For each of the two new layers (developed land and census blocks clipped to extent of the
measurement geographies), do the following:
Open the layer’s Attribute Table
Right-click on the name of the field containing the unique ID of the study site
Choose Summarize
In the box beneath Choose one or more summary statistics..., click the + next to Hectares
Check the box next to Sum
Choose a name and location for the output summary table
Click OK
]om one of the resulting summary tables to the other based on the study site ID field
Add a field called PopPerDevl of type double
Click Options and choose Calculate Values
In the Field Calculator, double click Sum_Popsplit, click the / button, and then double click the
Sum_Hect field from the residential parcel summary table
6. Hit OK

cmrh.m,o-o o p
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The field PopPerDevl now contains the result of dividing the apportioned census population for a study
site by the total area of developed land for the study site. The table can be joined with your study site
shapefile based on the site ID, allowing you to copy the values into a new field you can create in the
study site Attribute Table.
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3.4 Residential Population in Residential Parcels (Residential Density)
(without water)

1. Basic Concept

This density calculation reflects the kinds of densities that are talked about by developers,
rather than the experience of place. That is, while people experience a whole environment—
including roads and non-residential uses—developers build on parcels and density is often
debated in those terms.

We propose to do some measurements using this definition of density to see if it has any
relation at all to actual physical activity in a specific place.

2. Basic Formula
Residential Population in Residential Parcels = Persons in housing units per unit land area in
residential parcels.

3. Detailed Formula

Residential Population in Residential Parcels = Persons in housing units as measured in the US
Census at the block level per unit land area in residential parcels that is excluding rights of
ways, water bodies, and land not in parcels.

4. Comments and Explanations
This calculation requires that your parcel layer contain land use information that can identify
residential parcels.

5. GIS Approach

Use a definition query to display only residential parcels from the parcel layer. Intersect these
residential parcels with the measurement geographies. Summarize the resulting layer’s attribute
table by measurement geography ID and sum the area. Apportion the census population by
intersecting the census blocks with the measurement geographies. Summarize the resulting
layer’s attribute table by measurement geography ID and sum the population. For each
measurement geography, divide the sum of apportioned population by the sum of residential
hectares.

6. GIS Steps
The following procedures were completed using ArcMap (ArcInfo) 8.3.

To follow this protocol you will need:
1. Study site layer (polygon) with unique ID field
2. Parcel layer (polygon)
3. Census block layer (polygon) with field containing population
4. XTools extension (available from the Downloads section of the ESRI website)

Use a Definition Query to display only residential parcels

1. In the Table of Contents (the pane with the list of layers), right-click on the parcel layer and
choose Properties

2. Go to the Definition Query tab and click Query Builder

3. Construct a SQL expression that applies to whichever field contains the land use data of the
parcels and selects the values that identify residential uses

4. Click OK to close the Query Editor and then OK again to close the Layer Properties window.

5. Ensure that only the residential parcels in your parcel layer are displayed
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Determine total area of residential parcels for each site:
5. Add the site layer and parcel layer to your Map Document.
6. Open the GeoProcessing Wizard.
g. Choose Intersect two layers and click Next
Select your parcels as the input layer
Select your study site layer as the overlay layer
Choose a name and location for the output layer
Click Finish
The new layer will be added to the Map Document
7. From the XTools menu, select “Table Operations” and then “Calculate Area, Perimeter, Length,
Acres, and Hectares” (follow instructions included with the extension for XTools installation).
e. Under “Select layer to measure”, select the layer created in the previous step
f.  Under “Desired output units”, choose your units (depending on the study site size, try
Miles, Meters, or Feet, for example)
g. If you do not with to generate a parameter, such as Perimeter, Length, or Hectares,
deselect it now (leave Area and Hectares selected)
h. Hit OK
8. New fields called “Area” and “Hectares” will be created in the attribute table of your new parcel
polygon layer with the areas of each polygon calculated in the units you chose (Area) and in
hectares (Hectares).

= le 2

Determine the apportioned census population figure for each site:
1. Add the site layer and census block layer to your Map Document.
2. From the XTools menu, select “Table Operations” and then “Calculate Area, Perimeter, Length,
Acres, and Hectares” (follow instructions included with the extension for XTools installation).
a. Under “Select layer to measure”, select the census block layer
b. Under “Desired output units”, choose your units (depending on the study site size, try
Miles, Meters, or Feet, for example)
c. If you do not with to generate a parameter, such as Perimeter, Length, or Hectares,
deselect it now (leave Area and Hectares selected)
d. HitOK
3. New fields called “Area” and “Hectares” will be created in the attribute table of your new census
block polygon layer with the areas of each polygon calculated in the units you chose (Area) and
in hectares (Hectares).
4. Open the GeoProcessing Wizard.
Choose Intersect two layers and click Next
b. Select your census blocks as the input layer
c. Select your study site layer as the overlay layer
d. Choose a name and location for the output layer
e. Click Finish
f. The new layer will be added to the Map Document
5. Open the Attribute Table of the census block layer created in the previous step.
Click on Options and choose Add Field
b. Name the field OrigHect and make it of type Double
c. Backin the Attribute Table, right click on the name of the OrigHect field
d. Choose Calculate Values
e. In the Field Calculator, double click Hectares and click OK.
f.  You have now copied the values from Hectares to OrigHect
6. From the XTools menu, select “Table Operations” and then “Calculate Area, Perimeter, Length,
Acres, and Hectares” (follow instructions included with the extension for XTools installation).
a. Under “Select layer to measure”, select the clipped census block layer created in step 4
above
b. Under “Desired output units”, choose your units (depending on the study site size, try
Miles, Meters, or Feet, for example)
c. If you do not with to generate a parameter, such as Perimeter, Length, or Hectares,
deselect it now (leave Area and Hectares selected)

2
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d. HitOK
7. This will overwrite the values in the Hectares field with the new correct values (since the shapes
have been clipped to the extent of the study site layer), yet the original number of hectares is
preserved in the OrigHect field.
8. To perform the population apportionment, open the Attribute Table of the clipped census block
layer again.
Click on Options and choose Add Field
b. Name the field PopSplit and make it of type Double
c. Backin the Attribute Table, right click on the name of the PopSplit field
d. Choose Calculate Values
e. In the Field Calculator, double click Hectares, then hit the / button, then double click
OrigHect, hit the * button, and finally double click the name of your Population field
f. Hit OK
9. The result s a field called PopSplit that contains the same proportion of the original census
population figure as the proportion of the clipped census block area to the original area.

o

Calculate residential density:

7. For each of the two new layers (parcels and census blocks clipped to extent of study sites), do the
following:

Open the layer’s Attribute Table

Right-click on the name of the field containing the unique ID of the study site

Choose Summarize

In the box beneath Choose one or more summary statistics..., click the + next to Hectares

Check the box next to Sum

Choose a name and location for the output summary table

. Click OK

8. Join one of the resulting summary tables to the other based on the study site ID field

9. Add a field called ResDensity of type double

10. Click Options and choose Calculate Values

11. In the Field Calculator, double click Sum_Popsplit, click the / button, and then double click the
Sum_Hect field from the residential parcel summary table

12. Hit OK

W an o

The field ResDensity now contains the result of dividing the apportioned census population for a study
site by the total area of residential parcels for the study site. The table can be joined with your study site
shapefile based on the site ID, allowing you to copy the values into a new field you can create in the
study site Attribute Table.

3.5 Population plus Employment per Unit Land Area (excluding water)

1. Basic Concept

Traditionally, population densities have been calculated in terms of people residing in an area.
However, if density has some direct relation to walking (e.g. though there being a critical mass
of people walking, via congestion, or via transit viability) then some kind of overall activity
density is a better measure than merely residential density. Of course there are many kinds of
activities that bring people to a place—e.g. employment, school, tourism, leisure. Of these
employment is a major generator of movement and is also measured at a fine scale—though
these very localized data are difficult to get access to.

A later version of this manual will discuss sources that have used this measure including
(Messenger and Ewing 1996, 149-50)
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2. Basic Formula
Population plus Employment per Unit Land Area = Persons in housing units plus total
employees per unit land area (excluding water).

3. Detailed Formula
Population plus Employment per Unit Land Area = Persons in housing units as measured by
the US Census at the block level plus total employees per unit land area (excluding water).

4. Comments and Explanations

Where census blocks are cut by the end of the measurement geography, the residential
population is apportioned according to the percentage of land area falling inside and outside
the line.

Employment data are quite varied. We changed the data we planned to use during the course of
our study.

5. GIS Approach

[Note this uses employment data in grid cells, the result of a strategy to avoid confidentiality
problems with state employment data. However, we ended out using Dun and Bradstreet point
data so will redo these steps in the next version of the protocols.]

Add together the apportioned population and grid cell based employment for an area. Divide
this figure by the total land area after adjusting for the area of the removed water features.

6. GIS Steps
The following procedures were completed using ArcMap (ArcInfo) 8.3.

To follow this protocol you will need:

Study site layer (polygon) with unique ID field

Census block layer with population data (polygon)

Grid cell employment data (polygon)

Water features layer (polygon)

XTools extension (available from the Downloads section of the ESRI website)

P 29 [ =

Refer to the fundamental protocol for calculating Net Land Area (excluding water). That protocol will
create a study site layer that excludes water features and has updated area. In the rest of this protocol,
any references to the study site layer assume that water features have been removed.

Add the study site layer and employment grid cell layers to your Map Document.

1. Open the Attribute Table of the employment grid cells.

2. Find the field containing the study site ID. Right-click on the name of the field and choose
Summarize

3. In the box below 2. Choose one or more summary statistics..., click the + next to the name of the field
containing the number of employees and then check the box for Sum

4. At the bottom of the dialog box, choose a name and location for the output summary table

5. Hit OK

Determine the apportioned census population figure for each site:
1. Add the site layer and census block layer to your Map Document.
2. From the XTools menu, select “Table Operations” and then “Calculate Area, Perimeter, Length,
Acres, and Hectares” (follow instructions included with the extension for XTools installation).
a. Under “Select layer to measure”, select the census block layer

ENVIRONMENT AND PHYSICAL ACTIVITY: GIS PROTOCOLS VERSION 2.3, August 2005, WORK IN PROGRESS 53
University of Minnesota, Twin Cities Walking Study, Metropolitan Design Center



b.

C.

d.

Under “Desired output units”, choose your units (depending on the study site size, try
Miles, Meters, or Feet, for example)

If you do not with to generate a parameter, such as Perimeter, Length, or Hectares,
deselect it now (leave Area and Hectares selected)

Hit OK

3. New fields called “Area” and “Hectares” will be created in the attribute table of your new census
block polygon layer with the areas of each polygon calculated in the units you chose (Area) and
in hectares (Hectares).

4. Open the GeoProcessing Wizard.

a.
b.

C.

d.
e.

f.

Choose Intersect two layers and click Next

Select your census blocks as the input layer

Select your study site layer as the overlay layer
Choose a name and location for the output layer
Click Finish

The new layer will be added to the Map Document

5. Open the Attribute Table of the census block layer created in the previous step.

2

b
C.
d.
e.
f.

Click on Options and choose Add Field

Name the field OrigHect and make it of type Double

Back in the Attribute Table, right click on the name of the OrigHect field
Choose Calculate Values

In the Field Calculator, double click Hectares and click OK.

You have now copied the values from Hectares to OrigHect

6. From the XTools menu, select “Table Operations” and then “Calculate Area, Perimeter, Length,
Acres, and Hectares” (follow instructions included with the extension for XTools installation).

a.

b.

C.

d.

Under “Select layer to measure”, select the clipped census block layer created in step 4
above

Under “Desired output units”, choose your units (depending on the study site size, try
Miles, Meters, or Feet, for example)

If you do not with to generate a parameter, such as Perimeter, Length, or Hectares,
deselect it now (leave Area and Hectares selected)

Hit OK

7. This will overwrite the values in the Hectares field with the new correct values (since the shapes
have been clipped to the extent of the study site layer), yet the original number of hectares is
preserved in the OrigHect field.

8. To perform the population apportionment, open the Attribute Table of the clipped census block
layer again.

a.

b
C.
d.
e

f.

Click on Options and choose Add Field

Name the field PopSplit and make it of type Double

Back in the Attribute Table, right click on the name of the PopSplit field

Choose Calculate Values

In the Field Calculator, double click Hectares, then hit the / button, then double click
OrigHect, hit the * button, and finally double click the name of your Population field
Hit OK

9. The result s a field called PopSplit that contains the same proportion of the original census
population figure as the proportion of the clipped census block area to the original area.

Perform final calculation
1. In the Attribute Table of the clipped census block layer, right click on the name of the site ID field
and choose Summarize

a. Inthe box beneath Choose one or more summary statistics..., click the + next to PopSplit
b. Check the box next to Sum

c. Choose a name and location for the output summary table

d. Click OK

2. Join the summary table of apportioned population and the summary table of employment into
the study site layer table using the ID field
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a. Add anew field of type double that will contain the result of the population plus
employment per hectare calculation

b. Right click on this new field and choose Calculate Values

c. In the Field Calculator, click the ( button, double click on the PopSplit field, click the +
button, double click the field containing the sum of employees, click the ) button, click
the / button, and finally double click on the Hectares field from the study site layer.

d. HitOK

The field you just calculated now contains the sum of apportioned population and total employment
divided by the study site’s area in hectares (excluding water).

3.6 Employment per Unit Land Area

1. Basic Concept

While residential population is the most often used density measure, and an overall activity
density is likely important, a number of researchers have propose that employment density
may be associated with walking. In downtown areas, this is obvious as congestion makes
automobiles less viable for transportation. However, in terms of the residential populations in
the Twin Cities Walking Study, employment density in these neighborhoods is more likely a
proxy of mixed use.

A later version of this manual will address prior studies using various employment density
measures, although many were only of land in parcels e.g. Cervero and Kockelman (1996, 8),
Ewing (1995, 55), Frank and Pivo (1994, 46-48).

2. Basic Formula
Employment per Unit Land Area = Total employees per unit land area (excluding water).

3. Detailed Formula
Employment Per Unit Area = Total employees per unit land area (excluding water).

4. Comments and Explanations
Area of water features is excluded in the calculation of area. The methods explained below are
narrowly tailored to the nature of the employment data we purchased.

Employment is from Dun and Bradstreet with some checking of data.

5. GIS Approach

The approach to this measurement is to perform a spatial join between the employment data
and the study sites for which employment density is needed. When doing the spatial join,
calculate the sum of all employment. Finally, divide the total employment for each study site by
its area.

6. GIS Steps
The following procedures were completed using ArcMap (ArcInfo) 8.3.

To follow this protocol you will need:

1. Study site layer (polygon) with unique ID field
2. Employment data (point)
3. Water features layer (polygon)
4. XTools extension (available from the Downloads section of the ESRI website)
ENVIRONMENT AND PHYSICAL ACTIVITY: GIS PROTOCOLS VERSION 2.3, August 2005, WORK IN PROGRESS 55

University of Minnesota, Twin Cities Walking Study, Metropolitan Design Center



Add the study site layer and employment layers to your Map Document.

Refer to the fundamental protocol for calculating Net Land Area (excluding water). Create a study site
polygon layer that has had water features erased from it and area data updated. Join the summary table
of employment to the Attribute Table of the study site layer with water removed based on the ID field.

1. Add anew field to the Attribute Table of type double called EmpPerHect or similar.

2. Right click on this field and choose Calculate Values

3. In the Field Calculator, double click the field containing the sum of employees, click the / button,
and then double click the Hectares field from the study site table

4. HitOK

The EmpPerHect field now contains the number of employees per hectare (excluding the area of water
features).

3.7 Housing Units per Unit Land Area (gross, census data) (without water)

1. Basic Concept
Housing units per hectare are a proxy for population density. However, housing units rather
than population is what is regulated by such mechanisms as zoning.

This measure uses census housing units. It would also be possible to use housing unit numbers
from parcel data, and this might well be more accurate toward the end of the inter-censal period
and in areas with a great deal of construction.

In the next version of the manual we will discuss earlier studies that used this measure e.g.
Krizek (2003 APA, 269), McNally and Ryan (1993, 70).

2. Basic Formula
Housing Units per Unit Land Area = Total housing units as counted by the census per unit land
area (excluding water).

3. Detailed Formula
Housing Units per Unit Land Area = Total housing units as counted by the census, including
both occupied and unoccupied units, per unit land area (excluding water).

4. Comments and Explanations
Where census blocks are cut by the end of the measurement geography, the Number of housing
units is apportioned according to the percentage of land area falling inside and outside the line.

5. GIS Approach

The approach to this measure is to intersect census blocks with the measurement geography
and apportion the housing units to the measurement geographies. Divide the housing units by
the total area.

6. GIS Steps
The following procedures were completed using ArcMap (ArcInfo) 8.3.

To follow this protocol you will need:
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Study site layer (polygon) with unique ID field

Parcel layer (polygon)

Census block layer (polygon) with field containing housing units

Water features layer (polygon)

XTools extension (available from the Downloads section of the ESRI website)

Determine the apportioned census population figure for each site:

1. Add the site layer and census block layer to your Map Document.
2. From the XTools menu, select “Table Operations” and then “Calculate Area, Perimeter, Length,
Acres, and Hectares” (follow instructions included with the extension for XTools installation).
a. Under “Select layer to measure”, select the census block layer
b. Under “Desired output units”, choose your units (depending on the study site size, try
Miles, Meters, or Feet, for example)
c. If you do not with to generate a parameter, such as Perimeter, Length, or Hectares,
deselect it now (leave Area and Hectares selected)
d. HitOK
3. New fields called “Area” and “Hectares” will be created in the attribute table of your new census
block polygon layer with the areas of each polygon calculated in the units you chose (Area) and
in hectares (Hectares).
4. Open the GeoProcessing Wizard.
a. Choose Intersect two layers and click Next
b. Select your census blocks as the input layer
c. Select your study site layer as the overlay layer
d. Choose a name and location for the output layer
e. Click Finish
f. The new layer will be added to the Map Document
5. Open the Attribute Table of the census block layer created in the previous step.
a. Click on Options and choose Add Field
b. Name the field OrigHect and make it of type Double
c. Backin the Attribute Table, right click on the name of the OrigHect field
d. Choose Calculate Values
e. In the Field Calculator, double click Hectares and click OK.
f.  You have now copied the values from Hectares to OrigHect
6. From the XTools menu, select “Table Operations” and then “Calculate Area, Perimeter, Length,
Acres, and Hectares” (follow instructions included with the extension for XTools installation).
a. Under “Select layer to measure”, select the clipped census block layer created in step 4
above
b. Under “Desired output units”, choose your units (depending on the study site size, try
Miles, Meters, or Feet, for example)
c. If youdonot with to generate a parameter, such as Perimeter, Length, or Hectares,
deselect it now (leave Area and Hectares selected)
d. HitOK
7. This will overwrite the values in the Hectares field with the new correct values (since the shapes
have been clipped to the extent of the study site layer), yet the original number of hectares is
preserved in the OrigHect field.
8. To perform the housing unit apportionment, open the Attribute Table of the clipped census block
layer again.
a. Click on Options and choose Add Field
b. Name the field HUSplit and make it of type Double
c. Backin the Attribute Table, right click on the name of the HUSplit field
d. Choose Calculate Values in the Field Calculator, double click Hectares, then hit the /
button, then double click OrigHect, hit the * button, and finally double click the name of
your Housing Units field. Hit OK
9. The result is a field called HUSplit that contains the same proportion of the original census

population figure as the proportion of the clipped census block area to the original area.
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3.8 Lot Coverage (without water)

1. Basic Concept
This is a measure of perceived density and is literally how much ground is covered with
buildings.

2. Basic Formula
Lot Coverage = Building footprint area divided by area in parcels excluding vacant or
agricultural land uses.

3. Detailed Formula
Same as above.

4. Comments and Explanations
Where buildings and/ or parcels are cut by the end of the measurement geography, just slice
them. This is an overall coverage measure for an entire measurement geography.

5. GIS Approach

Intersect building footprints with study sites and calculate area for the resulting layer. Perform
a definition query on the parcel layer to exclude vacant for the resulting layer. Summarize the
tables from the two layers resulting from the previous intersect procedures by measurement
geography ID and generate the sum of the areas. Divide the sum of building footprint hectares
by the sum of parcel areas for each measurement geography. t and agricultural areas, then
intersect it with the measurement geographies and calculate area
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6. GIS Steps
The following procedures were completed using ArcMap (ArcInfo) 8.3.

To follow this protocol you will need:
1. Study site layer (polygon) with unique ID field
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2. Parcel layer (polygon)
3. Building footprints layer (polygon)
4. XTools extension (available from the Downloads section of the ESRI website)

Determine total area of building footprints for each site:
Add the site layer and building footprints layer to your Map Document.
Open the GeoProcessing Wizard.
Choose Intersect two layers and click Next
Select your building footprints as the input layer
Select your study site layer as the overlay layer
Choose a name and location for the output layer
Click Finish
The new layer will be added to the Map Document
From the XTools menu, select “Table Operations” and then “Calculate Area, Perimeter, Length,
Acres, and Hectares” (follow instructions included with the extension for XTools installation).
a. Under “Select layer to measure”, select the layer created in the previous step
b. Under “Desired output units”, choose your units (depending on the study site size, try
Miles, Meters, or Feet, for example)
c. If you do not with to generate a parameter, such as Perimeter, Length, or Hectares,
deselect it now (leave Area and Hectares selected)
d. Hit “OK”
New fields called “Area” and “Hectares” will be created in the attribute table of your new building
footprints polygon layer with the areas of each polygon calculated in the units you chose (Area)
and in hectares (Hectares).

moap o

Determine total area of parcels for each site:
1. Add the site layer and parcel layer to your Map Document.
2. Open the GeoProcessing Wizard.
a. Choose Intersect two layers and click Next
b. Select your parcels as the input layer
c. Select your study site layer as the overlay layer
d. Choose a name and location for the output layer
e. Click Finish
f.  The new layer will be added to the Map Document
3. From the XTools menu, select “Table Operations” and then “Calculate Area, Perimeter, Length,
Acres, and Hectares” (follow instructions included with the extension for XTools installation).
a. Under “Select layer to measure”, select the layer created in the previous step
b. Under “Desired output units”, choose your units (depending on the study site size, try
Miles, Meters, or Feet, for example)
c. If youdonot with to generate a parameter, such as Perimeter, Length, or Hectares,
deselect it now (leave Area and Hectares selected)
d. Hit “OK”
4. New fields called “Area” and “Hectares” will be created in the attribute table of your new parcel
polygon layer with the areas of each polygon calculated in the units you chose (Area) and in
hectares (Hectares).

At this point you have a new parcel layer and a new building footprint layer. Both have been clipped to
the extent of your study sites, and each feature in the two new layers should have a field containing the
unique ID of the study site in which it is located.

For each of the two new layers, do the following;:

1. Open the layer’s Attribute Table
2. Right-click on the name of the field containing the unique ID of the study site
3. Choose Summarize
4. In the box beneath Choose one or more summary statistics..., click the + next to Hectares
5. Check the box next to Sum
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6. Choose a name and location for the output summary table
7. Click OK

Final calculation
1. Join the summary table of building footprint area to the summary table of parcel area based on
the study site ID field.
Add a field of type Double named LotCover or similar (this will contain the final desired result).
Right-click on the name of this new field and select Calculate Values
Click yes to bypass the question about not being in an edit session.
In the Field Calculator:
a. Using the list of available fields, double click on the Sum_Hectares field from the
building footprint summary table
Click on the / button to the right
Double click on the Sum_Hectares field from the parcel summary table
Click OK to perform the calculation.

O = @) )
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The result is a table with one record for each study site that also contains the lot coverage (building
footprint area divided by parcel area). This table can be joined into the study site layer and the values
copied over into a new field if desired.

The following variables are not proposed to be used in the study, so only a
detailed formula is included.

3.9 Housing Units per Unit Land Area (parcel data)--Not Used in Study

Detailed Formula

Housing Units per Unit Land Area (parcel data)= Total housing units in parcels in parcel data,
including occupied and unoccupied units of all sorts, per unit land area including land inside
and outside parcels *but excluding water). Where buildings and / or parcels are cut by the end of
the measurement geography, just slice them. This is an overall density measure for an entire
measurement geography. Care needs to be taken with group quarters.

3.10 Housing Units per Unit Residential Land Area—Not Used in Study

Detailed Formula

Housing Units per Unit Residential Land Area = Total housing units as counted by the census
per area of land in residential parcels (excluding water). Where census blocks are cut by the end
of the measurement geography, the Number of housing units is apportioned according to the
percentage of land area falling inside and outside the line.

Note: This is the housing unit equivalent of Residential Population in Residential Parcels. The
next draft of this manual will relate this variable to dwellings per net area in Ewing (1995, 55).

3.11 Households per Unit Land Area (excluding water) —Not Used in Study

Detailed Formula

Households per Unit Land Area (excluding water) = Total households as counted by the census
in blocks per unit land area (excluding water). Where census blocks are cut by the end of the
measurement geography, the population is apportioned according to the percentage of land
area falling inside and outside the line. See e.g. Rutherford et al (2000, 15).
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4. PEDESTRIAN INFRASTRUCTURE

Chapter by: Ann Forsyth (drafting, conceptual issues and formulae, some comments and GIS approach
text) and Joel Koepp (GIS Steps and the rest of the GIS approach/comments text)

Between Versions 2.0 and 2.2 there were significant updates to protocols 4.3, 4.6, 4.7, 4.8, 4.10, and
4.11.

Background

Pedestrian infrastructure includes the built and planted features that provide pedestrian
amenities or that affect pedestrian mobility, safety, and comfort. From marked pedestrian
crossings to street trees, these are more open to modification than the basic street pattern._This
dimension matters because:

» Pedestrians are exposed to the outdoor elements—amenities can make walking much
more enjoyable.

* Pedestrians have unique safety concerns, some of which are affected by design features
e.g. street lights, pedestrian crossings.

» The street pattern and pedestrian infrastructure such as sidewalks do not always
coincide—some areas with gridded street patterns do not have sidewalks; some areas with
superblocks and culs-de-sac have pedestrian path and trail networks (Forsyth 2002).
Examining pedestrian infrastructure can uncover some of this complexity.

However, measurements of this dimension are the least developed because data are incomplete
or unavailable, so measurement includes data collection as well as analysis. Some studies
assume that more “traditional” neighborhoods with gridded streets and high connectivity
possess good pedestrian infrastructure. However, more detailed measures have been developed
based on field observations, interviews, and GIS based indicators such as completeness of the
sidewalk system (Hess et al. 1999).

4.1 Sidewalk Length per Unit Area

1. Basic Concept

Sidewalks are thought to support walking.
Intuitively, this is likely to be the case on busy
roads though the relationship is less clear in the
case of slower roads. Sidewalk length in an area
also reflects the density of streets compared
with the ratio of sidewalks to roads. One could
imagine a moderate value on this measure with
both a very dense street network with
sidewalks on some streets or a street pattern
with larger blocks but a complete sidewalk
system. Both may promote walking.

l — __’_—/--://“\"
—_————
T —— -
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2. Basic Formula
Sidewalk Length in an Area = Sum together the length of all sidewalk segments in a particular
area.

3. Detailed Formula Figure 1: Sidewalks in a neighborhood along
Sidewalk Length in an Area = Total sidewalk some streets and not others

length of all sidewalks in area where they are located along public rights of way. This excludes
sidewalks in parks, informal paths, and cuts-through. [The next version will explain the case of
sidewalks connecting dead end streets—we had few of these.]

4. Comments and Explanations
Sidewalk data are inconsistently collected. As explained in Chapter 1, we digitized all sidewalks
from high resolution orthophotos of the area and field checked the data.

5. GIS Approach

The GIS approach is to perform a spatial intersect between the sidewalks and the study sites.
Open the attributes of the resulting layer and summarize the data using the unique study site
ID field. When doing the table summary, calculate the Sum of the Length field. The new table
created will be the sum of the length of all sidewalk segments for each study site.

6. GIS Steps
The following procedures were completed using ArcMap (ArcInfo) 8.3.

To follow this protocol you will need:
1. Study site layer (polygon) with unique ID field
2. Sidewalk layer (polyline)
3. XTools extension (available from the Downloads section of the ESRI website)

Add the site layer and sidewalk layer to your Map Document.
1. Open the GeoProcessing Wizard.
a. Choose Intersect two layers and click Next
b. Select your sidewalks as the input layer
c. Select your study site layer as the overlay layer
d. Choose a name and location for the output layer
e. Click Finish
f.  The new layer will be added to the Map Document
2. From the XTools menu, select “Table Operations” and then “Calculate Area, Perimeter, Length,
Acres, and Hectares” (follow instructions included with the extension for XTools installation).
a. Under “Select layer to measure”, select the clipped sidewalk layer created in the previous
step
b. Under “Desired output units”, choose your units (depending on the study site size, try
Miles, Meters, or Feet, for example)
c. Ifyoudonot with to generate a parameter, such as Perimeter, Length, or Hectares,
deselect it now
d. Hit “OK”
3. Open the Attribute Table of the new sidewalk layer
a. Right click on the name of the unique study site ID field and choose Summarize
b. Click the + to expand the Length field and check the box next to Sum
c. Select a name and location for the output summary table
d. Click OK

This summary table contains records for all the study sites, along with a Sum_Length field that contains
the total length of all sidewalks in the study site.
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4.2 Sidewalk Length Divided by Road Length

1. Basic Concept
More complete and continuous sidewalks are thought to support walking. This measure focuses
on the proportion of the road network that has sidewalks.

The next version of these protocols will discuss the previous uses of this measure e.g. Hess et al
(1999, 10).

2. Basic Formula
Sidewalk Length Divided by Road Length = Sum together the length of all sidewalk segments
along public rights of way and divide by the length of all road centerlines.

3. Detailed Formula

Sidewalk Length Divided by Road Length = Sum together the length of all sidewalk segments
along public rights of way and divide by the length of all road centerlines for roads where
pedestrians have access i.e. excluding interstates and other limited access roads. Divided roads
are counted as one.

4. Comments and Explanations
Where sidewalks and / or roads are cut by the end of the measurement geography, just slice
them. This is an overall ratio measure for an entire measurement geography.

The results of this calculation can vary based on which definition of “roads” is used, i.e.,
whether or not freeway entrance/exit ramps are included, length of divided roads is averaged,
etc. See the protocol for Road Length per Hectare for more details.

The area that we studied did not have private roads.

5. GIS Approach

Use the GeoProcessing Wizard to intersect sidewalks with measurement geographies. Use
XTools to recalculate the lengths of all sidewalk segments. Finally, summarize the intersected
sidewalks by measurement geography ID, calculating the sum of the Length field in the process.

6. GIS Steps
The following procedures were completed using ArcMap (ArcInfo) 9.0.

To follow this protocol you will need:
1. Study site layer (polygon) with unique ID field
2. Road features layer (polyline)
3. Sidewalk layer (polyline)
4. XTools extension (available from the Downloads section of the ESRI website)

Refer to the earlier Protocol 4.1 on calculating sidewalk length. Once a summary table of sidewalk length
by study site exists, perform calculation of road length:

Add the roads layer and study sites layer to a new ArcMap document
In Arc Toolbox, go to Analysis Tools 2Overlay and select Intersect
Under Input Features, select both the roads layer and the study sites
Under Output Feature Class, choose a name and location for the output layer
Click OK
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The new layer will be added to the Map Document

In Arc Toolbox, go to Data Management Tools ?Generalization and select Dissolve

For Input Features, select the layer created in step 3

Under Output Feature Class, choose a name and location for the output file

Under Dissolve_Field(s), check the box for the field containing the unique ID of your study sites

Click OK

The resulting file should consist of road segments and have the same number of features as you have
study sites

To complete the calculation, divide the length of all sidewalks in a study site (from the summary table
created earlier) by the length of all roads in that study site.

4.3 Sidewalk Length per Length of Major Road

1. Basic Concept
The basic idea behind this measure is that sidewalks are more important on major roads than on
side streets. Ann Vernez Moudon (2004) and her team have used the measure.

2. Basic Formula
Sidewalk Length Divided by Length of Major Road = Length of sidewalks along major roads
only divided by the length of those major roads in an area.

3. Detailed Formula

Sidewalk Length Divided by Length of Major
Road = Using major roads only, sum together
the length of all sidewalk segments along
public rights of way on those roads and
divide by the length of all road centerlines

o
!
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after removing roads with no pedestrian \ L | |

access and averaging the length of divided
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4. Comments and Explanations ] L

As Vernez Moudon had a different road file, )g 1] |

we defined major roads as roads larger than ] W

neighborhood streets but smaller than ﬁ — —

interstates and US highways (four lane (Tl

divided, limited access roads not available to — %*

pedestrians). This is possible using the _\T;

F_CLASS field in the roads data. Selecting = {jJ il ; E

roads of F_CLASS “A30" and *A25" will i .

identify the collectors and arterials to be used

as majgr roads. We removed by hand certain MR \\M T s

roads within this group known to be four Figure 2: Major roads (collectors and arterials)

lane divided with no pedestrian access. differentiated from other roads. These roads
often have attractive destinations but also have

5. GIS Approach problems of traffic safety

Select features with F_CLASS =‘A25 OR
*A30’ from the roads file, and average the lengths of divided roads to create a major roads layer.
Intersect the major roads with measurement geographies. Summarize the Attribute Table of the
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resulting layer and calculate the length of all major roads in each study site. Use Select by
Location to identify features in the sidewalks layer that are within a certain distance (e.g., 10
meters) of the major roads and save them as a new layer. Use the GeoProcessing Wizard to
intersect the sidewalks along major roads with measurement geographies. Use XTools to
recalculate the lengths of all sidewalk segments. Summarize the attribute table of intersected
sidewalks by measurement geography ID, calculating the sum of the Length field in the process.
Divide each site’s sidewalk length by the length of its major roads.

6. GIS Steps
The following procedures were completed using ArcMap (ArcInfo) 8.3.

To follow this protocol you will need:
1. Study site layer (polygon) with unique ID field
2. Sidewalk layer (polyline)
3. Roads layer (polyline)
4. XTools extension (available from the Downloads section of the ESRI website)

Calculate length of major roads
1. Right click on the roads layer and choose Data->Export Data to make a copy of the roads layer
for the purpose of editing
2. Choose a location for the output file and name it major_roads or similar
3. Click Yes to add the new layer to the view
4. Go to the Editor toolbar and select Editor->Start Editing
a. Select the directory that contains the major roads layer and click OK
b. Open the Selection menu and choose Select By Attributes
c. Select the major roads layer in the top drop down box
d. Make sure the method is Create a new selection
a. Type out an expression that will identify non-walkable roads (freeways and on/ off
ramps), such as “F_CLASS” <=“A25" OR “F_CLASS” >‘A30
e. Double check that all the roads intended to be removed are selected, then hit the Delete
key to remove them
f.  For every divided road, use the Edit Tool from the Editor Toolbar to select one of the two
segments and delete it
g. When all edits are complete, go to the Editor Toolbar and choose Editor->Stop Editing,
clicking Yes when prompted to save edits
5. Open the GeoProcessing Wizard.
Choose Intersect two layers and click Next
b. Select your major roads as the input layer
c. Select your study site layer as the overlay layer
d. Choose a name and location for the output layer
e. Click Finish
f.  The new layer will be added to the Map Document
6. From the XTools menu, select “Table Operations” and then “Calculate Area, Perimeter, Length,
Acres, and Hectares” (follow instructions included with the extension for XTools installation).
a. Under “Select layer to measure”, select the intersected major roads layer created in the
previous step
b. Under “Desired output units”, choose Meters
c. Hit“OK”
7. Open the Attribute Table of the intersected major roads layer
a. Right click on the name of the unique study site ID field and choose Summarize
b. Click the + to expand the Length field and check the box next to Sum
c. Select a name and location for the output summary table
d. Click OK

2
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This summary table contains records for all the study sites, along with a Sum_Length field that contains
the total length of all major roads in the study site.

1. Add the site layer and sidewalk layer to your Map Document.
Open the Selection menu and choose Select By Location
In the top drop down box, choose select features from
Check the box next to the sidewalks layer
In the second drop down box, choose are within distance of
In the last drop down box, choose the major roads layer
Check the box next to Apply a buffer to the features... and enter a distance and the units
(e.g., 10 meters)
Click Apply
In the Table of Contents, right click on the sidewalks layer and choose Data->Export Data
Save the selected features to a new layer named major_sidewalks or similar
2. Open the GeoProcessing Wizard.
a. Choose Intersect two layers and click Next
b. Select your major sidewalks as the input layer
c. Select your study site layer as the overlay layer
d. Choose a name and location for the output layer
e. Click Finish
f.  The new layer will be added to the Map Document
3. From the XTools menu, select “Table Operations” and then “Calculate Area, Perimeter, Length,
Acres, and Hectares” (follow instructions included with the extension for XTools installation).
a. Under “Select layer to measure”, select the sidewalk layer created in the previous step
b. Under “Desired output units”, choose your units (depending on the study site size, try
Miles, Meters, or Feet, for example)
c. If you do not with to generate a parameter, such as Perimeter, Length, or Hectares,
deselect it now
d. Hit “OK”
4. Open the Attribute Table of the new major sidewalk layer
a. Right click on the name of the unique study site ID field and choose Summarize
b. Click the + to expand the Length field and check the box next to Sum
c. Select a name and location for the output summary table
d. Click OK
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This summary table contains records for all the study sites, along with a Sum_Length field that contains
the total length of all sidewalks along major roads in the study site.

To complete the calculation, use the two summary tables created using these instructions. For each study
site, divide the length of sidewalks along the major roads by the length of all major roads.

4.4 Street Lights per Length of Road

1. Basic Concept . . . e

Safety from accidents and crime is an important - | | i
issue for pedestrians. Lighting improves both | . h 1
forms of safety at night. . Eo— |

The next version of these protocols will review . G o—
previous uses of related variables e.g. Cervero | ’ | ! s
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2. Basic Formula
Street Lights per Length of Road = Number of street lights divided by total length of road
centerlines.

3. Detailed Formula

Street Lights per Length of Road = Number of street lights (multiple headed fixtures classed as
one) divided by total length of road centerlines for roads that are accessible to pedestrians (i.e.
not limited access highways).

4. Comments and Explanations
Where roads are cut by the end of the measurement geography, just slice them. This is an
overall ratio measure for an entire measurement geography.

5. GIS Approach

Perform a spatial join between the street lights and the measurement geographies to determine
the number of street lights in each measurement geography. Intersect the roads layer with the
measurement geographies. With the resulting layer, open the attributes and summarize the
table using the field containing the unique measurement area ID. When summarizing the table,
calculate the sum of all fields containing numbers, which will result in an output table with a
field containing the length of all road segments. Divide the number of street lights in each
measurement geography by the total road length in that measurement geography.

6. GIS Steps
The following procedures were completed using ArcMap (ArcInfo) 8.3.

To follow this protocol you will need:
1. Study site layer (polygon) with unique ID field
2. Street lights layer (point)
3. Roads layer (polyline)
4. XTools extension (available from the Downloads section of the ESRI website)

Add the site layer and street lights layer to your Map Document.
1. Perform a Spatial Join on your new buffer layer
a. Right click on your new layer and select Joins and Relates and then Join...
b. Under “What do you want to join to this layer?” select Join data from another layer based on
spatial location
c.  Under “1. Choose the layer to join to this layer” select your clipped intersection layer
(point)

d. Under “2. You are joining:” select the first option Each polygon will be given a summary...
e. Under “How do you want the attributes to be summarized?” check the box for Sum

f.  Under “3. The result of the join will be saved...” give your new layer a name

g. Click on OK

Add the roads layer to your Map Document.

1. Open the GeoProcessing Wizard.
a. Choose Intersect two layers and click Next
b. Select your roads as the input layer
c. Select your study site layer as the overlay layer
d. Choose a name and location for the output layer
e. Click Finish
f.  The new layer will be added to the Map Document

2. From the XTools menu, select “Table Operations” and then “Calculate Area, Perimeter, Length,

Acres, and Hectares” (follow instructions included with the extension for XTools installation).
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a. Under “Select layer to measure”, select the clipped roads layer created in the previous
step
b. Under “Desired output units”, choose Meters
c. If you do not with to generate a parameter, such as Perimeter, Length, or Hectares,
deselect it now
d. Hit“OK”
3. Open the Attribute Table of the new roads layer
Right click on the name of the unique study site ID field and choose Summarize
Click the + to expand the Length field and check the box next to Sum
Select a name and location for the output summary table.
Click OK

anpow

You now have a summary table of road length in meters by study site. Join this table into the table of the
layer that resulted from the spatial join of lights to study sites above (based on the site ID field).
1. Add a field of type double to hold the result of your street lights per meter calculation.
2. Right click on this new field in the Attribute Table and choose Calculate Values
3. In the field selector box, double click the field containing the number of street lights, then click
the / button, and finally double click the field containing the length of roads
4. HitOK

4.5 Street Trees (trees within an X distance buffer) per Length of Road

1. Basic Concept

Street trees are thought to improve pedestrian comfort (shade, wind protection) and the
attractiveness of the street. While this is a measure per length of road, it is in many ways a
density measure weighted by road length, as all trees within a certain area are being counted.

A later version of these protocols will examine the use of related concepts by earlier researchers
e.g. Cervero and Kockelman (1996, 8,) who looked at the proportion of blocks with street trees.

2. Basic Formula

Street Trees (trees within a 15/20 meter
buffer) per Length of Road = Number of | ™
street trees within a buffer distance of 15/20 \

meters of the road centerline per length of '

road. —[
e

3. Detailed Formula
The size of the road buffer depends on the
character of the road. For city streets, the [ J

buffer is 15 meters from the street centerline.
For arterials and larger roads, the buffer is 20
meters from the centerline. These roads were
identified by querying the F_CLASS
(functional class) field for values less than or
equal to A30 (A30 is typically a major arterial,

A20 a state or US highway, and A10 an
interstate). \/_J

Figure 4: Only trees found within the road buffer
are counted
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4. Comments and Explanations

We digitized trees from high resolution digital orthophotos. Where trees had a continuous
canopy so that marking individual trees was difficult, tree stands were photographed and then
sorted into high, medium, and low density. We measured densities of trees in three areas and
used these figures, and some research on tree density ranges, to allocate trees into general
density ranges with a clear upper limit. The upper limit was so that a very dense stand in one
area, that may be perceived similarly to a stand that is much less dense but still has a lot of
trees, did not bias the tree density too much. The working density figures are 60 trees per acre
for low density, 200 for medium density, and 400 for high density. However, these figures are
subject to review as we refine these measurements. Trees can reach very high densities, well
over 1,000 per acre.

5. GIS Approach

The GIS approach to this calculation requires two stages. First, a spatial join between the road
buffer and the tree points will yield the count of trees per study site. Next, the road buffer must
be intersected with the tree polygons (which represent dense stands of trees) and the count of
trees must be determined by calculating the area of the resulting features and multiplying it by
the assigned tree density. Finally, the count of tree points and count of trees in polygons must
be added together and divided by the area of the road buffer.

6. GIS Steps
The following procedures were completed using ArcMap (ArcInfo) 9.0.

To follow this protocol you will need:

Study site layer (polygon) with unique ID field

Roads layer (polyline)

Trees layer (point)

Tree stands layer (polygon) with a field containing the density

XTools extension (available from the Downloads section of the ESRI website)

o 9 [ 1=

Prepare roads layer for buffering

Open the Attribute Table of the roads layer

Click on Options and choose Add Field

Name the field BuffDist and make it of type Short Integer, then click OK

Click on Options and choose Select by Attributes

Double click the field “F_CLASS”, then click the <= button, and then select “A30" from the unique
values

Click Apply to select major arterials from the roads layer

In the Attribute Table, right click the name of the BuffDist field and choose Calculate Values
Type in 20 and click OK to assign a value of 20 to the selected records

. In the Attribute Table, click Options and choose Switch Selection

0. Right click the name of the BuffDist field and choose Calculate Values

1. Type in 15 and click OK to assign a value of 15 to the selected records

o 29 [ 1=
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Buffer road features

In Arc Toolbox, open Analysis Tools 2Proximity, and select Buffer.

In the Buffer tool window, under Input Features select your roads layer

Under Output Feature Class, choose a name and location for the output shapefile
For Distance, click Field and select the BuffDist field from the list

Click OK

o 29 [ =

Create road buffers for each study site
1. In Arc Toolbox, go to Analysis Tools 2Ouverlay and select Intersect
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Under Input Features, select both the buffered roads layer from the previous step and the study
sites

Under Output Feature Class, choose a name and location for the output layer

Click OK

The new layer will be added to the Map Document

In Arc Toolbox, go to Data Management Tools 2Generalization and select Dissolve

For Input Features, select the layer created in step 3

Under Output Feature Class, choose a name and location for the output file

Under Dissolve_Field(s), check the box for the field containing the unique ID of your study sites
Click OK

The resulting file should consist of road buffers and have the same number of features as you
have study sites

Count tree points

1.

2.
3.
4.

In the Table of Contents pane, right click on the road buffers layer created in the last step and go
to Join and Relates 2Join

Choose to Join data from another layer based on spatial location

Below, click the radio button that provides a summary of numeric attributes

Choose a name and location for the output file and click OK

Count trees in tree stands

1. In Arc Toolbox, go to Analysis Tools 2Ouverlay and select Intersect
2. Under Input Features, select both the buffered roads layer from the previous step and tree stands
layer
3. Under Output Feature Class, choose a name and location for the output layer
4. Click OK
5. The new layer will be added to the Map Document
6. In Arc Toolbox, go to Data Management Tools 2Generalization and select Dissolve
7. For Input Features, select the layer created in step 3
8. Under Output Feature Class, choose a name and location for the output file
9. Under Dissolve_Field(s), check the boxes for the field containing the unique ID of your study sites
and the unique ID of the tree stands
10. Under Statistics Field(s), choose Density
11. Set the Statistic Type to be First
12. Click OK
13. From the XTools menu, select “Table Operations” and then “Calculate Area, Perimeter, Length,
Acres, and Hectares” (follow instructions included with the extension for XTools installation).
a. Under “Select layer to measure”, select the output layer from the dissolve above
b. Under “Desired output units”, choose your units (depending on the study site size, try
Miles, Meters, or Feet, for example)
c. If you do not with to generate a parameter, such as Perimeter, Length, or Hectares,
deselect it now (leave Area and Hectares selected)
d. HitOK
e. New fields called “Area” and “Hectares” will be created in the attribute table of your
new census block polygon layer with the areas of each polygon calculated in the units
you chose (Area) and in Hectares (Hectares).
14. Open the Attribute Table of the layer of created in the dissolve procedure above
15. Click on Options and choose Add Field
16. Name the field Trees and set it to type Double, then hit OK
17. Right click on the name of this field and do Calculate Values
18. Double click the name of the Density field (First_Dens), then click the * button, finally double
click the Hectares field and hit OK
19. This will calculate the number of trees in each tree stand based on the density and area.
20. In the Attribute Table, right click on the field containing the study site unique ID and choose
Summarize
21. For the Trees field, check the box the calculate the Sum summary statistic
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22. Choose a name and location for the output table
23. This summary table should contain one record for each study site and the total number of trees in
tree stands for each.

Add together the count of tree points and count of trees in tree stands for each study site. Refer to the
protocol for calculating road length to calculate it, then divide the total trees for each study site by its total
road length.

Note, the next variables use data from an urban design inventory that uses
sample data and may need to be modified for 100% data

4.6 Percent of Street Segments with Marked Pedestrian Crossings at One
or Both Ends

1. Basic Concept

Marked pedestrian crossings may help pedestrian movement, though they may also indicate
busy streets. This measure is very broad and looks for at least some marked crossings and does
not require all potential crossing areas to be marked. If it becomes interesting

This variable is based on the following inventory question that was filled in for both ends of the
segment.

2a. Consider the places on the segment that are intended for pedestrians to cross the
street. Are these places marked for pedestrian crossing?
All = 3; Some = 2; none = 0; NA = 8 (lines 7 and 211 of inventory)

2. Basic Formula

Percent of Street Segments with Marked Pedestrian Crossings at One or Both Ends = Total street
segments in area that were sampled, divided by the number that score 2 or 3 on this variable at
one or both ends.

3. Detailed Formula
As above.

4. Comments and Explanations
None.

5. GIS Approach

The GIS approach to creating this variable begins with identifying which sampled road
segments have marked pedestrian crossings. Perform a spatial intersect between the sampled
road segments and the measurement geography. The output needs to be dissolved using both
the unique measurement geography ID and the unique road segment ID (in case the features of
the measurement geography overlap each other). The attribute table of the dissolved output
must then be summarized using the measurement geography ID field. This will yield a new
table containing both a count of the number of road segments with marked crossings and the
total number of road segments. Divide the number of segments with marked crossings by the
total to determine the percentage.

6. GIS Steps
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The following procedures were completed using ArcMap (ArcInfo) 9.0.

To complete this protocol you will need:
1. Site layer (polygon)
2. Roads layer (polyline) with unique ID for each road segment
3. Urban Design Inventory (table) with road segment IDs

Identify sampled roads with marked pedestrian crossings
1. Add the sampled roads layer and Urban Design Inventory table to an ArcMap document
a. Right click on the Inventory table and choose Joins and Relates—> Relate
b. Initem 1 of the Relate dialog box, choose the field in the Inventory table that contains the
unique road segment ID (in our case, Linel)
c. Initem 2, choose the sampled roads layer
d. Initem 3, select the field from the sampled roads layer that contains the unique ID (in our
case, TLGID)
Click OK
2. nght click the Inventory table and choose Open
a. A road segment with a marked crossing at either end will be counted as having marked
crossings
b. Click Options and choose Select By Attributes
c. Enter the expression “Line7” <> 0 OR “Line211” <> 0 and hit Apply, then Close
d. This will select the road segments that have one or more ends with marked crossings
3. Click Options and choose Related Tables>Relatel to open the sampled roads layer and select the
matching records
In the sampled roads Attribute Table, select Options—=>Add Field
Name the field Crossings and make it of type Short Integer, then hit OK
Right click on the new Crossings field and choose Calculate Values
Enter 1 and hit OK to assign a value of 1 to the highlighted records (sampled roads that
have crossings at one or both ends)

oo o

Combine sampled roads and measurement geographies
1. Intersect the roads and measurement geographies
a. In ArcToolbox, open the Analysis Tools=> Overlay-> Intersect tool
b. Select the sampled roads and the measurement geography as the Input Features
c. Choose a name and location for the Output Feature Class
d. Hit OK
2. Open the Data Management Tools—>Generalization-> Dissolve tool
a. Select the output layer from the Intersect tool above as the Input Feature
b. Choose a name and location for the Output Feature Class
c. Select both the unique measurement geography ID and the unique sampled road ID as
the Dissolve Fields
d. Choose Crossings as the Statistics field and set the Statistic Type to MAX or MIN (it
doesn’t matter which one, this is just a way of preserving the field and carrying it over to
the output file)
e. HitOK

Count roads and roads with crossings
2. Open the Attribute Table of the output layer from the Dissolve tool process
a. Right click on the field containing the unique ID of the measurement geographies and
choose Summarize
b. In the dialog box that appears, click the + symbol next to the MAX_Crossings field and
check the box for Sum to calculate the sum of that field as a summary statistic
c. Choose a name and location for the output summary table
d. Hit OK
e. Click Yes to add the table to the ArcMap document
3. Open the summary table
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a. Click Options and choose Add Field

b. Name it PctCross or similar and set it to type Double

c. Right click the added field in the table and choose Calculate Values

d. In the dialog box, enter the expression [SUM_MAX_Cr] / [Count] (the field names may
be slightly different depending on the names you chose earlier)

e. HitOK

This divides the number of segments with marked crossings by the total number of sampled segments for
each feature in the measurement geographies

4.7 Percent of Street Segments with Visible Litter, Graffiti, or Dumpsters

1. Basic Concept
General maintenance and cleanliness is thought to affect attractiveness and a sense of safety for
pedestrians.

This variable is based on the following inventory questions.

44. How much graffiti is apparent on this segment?
Some/a lot = 3; little = 2; none = 0 (line 166)

45. How much litter is apparent on this segment?
Some/a lot = 3; little = 2; none = 0 (line 167)

46. Are there dumpsters visible on this segment?
Some/a lot = 3; few = 2; none = 0 (Line 168)

2. Basic Formula

Percent of Street Segments with Visible Litter, Graffiti, or Dumpsters = The total number of
inventory segments in an area with at least one instance of “some/a lot” (i.e. score 3) of graffiti,
litter, or dumpsters visible, divided by the total number of segments sampled in an area.

3. Detailed Formula
As above.

4. Comments and Explanations
None.

5. GIS Approach

The GIS approach to creating this variable begins with identifying which sampled road
segments have visible litter, graffiti, or dumpsters. Perform a spatial intersect between the
sampled road segments and the measurement geography. The output needs to be dissolved
using both the unique measurement geography ID and the unique road segment ID (in case the
features of the measurement geography overlap each other). The attribute table of the dissolved
output must then be summarized using the measurement geography ID field. This will yield a
new table containing both a count of the number of road segments with visible litter, etc. and
the total number of road segments. Divide the number of segments with visible litter, etc. by the
total to determine the percentage.

6. GIS Steps
The following procedures were completed using ArcMap (ArcInfo) 9.0.

ENVIRONMENT AND PHYSICAL ACTIVITY: GIS PROTOCOLS VERSION 2.3, August 2005, WORK IN PROGRESS 73
University of Minnesota, Twin Cities Walking Study, Metropolitan Design Center



To complete this protocol you will need:
1. Site layer (polygon)
2. Roads layer (polyline) with unique ID for each road segment
3. Urban Design Inventory (table) with road segment IDs

Identify sampled roads with visible litter, graffiti, or dumpsters
1. Add the sampled roads layer and Urban Design Inventory table to an ArcMap document
a. Right click on the Inventory table and choose Joins and Relates—> Relate
b. Initem 1 of the Relate dialog box, choose the field in the Inventory table that contains the
unique road segment ID (in our case, Line1)
c. Initem 2, choose the sampled roads layer
d. Initem 3, select the field from the sampled roads layer that contains the unique ID (in our
case, TLGID)
Click OK
2. R1ght click the Inventory table and choose Open
a. Click Options and choose Select By Attributes
b. Enter the expression “Linel66” =3 OR “Line167” = 3 OR “Line168” = 3 and hit Apply,
then Close
c. This will select the road segments that are defined as having visible litter, graffiti, or
dumpsters
3. Click Options and choose Related Tables->Relatel to open the sampled roads layer and select the
matching records
a. In the sampled roads Attribute Table, select Options—> Add Field
b. Name the field Litter and make it of type Short Integer, then hit OK
c. Right click on the new Litter field and choose Calculate Values
d. Enter 1 and hit OK to assign a value of 1 to the highlighted records (sampled roads that
have visible litter, etc)

Combine sampled roads and measurement geographies
1. Intersect the roads and measurement geographies
a. In ArcToolbox, open the Analysis Tools>Ouverlay-> Intersect tool
b. Select the sampled roads and the measurement geography as the Input Features
c. Choose a name and location for the Output Feature Class
d. Hit OK
2. Open the Data Management Tools=>Generalization-> Dissolve tool
a. Select the output layer from the Intersect tool above as the Input Feature
b. Choose a name and location for the Output Feature Class
c. Select both the unique measurement geography ID and the unique sampled road ID as
the Dissolve Fields
d. Choose Litter as the Statistics field and set the Statistic Type to MAX or MIN (it doesn’t
matter which one, this is just a way of preserving the field and carrying it over to the
output file)
e. HitOK

Count roads and roads with visible litter, graffiti, or dumpsters
1. Open the Attribute Table of the output layer from the Dissolve tool process
a. Right click on the field containing the unique ID of the measurement geographies and
choose Summarize
b. In the dialog box that appears, click the + symbol next to the MAX_Litter field and check
the box for Sum to calculate the sum of that field as a summary statistic
c. Choose a name and location for the output summary table
d. Hit OK
e. Click Yes to add the table to the ArcMap document
2. Open the summary table
a. Click Options and choose Add Field
b. Name it PctLitt or similar and set it to type Double
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c. Right click the added field in the table and choose Calculate Values

d. In the dialog box, enter the expression [SUM_MAX_Li] / [Count] (the field names may
be slightly different depending on the names you chose earlier)

e. HitOK

This divides the number of segments with visible litter, graffiti, or dumpsters by the total number of
sampled segments for each feature in the measurement geographies

4.8 Percent of Street Segments with Traffic Calming, Broadly Defined
1. Basic Concept
This variable is based on the following inventory questions.

51. Are there measures on this segment that could slow down traffic? Mark all that
apply. Speed bump/speed hump/raised crosswalk; or dips (that are intended to
slow down traffic)
yes =1,n0o=0 (line 177)

Rumble strips or bumps (includes dots, reflectors, raised concrete strips, etc.)
yes=1;n0o=0 (line 178)

Curb bulb out/ curb extension
yes =1;n0o=0 (line 179)

Traffic circle/ roundabout
yes =1;n0o=0 (line 180)

Median
yes =1;,n0o=0 (line 181)

Angled/ On-street parking (that runs along most or the entire segment - does not have
to be on both sides of segment)
yes =1;n0o=0 (line 183)

Other
yes =1;n0=0 (line 184)

2. Basic Formula

Percent of Street Segments with Traffic Calming, Broadly Defined = The total number of
inventory segments in an area with at least one instance of one of the features above, divided by
the total number of segments sampled in an area.

3. Detailed Formula
As above.

4. Comments and Explanations
None.

5. GIS Approach

The GIS approach to creating this variable begins with identifying which sampled road
segments have traffic calming. Perform a spatial intersect between the sampled road segments
and the measurement geography. The output needs to be dissolved using both the unique
measurement geography ID and the unique road segment ID (in case the features of the
measurement geography overlap each other). The attribute table of the dissolved output must
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then be summarized using the measurement geography ID field. This will yield a new table
containing both a count of the number of road segments with traffic calming and the total
number of road segments. Divide the number of segments with traffic calming by the total to
determine the percentage.

6. GIS Steps
The following procedures were completed using ArcMap (ArcInfo) 9.0.

To complete this protocol you will need:
1. Site layer (polygon)
2. Roads layer (polyline) with unique ID for each road segment
3. Urban Design Inventory (table) with road segment IDs

Identify sampled roads with visible litter, graffiti, or dumpsters
1. Add the sampled roads layer and Urban Design Inventory table to an ArcMap document
a. Right click on the Inventory table and choose Joins and Relates—> Relate
b. Initem 1 of the Relate dialog box, choose the field in the Inventory table that contains the
unique road segment ID (in our case, Linel)
c. Initem 2, choose the sampled roads layer
d. Initem 3, select the field from the sampled roads layer that contains the unique ID (in our
case, TLGID)
e. Click OK
2. Right click the Inventory table and choose Open
a. A road segment with a value of 1 for at least one of the seven questions will be counted
as having traffic calming
b. Click Options and choose Select By Attributes
c. Enter the expression “Linel77” <> 0 OR “Linel78” <> 0 OR “Linel79” <> 0 OR
“Linel80” <> 0 OR “Line181” <> 0 OR “Linel83” <> 0 OR “Line184” <> 0 and hit Apply,
then Close
d. This will select the road segments that have at least one element of traffic calming
3. Click Options and choose Related Tables->Relatel to open the sampled roads layer and select the
matching records
a. In the sampled roads Attribute Table, select Options—>Add Field
b. Name the field Calming and make it of type Short Integer, then hit OK
c. Right click on the new Calming field and choose Calculate Values
d. Enter 1 and hit OK to assign a value of 1 to the highlighted records (sampled roads that
have traffic calming)

Combine sampled roads and measurement geographies
1. Intersect the roads and measurement geographies
a. In ArcToolbox, open the Analysis Tools=>Ouverlay->Intersect tool
b. Select the sampled roads and the measurement geography as the Input Features
c. Choose a name and location for the Output Feature Class
d. Hit OK
2. Open the Data Management Tools—>Generalization—> Dissolve tool
a. Select the output layer from the Intersect tool above as the Input Feature
b. Choose a name and location for the Output Feature Class
c. Select both the unique measurement geography ID and the unique sampled road ID as
the Dissolve Fields
d. Choose Calming as the Statistics field and set the Statistic Type to MAX or MIN (it
doesn’t matter which one, this is just a way of preserving the field and carrying it over to
the output file)
e. Hit OK

Count roads and roads with visible traffic calming
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e Attribute Table of the output layer from the Dissolve tool process

Right click on the field containing the unique ID of the measurement geographies and
choose Summarize

In the dialog box that appears, click the + symbol next to the MAX_Calming field and
check the box for Sum to calculate the sum of that field as a summary statistic

Choose a name and location for the output summary table

Hit OK

Click Yes to add the table to the ArcMap document

e summary table

Click Options and choose Add Field

Name it PctCalm or similar and set it to type Double

Right click the added field in the table and choose Calculate Values

In the dialog box, enter the expression [SUM_MAX_Ca] / [Count] (the field names may
be slightly different depending on the names you chose earlier)

Hit OK

number of segments with traffic calming by the total number of sampled segments for

each feature in the measurement geographies

4.9 Other fieldwork based measurements of neighborhood identification,

street cross

ing, street characteristics, views, land uses, barriers, sidewalks,

bicycle lanes, mid block crossing, steepness, sidewalk amenities, street

trees, buildi

ngs, windows, other features of buildings, garages, parking,

driveways, maintenance, lighting, freeways, traffic features,
architecture/design.

To add in subsequent editions.]
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4.10 Distance to Nearest Transit Stop

1. Basic Concept

People walk to transit. The distance to the
nearest transit stop may be associated with
physical activity.

2. Basic Formula

Distance to Nearest Transit Stop = Network
or straight line distance from residence to
nearest transit stop.

3. Detailed Formula
As above.

4. Comments and Explanations
This is also done using Network Analyst in
ArcView 3.3 (see network buffers above)

using a function called Find Closest Facility.

You can specify a point layer to use as your
“facilities” and then also a point to serve as
your origin. It will then take the road
network and calculate the shortest path to a
“facility” (and it can do this using travel
costs as well if, for instance, certain types of
roads were considered more or less easy to
use).

The basic function only works for a limited
number of base points (12). In our case we
had 715 valid participant addresses so
needed to use an ArcView extension called
Multiple Closest Facilities. It can be
downloaded from the ESRI website at
http:/ /arcscripts.esri.com / details.asp?dbid
=13125. For points that do not fall on the
network, there is a dialog box when using
this extension that allows the user to decide
how far away from the network to search
for points to use in the processing. We
selected a distance of 250 meters. Points
outside that distance will not be used.

5. GIS Approach

The approach for this measure is to load a
set of origins (in this case, participant
locations) and destinations (transit stops).
Then use the Find Closest Facility feature in
Network Analyst or the Multiple Closest

e

Direct line from residence at star in upper part
of image to nearest bus stop as the crow flies.

Line along the street network from residence
at star in upper part of image to nearest bus
stop along the network. Note that it is a
different stop to the one in the illustration
above.
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Facilities extension to calculate the network distance from each origin to the nearest transit stop.

6. GIS Steps
The following procedures were completed using ArcView 3.3.

To complete this protocol you will need:
Roads layer (polyline)
7. A participant locations layer (point)
8. A transit stops layer (point)
9. The Network Analyst extension for ArcView
10. The Multiple Closest Facilities extension for ArcView

Calculate network distance to nearest transit stop
14. Start a new ArcView project and create a blank View
a. Open the View menu and choose Add Theme
b. Add the roads, participant locations, and transit stops layers to the View
c.  Open the View menu and choose Properties
d. Make sure the map units (meters, feet, etc.) match the units of the data layers
e. Open the File menu and choose Extensions
. Check the box next to the Multiple Closest Facilities extension and click OK
15. Open the Network Tools menu that has been added and choose Multiple closest facilities
16. In the dialog box that appears, select the participant locations layer in the From dropdown box
17. Select the unique ID of the participant locations layer in the From ID field dropdown box
18. In the To dropdown box, select the transit stops layer
19. Choose the unique ID of the transit stops layer in the To ID field dropdown box
20. In the Network dropdown box, select the roads layer
21. For Facilities to find, enter 1
22. Set the Cutoff Distance to 0
23. The Search Tolerance is a distance in the current map units that Network Analyst will search away
from the road features to find points. Make this number large enough so the process will not miss
any of the participant locations
24. Click Travel to facility
25. Check the box for Create Join Table
26. Hit Process

When the process ends, the extension will add a new polyline feature to the View consisting of the
network segments that trace the shortest path from each participant location to its nearest transit stop.
The table of the new layer contains an Origin field with the unique ID of the participant locations layer, a
Destin field with the unique ID of the closest transit stop, and a Length field with the distance in the
current map units between the participant location and the closest transit stop.

4.11 Transit Stop Density

1. Basic Concept
Transit stops may also be a proxy for a walkable neighborhood. Transit stop density may
correlate with overall activity.

2. Basic Formula
Transit Stop Density= Number of transit stops per unit area.

3. Detailed Formula
As above.
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4. Comments and Explanations
None.

5. GIS Approach

The GIS approach is to perform a spatial join between the measurement geographies and the

transit stops. This will count the number of stops in each measurement geography. Then divide

this number by the net land area of each measurement geography.

6. GIS Steps
The following procedures were completed using ArcMap (ArcInfo) 9.0.

To complete this protocol you will need:
1. Site layer (polygon)
2. Transit stops layer (point)
3. Water features layer (polygon)
4. XTools extension (available from the Downloads section of the ESRI website)

Refer to Protocol 2.1 for the procedures to calculate net land area (land area with water features
removed).

Add the transit stops and site layers to an ArcMap document
1. Right click on the site layer and choose Joins and Relates=> Join

2. Under the dropdown box labeled What do you want to join to this layer?, choose Join data from

another layer based on spatial location
3. Instep 1 of the dialog box, choose the transit stops layer

4. Instep 2, click the button to choose Each polygon will be given a summary of the numeric attributes,

etc
In step 3, choose a name and location for the output layer
Hit OK

NUCRC

feature of the measurement geography

Calculate transit stops per net land area

1. In the Table of Contents, right click on the output layer from the spatial join performed above

and choose Joins and Relates=> Join
2. In the dropdown box, choose to Join attributes from a table
3

In step 1, choose to base the join on the field containing the unique ID of the measurement

geographies
4. Instep 2, load the table from the result of following Protocol 2.1, Net Land Area
5

In step 3, choose the field in the net land area layer’s table containing the unique ID of the

measurement geographies
6. Hit OK

7. Open the Attribute Table of the output layer from the spatial join, which now has the net land

area table joined into it
8. Click Options and choose Add Field
9. Name the field StopDens or similar, and set it to be type Double
10. Right click on the new field and choose Calculate Values

11. In the Field Calculator dialog box, double click the Count field, then click the / button, and

finally double click the name of the field containing the net land area
12. Click OK

The output layer now contains a Count field with the number of transit stops found in each

This field now contains the density of transit stops (number of transit stops divided by the net land area

in whichever units you used).
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The following variables are not proposed to be used in the study, so only a
detailed formula is included.

4.12 Percentage of Blocks with Full Length Sidewalks

Detailed Formula

Percentage of Blocks with Full Length Sidewalks = Percentage of block faces that have a
sidewalk along the entire length of at least one side without gaps (see related measure in
Cervero and Kockelman 1996, 8).

4.13 Percentage of Blocks with Street Lights

Detailed Formula

Percentage of Blocks with Street Lights = Percentage of block faces that have at least one street
light. This will involve creating some kind of logical formula to capture this (see related
measure in Cervero and Kockelman 1996, 8, 16).

ENVIRONMENT AND PHYSICAL ACTIVITY: GIS PROTOCOLS VERSION 2.3, August 2005, WORK IN PROGRESS 81
University of Minnesota, Twin Cities Walking Study, Metropolitan Design Center



5. LAND USE MIX

Chapter by: Ann Forsyth (drafting, conceptual issues and formulae, some comments and GIS approach
text) and Jason Zimmerman (GIS Steps, many comments/GIS approach text). Reference to additional
materials by the team of Active Living Research grantees at the University of North Carolina, led by
Daniel Rodriguez.

In Version 2.1 compared with Version 2.0 the basic outlines of several new protocols were added. These
include: 5.8, 5.9, 5.10, 5.15. Significant changes were made to 5.13 and 5.14. An error was corrected in
5.6 (now similar land uses = 0 in both 5.6 and 5.7). In version 2.2, the dissimilarity variables were
significantly elaborates, and the “North Carolina” variables were also expanded. In version 2.3 the
“North Carolina” variables were clarified.

Background

Mixed use is a measure of different activities. However, as Grant (2002) outlines “mixed-use” is
often used to indicate a mix of housing types e.g. detached houses and apartments.
Transportation planning is in part based on the insight that people move to go between
different activities or different destinations.

It is proposed that certain kinds of mixed land uses are particularly important, particularly ones
that can provide:
e A greater variety of attractive destinations within walking distance. However, this
raises a number of issues: is variety or attractiveness key? Once a critical mass of land
use variety has been reached, will more mix make a difference (Krizek 2003 a, b)? In
measurement there has been a focus on commercial destinations but other destinations
are important also: schools, faith-based facilities, or parks (Audirac 1999).
e More visual variety and interest for pedestrians. Varied land uses are seen as
promoting architectural and landscape variety.
o Greater street safety due to informal policing -- one is less likely to be alone with an
attacker. This assumes that uses have a mixture of opening hours, particularly in the
evening, and generate pedestrian traffic. However, some uses may be perceived to
undermine safety—e.g. rowdy bars.

Measures of mixed use have typically been either quite broad—looking at any mix—or have
focused on retail destinations. However, other destinations are potentially important such as
parks and civic uses. As Krizek (2003a, b) outlines common measures have included:
¢ Field observations or self report—simple reports on whether mix is present.
¢ Density and distance measures including of total employment or businesses; density
of specific kinds of land uses, businesses and jobs; or distances to particular kinds of
businesses (e.g. Cervero and Gorham 1995, Handy 1992).
e Entropy and dissimilarity indices that measure overall mix (e.g. Frank and Pivo
1994; Cervero and Kockelman 1996, 1997).
The now fairly wide availability of parcel level land use data allows other measurements based
on particular kinds of land uses (see McNally and Kulkarni 1997, 109; Crane and Crepeau 1998).

Several different sorts of data are used in mixed use measures. Land use data shows how land
is actually used at the parcel level. This is distinct form the zoning for a parcel which is what is
allowed to be built in the future. Employment data can indicate establishments and is useful in
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determining the scale of economic activity. However, it is less useful for ascertaining the
presence of some destinations such as parks..

5.1 Percentage of Total Parcel Area in Major Land Uses (seven land uses
in this case)

1. Basic Concept

A simple measure of land use percent in major uses. This is less a measure of mix per se than
the relative amount of each land use: residential, commercial, office, industrial, institutional,
park and recreation, vacant.

The next draft of these protocols will review earlier work that has used similar measures e.g.
McNally and Kulkarni (1997, 109) examined a ratio of commercial area to total area.

2. Basic Formula

Percentage of Total Parcel Area in Major Land Uses = Total area in each of seven major land use
categories (residential, commercial, office, industrial, institutional, park and recreation, vacant)
divided by total land area in parcels.

3. Detailed Formula

Percentage of Total Parcel Area in Major Land Uses = Total area in parcels in each of the seven
major land use categories (residential, commercial, office, industrial, institutional, park and
recreation, vacant) divided by total land area in parcels, with water area removed. Note that
some land uses (agricultural, airport, non-roadbed right-of-way) are not included in our seven
major land use categories but are included in the total land area figures.
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Parcels coded with the seven major land use categories (residential — yellow; commercial — red;
tax exempt — purple; office — blue; park and recreation — green; industrial — dark grey; Vacant
not marked).

4. Comments and Explanations
Land uses were assigned at the parcel level and reflected the most detailed data available. These
data were then generalized to our seven major land use categories.

Complicating factors may, however, be unique to our data :

a. Two different water layers were used for exclusions (see earlier discussion in chapter 1)

b. We used two methods for assigning land uses, depending on if the parcels were in our
original Context Areas or if they fell within our extended buffer areas (see Appendix 5C
for details on how this was done)

c. In general we field-checked in the context areas and where large buffers fell outside the
context areas we felt that the errors from using Metropolitan Council data would not be
so large

5. GIS Approach

The parcel layer (with areas of water removed) was intersected with the measurement
geographies and the areas of the parcels recalculated to account for those that were split by the
study site boundaries. The land uses associated with each parcel were generalized into seven
major land use categories. For each study site, the total area of each land use category was
summarized. The percentages of the total parcel area for each study site were then calculated.

6. GIS Steps

[Future versions will update for buffer-related steps and refer to Appendix 5C for details on creating
Context Area land uses]

The following procedures were completed using ArcMap (ArcInfo) 8.3.

To complete this protocol you will need:
4. Site layer (polygon)
5. Land use parcel layer (polygon)
6. XTools extension (available from the Downloads section of the ESRI website)

The basic steps are:
e  Determine Net Land Area (without water) for each Site
o Intersect Parcels with Site Layer
e  Conwvert Land Uses into 7 Categories
o  Summarize Land Use Hectares for each Site
o  Calculate Land Use Percentages for each Site

Determine Net Land Area (without water) for each Site:
2. Follow the steps outlined in the protocol above.

Intersect Parcels with Site Layer:
5. If the site layer does not have unique IDs or names for each site, create them now.
6. Using the GeoProcessing Wizard, intersect the land use parcel layer with the new (net area) site
polygon layer
g. Under the Tools menu, select “GeoProcessing Wizard”.

h. Select “Intersect two layers” and click on “Next”.
i. Under “Select the input layer to intersect:” choose your land use parcel layer.
j- Under “Select a polygon clip layer:” choose your site layer.
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k. Give your file a name and hit “Finish”.
The parcels will now be clipped to the study site boundaries, have areas of water
removed, and be assigned the IDs associated with each study site. Note that parcels that
exist in two or more overlapping study sites will now be represented by two or more
identical (except for ID number) rows in the attribute table).
7. From the XTools menu, select “Table Operations” and then “Calculate Area, Perimeter, Length,
Acres, and Hectares” (follow instructions included with the extension for XTools installation).
e. Under “Select layer to measure”, select your new land use parcel layer
f.  Under “Desired output units”, choose your units (depending on the parcel size, try
Meters or Feet, for example)
g. If you do not with to generate a parameter, such as Perimeter, Length, or Hectares,
deselect it now (leave Area and Hectares selected)
h. Hit “OK”
8. New fields called “Area” and “Hectares” will be created in the attribute table of your new land
use parcel layer with the areas of each polygon calculated in the units you chose (Area) and in
hectares (Hectares).

=

Convert Land Uses into 7 Categories:

1. Open the attribute table for the land use parcels.

2. Click on the “Options” button and select “Add Field...”.

3. Create a field called 7LUC that is type “Text”.

4. Reclassify your parcels so that the land uses are generalized into the 7 major land use categories
(residential, commercial, office, industrial, institutional, park and recreation, vacant). How this is
done depends on the level of detail of your existing land use categories — for example, if you have
Small-scale Commercial, Strip Commercial, and Shopping Center land uses, these would all be
generalized to a new land use code of Commercial.

5. Enter the new land use codes in the 7LUC field.

Summarize Land Use Hectares for each Site:

1. Right click on the land use parcel layer and select “Properties”.

2. Click the “Definition Query” tab and click the “Query Builder” button.

3. In the “SELECT * FROM ... WHERE:” box select the parcels that are one of the new generalized
land use categories.

4. Click “OK” then click “Apply”. Now, only parcels in the 7 major land use categories will be
shown in the attribute table.

5. Under the XTools drop-down menu, select “Table Operations” and “Export to Excel”.

6. Select your land use parcel layer and the following three fields: ID, Hectares, and 7LUC.

7. Click “OK”. Depending on the number of parcels you have selected, it may take some time to
export the data to Excel.

8. The new Excel file will contain the hectares of the land uses in each study site; use Excel’s
Subtotals command (under the Data drop-down menu) to summarize and group this
information.

9. Re-query the land use parcel layer to once again include all parcels (do not include areas of water
or roads). Follow steps 3-6 but modify the criteria for the parcels to be selected.

10. Return to the land use parcel attribute table.

11. Right-click on the field that contains the IDs and select Summarize.

12. Under “2. Choose one or more summary statistics...” expand the box labeled “Hectares” and
check the box marked “Sum”.

13. Select or create an output file name and hit OK.

14. The output .dbf file will contain the total hectares of the land use in each study site.

Calculate Land Use Percentages for each Site:
1. In Excel or other spreadsheet program, combine the land use hectares and your total parcel
hectares based on the site ID numbers.
2. For each land use category in each site, divide the land use hectares by total parcel hectares to get
the percentages of total parcel area in the 7 major land use categories.
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5.2 Percentage of Land Area in Night Time Uses

1. Basic Concept

Part of the benefit of mixed use is thought to be the increased activity that it provides at various
times of the day and night. This increases safety and increases the time period in which
destinations are available to give a reason for walking.

2. Basic Formula
Percentage of Land Area in Night Time Uses = Total area in parcels with Night Time Uses
divided by total land area in parcels.

3. Detailed Formula
Percentage of Land Area in Night Time Uses = Total area in parcels with Night Time Uses
divided by total land area in parcels with water area removed. The specific uses classed as night
time are the following, in terms of Ramsey County uses:

a. HOTELS

b. SUPERMARKETS

c. RESTURANT, CAFETERIA, AND/OR BAR

d. CONVENIENCE STORE

e. THEATERS
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Parcels with Night Time Uses highlighted.

4. Comments and Explanations
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Ramsey County parcels included detailed land use codes. Parcels outside of Ramsey County
were field checked to populate a land use data field with the same level of detail.

5. GIS Approach

Using the parcel layer that was intersected with the study sites (from above), the parcels with
Night Time Uses were selected. For each study site, the total hectares of the parcels with Night
Time Uses were summarized. The percentages of the land area in Night Time Uses for each
study site were then calculated.

6. GIS Steps
The following procedures were completed using ArcMap (ArcInfo) 8.3.

To complete this protocol you will need:
1. Net area land use parcel layer (polygon) created above
2. XTools extension (available from the Downloads section of the ESRI website)

The basic steps are:
o Select Parcels with Night Time Uses
o  Summarize Land Use Hectares for each Site
o  Calculate Land Use Percentages for each Site

Select Parcels with Night Time Uses:
2. Open the attribute table for the land use parcels.
3. Click on the “Options” button and select “Add Field...”.
4. Create a field called NIGHT that is type “Text”.
5. Select any parcels that qualify as “Night Time Uses”. The following are the uses we selected:
a. HOTELS
b. SUPERMARKETS
c. RESTURANT, CAFETERIA, AND/OR BAR
d. CONVENIENCE STORE
e. THEATERS
6. Enter a new land use code in the NIGHT field.

Summarize Land Use Hectares for each Site:

Right click on the land use parcel layer and select “Properties”.

Click the “Definition Query” tab and click the “Query Builder” button.

In the “SELECT * FROM . . . WHERE:” box select the parcels that are night time uses.

Click “OK” then click “Apply”. Now, only parcels that are night time uses will be shown in the

attribute table.

Under the XTools drop-down menu, select “Table Operations” and “Export to Excel”.

Select your land use parcel layer and the ID and Hectares fields.

Click “OK”. Depending on the number of parcels you have selected, it may take some time to

export the data to Excel.

8. The new Excel file will contain the hectares of the night time uses in each study site; use Excel’s
Subtotals command (under the Data drop-down menu) to summarize and group this
information.

9. Re-query the land use parcel layer to once again include all parcels (do not include areas of water
or roads). Follow steps 1-4 but modify the criteria for the parcels to be selected.

10. Return to the land use parcel attribute table.

11. Right-click on the field that contains the IDs and select Summarize.

12. Under “2. Choose one or more summary statistics...” expand the box labeled “Hectares” and
check the box marked “Sum”.

13. Select or create an output file name and hit OK.

14. The output .dbf file will contain the total hectares of the land use in each study site.

e

NGO
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Calculate Land Use Percentages for each Site:
1. In Excel or other spreadsheet program, combine the land use hectares and your total parcel
hectares based on the site ID numbers.
2. For each land use category in each site, divide the land use hectares by total parcel hectares to get
the percentages of total parcel area in the night time uses.

5.3 Percentage of Land Area in Social Uses

1. Basic Concept
Land uses that perform a social or civic function may be important destinations for walking.
These are often missed in measures of mixed use that focus on retail and other commercial uses.

2. Basic Formula
Percentage of Land Area in Social Uses = Total area in parcels with Social Uses divided by total
land area in parcels.

3. Detailed Formula

Percentage of Land Area in Social Uses = Total area in parcels with Social Uses divided by total
land area in parcels with water area removed. Social uses include the following Ramsey County
uses:

DAY CARE CENTERS

MEDICAL CLINICS AND OFFICES

THEATERS

BOWLING ALLEYS

LODGE HALLS AND AMUSEMENT PARKS
SPORT/PUBLIC ASSESMBLY FACILITY
EXEMPT COMMUNITY RECREATIONAL FAC.
LIBRARY

EXEMPT PROPERTY OWNED BY BD OF EDUC.
EXEMPT PROP OWNED BY PRIVATE SCHOOLS
CHURCHES ETC PUBLIC WORSHIP PRIVE

- NS
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4. Comments and Explanations
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Ramsey County parcels included detailed land use codes. Parcels outside of Ramsey County

were field checked to populate a land use data field with the same level of detail.

5. GIS Approach

Using the parcel layer that was intersected with the study sites (from above), the parcels with

Social Uses were selected. For each study site, the total hectares of the parcels with Social Uses
were summarized. The percentages of the land area in Social Uses for each study site were then

calculated.

6. GIS Steps
The following procedures were completed using ArcMap (ArcInfo) 8.3.

To complete this protocol you will need:
1. Net area land use parcel layer (polygon) created above
2. XTools extension (available from the Downloads section of the ESRI website)

The basic steps are:
o Select Parcels with Social Uses
e  Summarize Land Use Hectares for each Site
o Calculate Land Use Percentages for each Site

Select Parcels with Social Uses:
1. Open the attribute table for the land use parcels.
2. Click on the “Options” button and select “Add Field...”.
3. Create a field called SOCIAL that is type “Text”.
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4. Select any parcels that qualify as “Social Uses”. The following are the uses we selected:

DAY CARE CENTERS

MEDICAL CLINICS AND OFFICES

THEATERS

BOWLING ALLEYS

LODGE HALLS AND AMUSEMENT PARKS

SPORT /PUBLIC ASSESMBLY FACILITY

EXEMPT COMMUNITY RECREATIONAL FAC.

LIBRARY

EXEMPT PROPERTY OWNED BY BD OF EDUC.

EXEMPT PROP OWNED BY PRIVATE SCHOOLS
v. CHURCHES ETC PUBLIC WORSHIP PRIVE

5. Enter a new land use code in the SOCIAL field.

EorenoaTopg

Summarize Land Use Hectares for each Site:

Right click on the land use parcel layer and select “Properties”.

Click the “Definition Query” tab and click the “Query Builder” button.

In the “SELECT * FROM . .. WHERE:” box select the parcels that are social uses.

Click “OK” then click “Apply”. Now, only parcels that are social uses will be shown in the

attribute table.

Under the XTools drop-down menu, select “Table Operations” and “Export to Excel”.

Select your land use parcel layer and the ID and Hectares fields.

Click “OK”. Depending on the number of parcels you have selected, it may take some time to

export the data to Excel.

8. The new Excel file will contain the hectares of the social uses in each study site; use Excel’s
Subtotals command (under the Data drop-down menu) to summarize and group this
information.

9. Re-query the land use parcel layer to once again include all parcels (do not include areas of water
or roads). Follow steps 1-4 but modify the criteria for the parcels to be selected.

10. Return to the land use parcel attribute table.

11. Right-click on the field that contains the IDs and select Summarize.

12. Under “2. Choose one or more summary statistics...” expand the box labeled “Hectares” and
check the box marked “Sum”.

13. Select or create an output file name and hit OK.

14. The output .dbf file will contain the total hectares of the land use in each study site.

= @) =

No o

Calculate Land Use Percentages for each Site:
1. In Excel or other spreadsheet program, combine the land use hectares and your total parcel
hectares based on the site ID numbers.
2. For each land use category in each site, divide the land use hectares by total parcel hectares to
get the percentages of total parcel area in the social uses.

5.4 Percentage of Land Area in Retail Uses

1. Basic Concept
Retail uses are an important destination for trips. These protocols use a number of different
retail measures including land use (this protocol) and employment data (see below).

A later version of these protocols will deal with how retail measures have been used in previous
studies e.g. Crane and Crepeau (1998, 26) who examined the share of each census tract in
commercial use and Cervero and Kockelman (1996, 8) who looked at retail uses per developed
hectare.
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2. Basic Formula
Percentage of Land Area in Retail Uses = Total area in parcels with Retail Uses divided by total
land area in parcels.

3. Detailed Formula

Percentage of Land Area in Retail Uses = Total area in parcels with Retail Uses divided by total
land area in parcels with water area removed. Retail uses include the following Ramsey County
uses:

SMALL (UNDER 10,000SF) DETACH RETAI

SUPERMARKETS

DISCOUNT STORES & JR. DEPT STORES

MEDIUM DETACHED RETAIL

FULL LINE DEPARTMENT STORES

NEIGHBORHOOD SHOPPING CENTER

COMMUNITY SHOPPING CENTER

RESTURANT, CAFETERIA, AND/OR BAR

SMALL STRIP CENTER

CONVENIENCE STORE

FULL SERVICE BANKS
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Parcels with retail uses highlighted.

4. Comments and Explanations
Ramsey County parcels included detailed land use codes. Parcels outside of Ramsey County
were field checked to populate a land use data field with the same level of detail.
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5. GIS Approach

Using the parcel layer that was intersected with the study sites (from above), the parcels with
Retail Uses were selected. For each study site, the total hectares of the parcels with Retail Uses
were summarized. The percentages of the land area in Retail Uses for each study site were then
calculated.

6. GIS Steps
The following procedures were completed using ArcMap (ArcInfo) 8.3.

To complete this protocol you will need:
1. Net area land use parcel layer (polygon) created above
2. XTools extension (available from the Downloads section of the ESRI website)

The basic steps are:
e Select Parcels with Retail Uses
e Summarize Land Use Hectares for each Site
o  Calculate Land Use Percentages for each Site

Select Parcels with Retail Uses:
1. Open the attribute table for the land use parcels.
2. Click on the “Options” button and select “Add Field...”.
3. Create a field called RETAIL that is type “Text”.
4. Select any parcels that qualify as “Retail Uses”. The following are the uses we selected:
SMALL (UNDER 10,000SF) DETACH RETAI
. SUPERMARKETS
DISCOUNT STORES & JR. DEPT STORES
MEDIUM DETACHED RETAIL
FULL LINE DEPARTMENT STORES
NEIGHBORHOOD SHOPPING CENTER
COMMUNITY SHOPPING CENTER
RESTURANT, CAFETERIA, AND/OR BAR
SMALL STRIP CENTER
CONVENIENCE STORE
v. FULL SERVICE BANKS
5. Enter a new land use code in the RETAIL field.

EorenoaTopg

Summarize Land Use Hectares for each Site:

Right click on the land use parcel layer and select “Properties”.

Click the “Definition Query” tab and click the “Query Builder” button.

In the “SELECT * FROM . . . WHERE:” box select the parcels that are retail uses.

Click “OK” then click “Apply”. Now, only parcels that are retail uses will be shown in the

attribute table.

Under the XTools drop-down menu, select “Table Operations” and “Export to Excel”.

Select your land use parcel layer and the ID and Hectares fields.

Click “OK”. Depending on the number of parcels you have selected, it may take some time to

export the data to Excel.

8. The new Excel file will contain the hectares of the social uses in each study site; use Excel’s
Subtotals command (under the Data drop-down menu) to summarize and group this
information.

9. Re-query the land use parcel layer to once again include all parcels (do not include areas of water
or roads). Follow steps 1-4 but modify the criteria for the parcels to be selected.

10. Return to the land use parcel attribute table.

11. Right-click on the field that contains the IDs and select Summarize.
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12. Under “2. Choose one or more summary statistics...” expand the box labeled “Hectares” and
check the box marked “Sum”.

13. Select or create an output file name and hit OK.

14. The output .dbf file will contain the total hectares of the land use in each study site.

Calculate Land Use Percentages for each Site:
1. In Excel or other spreadsheet program, combine the land use hectares and your total parcel
hectares based on the site ID numbers.
2. For each land use category in each site, divide the land use hectares by total parcel hectares to
get the percentages of total parcel area in the retail uses.

5.5 Percentage of Land Area in Industrial and Auto-Oriented Uses

1. Basic Concept
Industrial and auto-oriented land uses are thought to deter walking.

2. Basic Formula
Percentage of Land Area in Industrial and Auto-Oriented Uses = Total area in parcels with
Industrial and Auto-Oriented Uses divided by total land area in parcels.

3. Detailed Formula
Percentage of Land Area in Industrial and Auto-Oriented Uses = Total area in parcels with
Industrial and Auto-Oriented Uses divided by total land area in parcels with water area
removed. Industrial uses include the following Ramsey County uses:

INDUSTRIAL, VACANT LAND

FOOD&DRINK PROCESS PLANTS AND STORAE

FOUNDERIES&HEAVY MANUFACT PLANTS

MANUFACTURING & ASSEMBLY LIGHT

GRAIN ELEVATORS

OTHER INDUSTRIAL STRUCTURES

CAR WASHES

AUTO CAR SALES AND SERVICES

PARKING GARAGE STRUCTURE & LOTS

FLEX INDUSTRAIL CENTER

COMMERCIAL WAREHOUSES

MINI WAREHOUSE
. COMMERCIAL TRUCK TERMINALS

RAILROAD REAL PROP USED IN OPERATION

BECATESR S a0 T
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Parcels with industrial and auto-oriented uses highlighted.

4. Comments and Explanations

Ramsey County parcels included detailed land use codes. Parcels outside of Ramsey County

were field checked to populate a land use data field with the same level of detail.

5. GIS Approach

Using the parcel layer that was intersected with the study sites (from above), the parcels with
Industrial and Auto-Oriented Uses were selected. For each study site, the total hectares of the

parcels with Industrial and Auto-Oriented Uses were summarized. The percentages of the land

area in Industrial and Auto-Oriented Uses for each study site were then calculated.

6. GIS Steps
The following procedures were completed using ArcMap (ArcInfo) 8.3.

To complete this protocol you will need:
1. Net area land use parcel layer (polygon) created above
2. XTools extension (available from the Downloads section of the ESRI website)

The basic steps are:
o Select Parcels with Industrial and Auto-Oriented Uses
e  Summarize Land Use Hectares for each Site
o  Calculate Land Use Percentages for each Site

Select Parcels with Industrial and Auto-Oriented Uses:
1. Open the attribute table for the land use parcels.
2. Click on the “Options” button and select “Add Field...”.
3. Create a field called AUTO that is type “Text”.
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4. Select any parcels that qualify as “Industrial and Auto-Oriented Uses”. The following are the uses
we selected:
o. INDUSTRIAL, VACANT LAND
FOOD&DRINK PROCESS PLANTS AND STORAE
FOUNDERIES&HEAVY MANUFACT PLANTS
MANUFACTURING & ASSEMBLY LIGHT
GRAIN ELEVATORS
OTHER INDUSTRIAL STRUCTURES
CAR WASHES
AUTO CAR SALES AND SERVICES
. PARKING GARAGE STRUCTURE & LOTS
FLEX INDUSTRAIL CENTER
COMMERCIAL WAREHOUSES
z. MINI WAREHOUSE
aa. COMMERCIAL TRUCK TERMINALS
bb. RAILROAD REAL PROP USED IN OPERATION
5. Enter a new land use code in the AUTO field.

dxgdegTp Ay

Summarize Land Use Hectares for each Site:

1. Right click on the land use parcel layer and select “Properties”.

2. Click the “Definition Query” tab and click the “Query Builder” button.

3. Inthe “SELECT * FROM ... WHERE:” box select the parcels that are industrial and auto-oriented
uses.

4. Click “OK” then click “Apply”. Now, only parcels that are industrial and auto-oriented uses will
be shown in the attribute table.

5. Under the XTools drop-down menu, select “Table Operations” and “Export to Excel”.

6. Select your land use parcel layer and the ID and hectares fields.

7. Click “OK”. Depending on the number of parcels you have selected, it may take some time to
export the data to Excel.

8. The new Excel file will contain the hectares of the social uses in each study site; use Excel’s
Subtotals command (under the Data drop-down menu) to summarize and group this
information.

9. Re-query the land use parcel layer to once again include all parcels (do not include areas of water
or roads). Follow steps 1-4 but modify the criteria for the parcels to be selected.

10. Return to the land use parcel attribute table.

11. Right-click on the field that contains the IDs and select Summarize.

12. Under “2. Choose one or more summary statistics...” expand the box labeled “Hectares” and
check the box marked “Sum”.

13. Select or create an output file name and hit OK.

14. The output .dbf file will contain the total hectares of the land use in each study site.

Calculate Land Use Percentages for each Site:
1. In Excel or other spreadsheet program, combine the land use hectares and your total parcel
hectares based on the site ID numbers.
2. For each land use category in each site, divide the land use hectares by total parcel hectares to
get the percentages of total parcel area in the industrial and auto-oriented uses.

5.6 Proportion of Dissimilar Land Uses Among Grid Cells by Cell, Formula
]
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1. Basic Concept

This measure, adapted from work by Cervero and Kockelman (1996, 8), places a 100100 meter
grid over the study site, assigns a major land use to each grid cell, and then calculates the
proportion of dissimilar land uses adjacent to or kitty corner to the central cell. It is a way of
standardizing mixed use calculations although initially it seems to have been used because data
were already available in the 100 meter cell format. Cervero and Kockelman go on to create an
index basically of average dissimilarity across and area such as a tract, similar to the method
described below. However, values for individual grid cells are also important.

2. Basic Formula

Proportion of Dissimilar Land Uses Among Grid Cells by Cell = Working from a grid, pick one
cell and calculate the dominant land use for that cell, calculate the dominant land uses in the
adjacent grid cells, then calculate the percentage of cells with different land uses to the central
cell.

3. Detailed Formula

Proportion of Dissimilar Land Uses Among Grid Cells by Cell = Working from a grid such as
the one in the diagram below, select one cell and calculate the dominant land use for that cell,
calculate the dominant land uses in the adjacent grid cells, then calculate the percentage of cells
with land uses different to the central cell. Land uses include the seven major land uses above as
well as water and an “other” category for land uses that are not among our seven major land
uses (e.g., agricultural, airport). Majority land uses are assigned based on the area within
parcels as well as water bodies (road rights-of-way are not included in the calculations).

4. Comments and Explanations
We found two ways to do this.

A. Using a grid to lay over the study areas, measuring land uses, and then calculating
the dissimilarity index in Excel.

B. We later found a way to automate the grid measurement process to create a dominant
land use, based on Steiner (2004). However, this just allocates a dominant land use and
Excel is still needed to perform the dissimilarity.

For both, the land use for a grid cell (see center cell A in the diagram below) is compared to the
land uses in each of its 8 neighboring cells (B, C, D, E, F, G, H, and I), scoring 0 for an identical
use and 1 for a different use. These 8 values are then averaged to generate the index for that
single cell.

Sample grid cell pattern:
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The steps for transferring the land use data for the grid cells to Excel and performing the
necessary calculations to generate the dissimilarity indices are complicated. We have attempted
to break out the steps to show both a generalization and an actual example from our data.

As part of the GIS steps used to create the grid (outlined below), each grid cell is assigned a
unique ID number. These numbers are assigned consecutively, from the bottom left hand corner
of the grid to the top right hand corner.

For example, the dissimilarity formula was, in our study, applied to a grid of 207 columns and
287 rows (enough to cover completely our largest buffered areas — see image). Using the steps
outlined below, the grid cells were numbered consecutively from bottom to top (rows 1-287)
beginning on the left and working to the right (columns 1-207). Since the steps for assigning
unique ID numbers produce a beginning number of 0, the leftmost bottom cell was number 0,
the leftmost top cell was number 286, the rightmost bottom cell was number 59122, and the
rightmost top cell was number 59408 (which is [207*287]-1).
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Study area with 100*100 meter grid overlay.

Looking more closely at a handful of grid cells from our study area, the pattern of unique ID
numbers becomes more clear (compare to the sample grid cell pattern above).

100*100 meter grid cells with land use coding and unique grid cell ID numbers.

When the data for each cell is exported to Excel (in order to carry out the dissimilarity
calculations), each grid cell also assumes an Excel cell reference number. Notice how the cell
reference numbers from the image below and the unique ID numbers from the image above are
also found in the clipped section of the Excel spreadsheet.
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100100 meter grid cells with land use coding and associated Excel cell reference numbers.
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A B C
1 Unique ID | Land Use Code | Dissimilarity Index
6946 14711 [ 0.5
6947 14712 [ 0.375
6948 14713 [ 0.5
6949 14714 R 0.875
6950 14715 WAT 0.5
7231 14996 R 0
7232 14997 R 0.125
7233 14998 R 0.25
7234 14999 R 0.375
7235 15000 R 0.375
7236 15001 PR 1
7237 15002 WAT 0.625
7238 15003 WAT 0.625
7239 15004 I 0.25
7520 15285 R 0
7521 15286 R 0
7522 15287 R 0.125
7523 15288 R 0.5
7524 15289 I 0.625

The spreadsheet that calculates the dissimilarity index for each cell in the 100100 meter grid

uses the following methodology:

1. Column A contains the unique ID number for each grid cell.

2. Column B contains the land use code associated with each grid cell (calculated to be the
majority land use in each cell).
3. Column C contains the formula to calculate the dissimilarity index for each cell, utilizing
the land use codes from the adjoining 8 grid cells. The formula does the following;:
a. Checks the unique ID number for that cell
b. Calculates the unique ID numbers for the adjoining 8 cells (since the cells are
numbered consecutively, these offsets are always the same — in our example,
based on the overall size of the grid, to calculate the number of the grid cell to the
lower left subtract 288)
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Looks up or down the unique ID column to find the matching ID numbers

In the row of each matching ID number, compares the land use code to the land

use code of the center cell

e. If the land use codes match, a value of 0 is returned; if the land use codes do not
match, a value of 1 is returned

f.  The 8 values (0s or 1s) are summed and divided by 8 to get an index number

between 0 and 1

oo

In Excel, here is the detailed formula for calculating the Cell by Cell Dissimilarity Index (with
values based on our data and being calculated for the cell with unique ID 15000):

=SUM(IF(B7235=(VLOOKUP(A7235-288,$A$2:$B$26640,2,F A1.5E)),0,1),
IF(B7235=(VLOOKUP(A7235-287,$A$2:$B$26640,2,F ALSE)),0,1),
IF(B7235=(VLOOKUP(A7235-286,$A$2:$B$26640,2,F AL.SE)),0,1),
IF(B7235=(VLOOKUP(A7235-1,$A$2:$B$26640,2,F A1.5E)),0,1),
IF(B7235=(VLOOKUP(A7235+1,$A$2:$B$26640,2,F A1.5E)),0,1),
IF(B7235=(VLOOKUP(A7235+286,$A$2:$B$26640,2,F A1.SE)),0,1),
IF(B7235=(VLOOKUP(A7235+287,$A$2:$B$26640,2,F AL.SE)),0,1),
IF(B7235=(VLOOKUP(A7235+288,$A$2:$B$26640,2,F A1.5F)),0,1))/8

So, generally, for each center cell A,

e SUM(B-I)/8 sums the values returned for B-I and divides the sum of the returned values by 8
to get the dissimilarity index for cell A

where B-I are the statements:
* IF(W=(Y),0,1) which check to see if the land use values of the 8 adjoining cells are the
same as that of cell A

where W is:
¢ the land use value of cell A

where Y is the statement:

* VLOOKUP(Z,range, ,FALSE) which looks up data in a specified cell
according to set of rules (the V in VLOOKUP indicates that Excel will be
searching vertically in the spreadsheet in contrast to an HLOOKUP which
searches horizontally)
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where 7 is the series of statements:
e V-offsetl; V-offset2; V-offset3; V-offsetd; V+offsetd; V+offset3;
V+offset2; V+offsetl

where V is:

e the unique numerical identifier of cell A, adjusted in each of the
8 entries to jump up or down the spreadsheet to access the land
use data associated with each of the 8 adjoining cells of cell A
(here, based on our grid size, the offsets are 288, 287, 286, and 1)

and range is:

e the extent of the data in the worksheet (here, from cell A2 to cell B26640
— the area that contains the data on both the unique ID numbers and the
land use codes)

and is:
e the column from which the comparison value is to be selected (here,
column 2, which contains the land use codes)

and is:
¢ the command that forces VLOOKUP to search for an exact match.

and 0,1:
e returns a value of 0 if W matches Y and returns 1 if it does not.

So from our example above we see that cell A with unique ID number 15000 has a land use code
R (for Residential). It is surrounded by cells with land uses I, I, R, R, PR, R, R, and R. The
dissimilarity formula will return values of 1, 1, 0, 0, 1, 0, 0, and 0. Summing these eight values
and dividing by eight yields a dissimilarity index for cell A of 0.375.

We did find one “glitch” in the way we used the MAJORITY function to calculate the dominant
land use in each cell. Since our land use layer was parcel based and did not include polygons
for road rights-of-way, when the MAJORITY function was used it only counted area that was
within our data layer. Therefore, a 100100 meter grid cell that was 95% road right-of-way and
5% residential land use (such as a cell located in the middle of a large highway) would be coded
as residential. The result is dissimilarity data that indicates less variety (or more similarity) of
land uses than actually exists along these wide road right-of-ways.

A fix to this problem would be to “fill” the road rights-of-way with an additional polygon layer
and take these areas into account (much like how water bodies are handled). After discussing
the issue we decided not to take this step and continue using the data as it was originally
calculated. By taking these road rights-of-way into account, we would be adding dissimilarity
into our results, but it would be based on wide road rights-of-way that are not pedestrian
friendly instead of a mix of land uses which are suggested to support pedestrian activity.
Therefore adding a road right-of-way layer would actually be working against our study goals.

Also, it should be noted that the Convert to Raster function used to change the land use parcel
layer into a 10*10 meter grid cell raster does NOT use a MAJORITY function to calculate the
underlying land use. In fact, it simply takes the land use beneath the grid cell centerpoint and
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assigns it to the grid cell. Although this step results in some cells that misrepresent the true
nature of the underlying land uses, we devised a method that broke the 100100 meter grid cells
into 1010 meter grid cells, took the land use under the center point, and then used that as the
basis for the majority land use. We estimated that this should remove most, if not all, of this
variation.

The following images demonstrate the cell by cell dissimilarity index in one study site.

The first shows the land uses as defined by the parcel boundaries (with the 100100 meter grid
cell overlay).

The next set of three images shows a close-up of the transition of land use designations from
parcels to 10*10 meter grid cells to 100*100 meter grid cells.

1w | W

The next image shows the land uses in the broader context as defined by the 100100 meter grid
cell boundaries with the dominant land uses applied.
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The last shows the cell by cell dissimilarity index. The index ranges from 0 — low dissimilarity
(the lightest shade of blue, where the dominant land use of the cell is the same as all of the
dominant land uses of the eight adjacent cells) to 1 — high dissimilarity (the darkest shade of
blue, where the dominant land use of the cell is different from any of the dominant land uses of
the eight adjacent cells).

5. GIS Approach
The basic steps to calculate the level of difference between each cell and its eight neighbors are:

1. Use FISHNET tool to create a 100*100 meter raster grid of the land use data that aligns
with the left and bottom edges of the data

2. Create a raster of the land use data in a 1010 meter grid (this should align with the
100*100 meter grid)
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3. Create unique ID numbers for the 100*100 meter grid (copy the existing the Object_ID
into a new field)

4. Use the Zonal Statistics tool to calculate the MAJORITY of land uses for each 100100
meter grid cell of the 100 1010 meter raster cells contained in each (this creates a raster)

5. Convert the raster back into polygons (don’t simplify the polygons!)

6. Create centroids for the original 100*100 meter grid

7. Assign the underlying (majority) land uses to the centroids using a spatial join

8. Assign the centroid land uses back to the 100100 meter grid

9. Export (using XTools) the unique ID numbers and the land use codes to Excel

10. Plug in the dissimilarity formula to produce the dissimilarity index for each cell

11. Save the unique ID number and the index columns in dbf format

12. Join the newly indexed dbf file to the 100*100 meter grid cell file

13. Create a new field for the dissimilarity numbers and copy the indexed column before
removing the join

14. Join this data to the participant point file (using a spatial join) to be able to produce
dissimilarity indices for each of the participants (there may be some index numbers that
will be repeated since some 100100 meter grid cells may contain more than one
participant)

6. GIS Steps

The following procedures were completed using ArcMap (ArcInfo) 9.0.

To complete this protocol you will need:

1.

SN OIRH=EORD

Land use parcel layer (polygon)

Water layer (polygon) if water not included in land use parcel layer
Participant layer (point)

Create Fishnet tool (available from ESRI’s ArcScripts website)

XTools extension (available from the Downloads section of the ESRI website)
Excel

The basic steps are:

Create Grids

Create Unique ID Numbers for Grid Cells

Calculate Majority Land Use for each Grid Cell
Calculate Dissimilarity Indices in Excel

Join Dissimilarity Data to Cells of Interest (Participants)

Create Grids

11.

12.

13.

14.

15.
16.
17.
18.
19.
20.

Ensure that the data view is using the desired units for measurement by checking the lower right
corner of the status bar at the bottom of ArcMap.

Move the mouse to the left-most extent of the area for which grid cells will be created. Zoom in
and note the X coordinate.

Move the mouse to the bottom-most extent of the area for which grid cells will be created. Zoom
in and note the Y coordinate.

Measure the approximate horizontal and vertical distances that need to be covered by the grid
and divide each distance by the intended size of each grid cell. This will yield the number of rows
and columns needed in the grid.

Click the Create Fishnet button that was added to the toolbar during the installation of the tool.
Enter the X-Y coordinates recorded above (this will identify the lower left corner of the area).
Enter the number of rows and columns estimated above.

Enter the height and width of each grid cell (100*100 meters for our purposes).

Choose a location and name for the output shapefile

Click the Edit button to select the coordinate system of the output shapefile.
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21.

Make sure it is set to product Polygons and click OK.

Create Unique ID Numbers for Grid Cells

1.

N Pl 22 [

Open the attribute table for the 100*100 meter grid cells.

Click on ‘Options’ and then ‘Add Field...".

Name the field and click on ‘OK’.

Right click on the field name and select ‘Calculate values...".

In the formula box, set the new field to be equal to the FID.

Click ‘OK’. Each cell will now have a unique ID, numbered consecutively from bottom to top
beginning with the left-most column.

Calculate Majority Land Use for each Grid Cell

1. Open the ArcToolbox.

2. Click on Conversion Tools, To Raster, Feature to Raster.

3. For ‘Input features’ select your land use layer.

4. For ‘Field’ select the field containing your land use codes.

5. Name your output file.

6. For ‘Output cell size’ enter 10 (meters).

7. Click on ‘OK’. A raster with 1010 meter grid cells containing land use data will have been
created (the first cell will be located in the lower left corner of the data layer’s extent).

8. In the ArcToolbox, click on Spatial Analyst Tools, Zonal, Zonal Statistics.

9. For ‘Input raster or feature zone data’ select your 100*100 meter grid cell file.

10. For ‘Zone field” select your unique ID field.

11. For ‘Input value raster” select your 1010 meter land use raster file.

12. Name your output file.

13. Under ‘Statistics type’ select 'MAJORITY".

14. Check the ‘Ignore NoData’ option.

15. Click on “OK’. The majority land use in each 100*100 meter grid cell (calculated based on the 100
10*10 meter grid cells contained within) will be assigned in the new 100100 meter grid cell layer
(raster).

16. In the ArcToolbox, click on Conversion Tools, From Raster, Raster to Polygon.

17. For ‘Input raster’ select your 100100 meter grid cell raster (just created).

18. For ‘Field’ select the field containing the land use codes.

19. Name your output file.

20. Deselect the ‘Simplify polygons’ option

21. Click ‘OK’. The raster file will have been converted to a polygon file (although not yet divided
back into 100*100 meter grid cells.

22. Using XTools, click on Feature Conversions, Shapes to Centroids.

23. For ‘Input feature layer” select your ORIGINAL 100*100 meter grid cell layer.

24. Name your output file.

25. For ‘Centroid location’ select ‘Center point’.

26. Click “OK’. Your 100100 meter grid cells will now have centroids.

27. Right click on your new centroid layer and select Joins and Relates, Join.

28. For “What do you want to join to this layer?” select ‘Join data from another layer based on spatial
location’.

29. For #1, select your new 100100 meter grid cell layer (now with land uses).

30. For #2, select the first option “Each point will be given all the attributes of the polygon that . . . it
falls inside.”

31. For #3, name your output file.

32. Click ‘OK’. The centroids of the 100100 meter grid cells will now contain the land use data.

33. Right click on your ORIGINAL 100100 meter grid cell layer and select Joins and Relates, Join.

34. For “What do you want to join to this layer?” select ‘Join data from another layer based on spatial
location’.

35. For #1, select your centroid layer (now with land uses).

36. For #2, select the second option “Each polygon will be given all of the attributes of the point that
is closets to its boundary . . .”
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37. For #3, name your output file.
38. Click ‘OK’. You now have a 100*100 meter grid cell layer that contains data on the dominant
underlying land use.

Calculate Dissimilarity Indices in Excel
1. Using XTools, click on Table Operations, Export Data to MS Excel.
For ‘Feature layer’ select your new 100100 meter grid cell layer with land uses.
For “Select fields to export’ select the Unique ID number and the land use code.
Click ‘OK".
In Excel, create a new column to contain the dissimilarity indices.
For each cell (Unique ID number), build a formula that calculates the dissimilarity index for that
cell (see Comments and Explanations above for a detailed description of our Excel formula).
For cells that contain no data (especially along the edges of irregular study areas), you may wish
to assign an easily identifiable code in the dissimilarity index column (we used 999). This will
make it easy to later identify and remove (or not display) these cells.
8. When finished, save the worksheet in DBF 4 (dBase IV) format.

©N Q1 (= G2 )
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Join Dissimilarity Data to Cells of Interest (Participants)

Right click on your new 100100 meter grid cell layer and select Joins and Relates, Join.

For “What do you want to join to this layer?” select ‘Join attributes from a table’.

For #1, select your Unique ID number field.

For #2, select your dbf file that contains the dissimilarity numbers.

For #3, select your Unique ID number field.

Click “OK’. The dissimilarity number will now be joined to your 100100 meter grid cell layer.

Right click on your grid cell layer and select Open Attribute Table.

Under ‘Options’, select Add Field...

Name your field. Under ‘Type’ select Double. For Precision and Scale use numbers that fit your

data (we used 8 for Precision and 3 for Scale).

10. Click ‘OK".

11. Right click on the name of your new field and select ‘Calculate Values...’

12. Set your new field equal to the dissimilarity index field and click on “OK’".

13. Right click on your new 100*100 meter grid cell layer and select Joins and Relates, Remove
Join(s), Remove All Joins.

14. Your 100*100 meter grid cell layer will now contain dissimilarity data for each grid cell. If
desired, you can pull out the data for specific cells of interest (such as those that contain the
location of individual study participants) by performing a ‘Join’ of the grid cell data to the
participant points file (note that some grid cells may be repeated since there may be more than
one participant in a given grid cell).

5ol (2ol NN O = (CSH S

5.7 Proportion of Dissimilar Land Uses Among Grid Cells in an Area,
Formula 1

1. Basic Concept

The basic idea here is to use the dissimilarity calculation in the previous protocol to come up
with an average dissimilarity over a larger area. Cervero and Kockleman (1996) examined a
census tract scale but a number of different geographies could be used including ones of more
uniform size than tracts. For example the index could be calculated for whole neighborhoods or
for cells inside or intersecting with a small buffer distance around an individual.

2. Basic Formula
Following Cervero and Kockelman (1996, 8)the formula is: Proportion of Dissimilar Land Uses

Among Grid Cells in an Area ={Z}* 2,* (X/8)]/K}, where K is the number of developed grid cells
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in the tract and “X; =1 if land use category of neighboring .... Hectare grid-cell differs from
hectare grid cell j (0 otherwise).”

3. Detailed Formula

Following Cervero and Kockelman (1996, 8)the formula is: Proportion of Dissimilar Land Uses
Among Grid Cells in an Area ={Z}* 2,* (X/8)]/K}, where K is the number of developed grid cells
in the study geography such as a buffer, and “X; = 1 if land use category of neighboring ....
Hectare grid-cell differs from hectare grid cell j (0 otherwise).”

4. Comments and Explanations

We considered changing the formula to a median dissimilarity, but decided to use the average
of grid cell indices instead of the median because the spread is low and we are trying to pick up
differences (median will hide differences).

In order to be consistent with other measures in this manual, we decided to use only the grid
cells that had their centroids within each buffer. This required an intermediate step in our
process that selects only those cells whose original (not intersected) centroid falls within the
buffer boundary.

Very large layers of grid cells intersected with buffers may have to be split into smaller pieces
before they can be dissolved (then merged back together). The intersection of grid cells with our
largest buffer (1600m) resulted in 4.1 million records!

5. GIS Approach
The basic steps to calculate the average dissimilarity index across an area are:

1. Begin by creating cell by cell dissimilarity as outlined above.

2. Intersect the grid cells with buffers.

3. Dissolve the layer based on buffer ID and unique grid cell ID.

4. Select only the cells that contain centroids from the original grid cells. Export as a new
data layer.

5.Join to original grid cell layer (via unique ID) and copy over the dissimilarity indices.
6. Use the Summarize function to average the indices for each buffer.

6. GIS Steps
The following procedures were completed using ArcMap (ArcInfo) 9.0.

To complete this protocol you will need:
1. Cell by cell dissimilarity layer (polygon)
2. Grid cell centroid layer (point)
3. Buffer layer (polygon)

The basic steps are:
o  Generate Cell by Cell Dissimilarity Indices
e  Roll Up Grid Cell into Areas
o Assign Dissimilarity Indices
e Calculate Average Dissimilarity Indices

Generate Cell by Cell Dissimilarity Indices
1. Follow steps outlined above in Protocol 5.6

Roll Up Grid Cells into Areas
1. From ArcToolbox, select Analysis Tools, Overlay, Intersect
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For ‘Input Layers’ select your grid cell layer and your buffer layer

Name your output layer

Click “OK’

Once your intersected layer has been completed, from ArcToolbox select Data Management
Tools, Generalization, Dissolve

For ‘Input Layer’ select your intersected layer (grid cells and buffer)

Name your output layer

For ‘Dissolve Fields’ select your buffer ID and the unique ID of the grid cells

Click “OK’

O = @) )

59 @91 N1 o

Assign Dissimilarity Indices
1. Under ‘Selection’ choose ‘Select by Location’
a. For ‘I want to:” choose ‘select features from’
b. For ‘the following layer(s):” choose your newly dissolved layer
c. For ‘that” choose “contain’
d. For ‘the features in this layer:” choose your grid cell centroid layer
e. Click‘Apply’
2. When this is complete, right click on the dissolved layer and select Data, Export Data
3. Choose “Export: Selected features” and check ‘Use the same Coordinate System as this layer’s
source data’
Name your output layer and click ‘OK’
Right click on your new layer and select Joins and Relates, Join
Select ‘Join attributes from a table’
a. For ‘Choose the field in this layer that the join will be base on:” choose your unique ID
b. For ‘Choose the table to join to this layer:” choose your original grid cell layer
c. For ‘Choose the field in the table to base the join on:” choose your unique ID
d. Click ‘OK’
7. Once the join is complete, right click on your layer and select Open Attribute Table
8. Under ‘Options’, select Add Field...
9. Name your field. Under ‘Type’ select Double. For Precision and Scale use numbers that fit your
data (we used 8 for Precision and 3 for Scale)
10. Click ‘OK”
11. Right click on the name of your new field and select ‘Calculate Values...’
12. Set your new field equal to the dissimilarity index field and click on ‘OK’
13. Once the values have been copied over, right click on your layer and select Joins and Relates,
Joins, Remove all Joins
14. The layer will now contain the dissimilarity indices for all selected grid cells

SNOIE

Calculate Average Dissimilarity Indices

Right click on your layer and select Open Attribute Table

Right click on the dissimilarity index field and select ‘Summarize’

Expand the options for your dissimilarity index field and check ‘Average’

Click ‘OK’

A new dbf file will be created that, for each buffer ID, contains the average of the dissimilarity
indices of all the associated grid cells

o e 29 [ 1=

5.8 Dissimilarity Index, Formula 2 (new in Version 2.1)

1. Basic Concept

This is a measurement based on work by Daniel Rodriguez and colleagues at the University of
North Carolina (Song and Rodriguez 2005a). Please contact us before using this measure as we
are still checking it and making sure that we are using similar scales and other characteristics
to the UNC team. This second version of a Dissimilarity Index is familiar to those working in
the area of racial segregation. As they outline:
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Definition: The degree to which different land uses exist within the smaller unit of
analysis (e.g., grids or neighbourhood) and this distribution pattern is typical
throughout the larger unit of analysis (e.g., neighbourhood or the city). The value of the
index ranges between 0 and 1. A value of 0 means perfect similarity; a value of 1 means
perfect dissimilarity. This measure is borrowed from Duncan and Duncan (1955) who
employed it to reflect the level of residential segregation and has received strong
endorsement from recent findings that it is effective to capture the evenness dimension
of residential segregation (Massey and Denton, 1988). The measure is implemented in
the Appendix for two land uses (e.g., residential and non-residential land uses) and for
various land use types simultaneously.

Unit of analysis: Different levels of neighbourhoods (e.g., grids, census boundaries, or
metropolitan areas). (Song and Rodriguez 2005a, 9)

The UNC team’s web site is
http:/ /planningandactivity.unc.edu / Activities%20and %20News.htm

2. Basic Formula
The UNC team chose to use a formula focused on two basic land use types, residential and non-
residential. As they explain:

“Measurement 1: The following formula can be used to measure the evenness between
residential use and non-residential land uses.

D:0.5i|xi -Y|
i=1

The first implementation of the index, D, is to examine if the distribution of land uses at sub-

neighbourhood level (i.e., a grid cell) is similar to the distribution pattern at the neighbourhood
level. We denote n as the number of grids in the neighbourhood, X; as the ratio of the
residential area in grid i to the residential area in the neighbourhood, and Y; as the ratio of the
non-residential area in grid i to the non-residential area in the neighbourhood” (Song and
Rodriguez 2005a, appendix 4).

In their format the index is measured for grid cells (we chose 100m) and then compared with
the larger study geography. In their case this is a neighbourhood. We are still determining
what geography we will use for comparison.

“Then the comparison of the distribution of land uses within each of the grids to the
neighbourhood as a whole can be made. The index of dissimilarity equals to 0 if distribution of
land uses within each grid is similar to the distribution at the neighbourhood level, i.e., the
proportions of the residential and non-residential land uses within each of the grids are
identical to the proportions at the neighbourhood level respectively. The index equals to 1 if
there are either only residential land uses, or there are only non-residential land uses within
each of the grids” (Song and Rodriguez 2005a, appendix 4-5).

2. Basic Formula

n
D=05>|X; Y|
i=1
ENVIRONMENT AND PHYSICAL ACTIVITY: GIS PROTOCOLS VERSION 2.3, August 2005, WORK IN PROGRESS 110

University of Minnesota, Twin Cities Walking Study, Metropolitan Design Center



In other words, Dissimilarity =

the ratio of the residential area in grid cell number 1 to the ratio in the larger comparison
measurement geography (the “neighbourhood”) minus the ratio of the non-residential area in
grid cell number 1 to the non-residential area in the neighbourhood

+ the same calculation for grid cells 2, 3, 4 etc,, all divided by 2.

3. Detailed Formula
This formula uses the simplified land uses from earlier protocols.

4. Comments and Explanations
We are still coordinating the exact operation of this measurement with the University of North
Carolina team. The key issue is defining the “neighborhood” or higher level measurement

geography.

5. GIS Approach

This is taken directly from draft work by Song and Rodriguez and should be cited as being by
them. The citation is Song, Yan and Daniel A. Rodriguez. 2005b. Steps for Computing the
Dissimilarity, Entropy, Herfindahl-Hirschman and Accessibility (Gravity with Competition)
Indices. Draft Manuscript. Please, however, check their web site for updated versions of these
steps: http:/ / planningandactivity.unc.edu / Activities%20and %20News.htm

1. “Decide to which neighbourhood each taxlot belongs:
a. Convert the taxlot polygons into centroids by using XTool;
b. Spatial join the neighbourhood polygons and the taxlot centroids so that each
taxlot would be assigned with a neighbourhood ID and all taxlot centroids that
are inside a neighbourhood will have the same neighbourhood ID;
2. Construct grids which would intersect with the study area:
a. create grids with user-defined size by using “Coordinate Grid Maker 2.290”
ArcView script which can be downloaded from ESRI’s website;
3. Assign each taxlot by grid:
a. Spatial join the grid (polygon) shape file and the taxlot centroids (point) shape
file so that all taxlot centroids that are inside a grid cell will have the same grid
cell ID;
4. Calculate total area of residential uses for each grid cell by summarizing the table of
taxlot centroids shape file based on the grid cell ID. You would obtain a table with the
grid cell ID as the key. Each grid cell also has a neighbourhood ID indicating the
neighbourhood to which the grid cell belongs.
5. Calculate total area of non-residential uses for each grid cell by summarizing the table of
taxlot centroids shape file based on the grid cell ID. You would obtain a table with the
grid cell ID as the key. Each grid cell also has a neighbourhood ID indicating the
neighbourhood to which the grid cell belongs.
6. Based on the common grid cell ID, combine the table created from step 4 and the table
created from step 5 into a single table. The resulted new table includes the following
fields: grid cell ID (key), residential area by each grid cell, non-residential area by each
grid cell, and neighbourhood ID.
7. Using the attribute table of taxlot centroids, calculate total residential area by each
neighbourhood by summarizing residential area based on neighbourhood ID. This
would result a table with neighbourhood ID as the key.
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8. Using the attribute table of taxlot centroids, calculate total non-residential area by each
neighbourhood by summarizing non-residential area based on neighbourhood ID. This
would result a table with neighbourhood ID as the key.

9. Based on the common grid cell ID, combine the table created from step 7 and the table
created from step 8 into a single table. The resulted new table contains the following
fields: neighbourhood ID (key), residential area by each neighbourhood, and non-
residential area by each neighbourhood.

10. Based on the common neighbourhood ID, join the table created from step 9 to the table
created from step 6. In addition to the existing fields in the table created from step 6, the
new table will also have information on total area of neighbourhood residential and
non-residential uses by each grid cell.

11. In the table created from step 10, divide total residential area in grid cell by total
residential area in neighbourhood. A new field containing the information on the ratio
is added to the table.

12. In the table created from step 11, divide total non-residential area in grid cell by total
non-residential area in neighbourhood. A new field containing the information on the
ratio is added to the table.

13. Calculate the difference between the two ratios obtained from step 11 and 12 and add
the new field - ratio difference - to the table.

14. Calculate Dissimilarity Index:

a. Use the table created from step 13 to summarize the grid cell ratio differences by
neighbourhood ID;

b. Divide the summarized total differences by 2 for each neighbourhood. This is
the value of dissimilarity index for each neighbourhood.”(Song and Rodriguez
2005b)

6. GIS Steps
[To add]

5.9 Entropy Index (new in Version 2.1)

1. Basic Concept

This is a measurement based on work by Daniel Rodriguez and colleagues at the University of
North Carolina (Song and Rodriguez 2005). Please contact us before using this measure as we are still
checking it and making sure that we are using similar scales and other characteristics to the UNC team.
As they outline:

Definition: The entropy index is a measure of variation, dispersion or diversity (Turner
et al., 2001). It measures the degree to which land uses are heterogeneously distributed
within a neighbourhood. A value of 0 indicates homogeneity, wherein all land uses are
of one single type; a value of 1 means heterogeneity, wherein area is evenly distributed
among all land use categories.

Unit of analysis: Neighbourhoods. (Song and Rodriguez 2005a, 10).

As they explain:

“The entropy index (Shannon Index) is commonly calculated through the following formula:
Entropy :{—z L(p)(n p)1}/(Ink) ” (Song and Rodriguez 2005a, appendix 6)
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There are several ways to operationalize this and the UNC team has chosen the following:

Measurement: To examine the distribution Battern of different land uses within a
neighbourhood, the index spells out that "' =proportions of each of the six land use
types such as single family residential, multi-family residential, commercial, industrial,
public institutional and park uses, and k=the number of land uses. In this case, k=6
(Song and Knaap, 2004) (Song and Rodriguez 2005b).

The UNC team’s web site is
http:/ /planningandactivity.unc.edu / Activities%20and %20News.htm

2. Basic Formula

Entropy = negative of proportion of land use (p) of type 1 times the log of that proportion, plus
proportion of land use (p) of type 2 times the log of that proportion, and so on for each of “k”
land use categories all divided by the log of “k.”

3. Detailed Formula

If the proportion of a land use type in a given neighborhood is 0, taking the log of that land use
would result in an undefined term, preventing the completing of the calculation. To work
around this problem, Rodriguez suggests the following fix:

For each land use i, the term is P_i*In(P_i). To calculate, we take the following shortcut:
If P_i is zero, then the whole term would be zero, even if In(P_i) is undefined (in other
words, that land use does not contribute to the entropy -- the key is to view entropy as
the sum of proportions of each land use, weighed by the natural log of those
proportions) (from personal e-mail correspondence, Rodriguez 2005).

4. Comments and Explanations

The University of North Carolina team defined “neighborhoods” as buffers of %, %, and % mile
around an invidual’s home. To be consistent with our other measures, we used similarly-sized
buffers of 200m, 400m, and 800m (both straight-line and network).

Some of our 200m network buffers had no land use area associated with them (see explanation
in Section 2.6). For these buffers, we recorded “No Data”, rather than using values of 0, to
distinguish them from buffers with calculated indices of 0 (which indicate perfect
homogeneity).

5. GIS Approach

This is taken directly from draft work by Song and Rodriguez and should be cited as being by
them. The citation is Song, Yan and Daniel A. Rodriguez. 2005b. Steps for Computing the
Dissimilarity, Entropy, Herfindahl-Hirschman and Accessibility (Gravity with Competition)
Indices. Draft Manuscript. Please, however, check their web site for updated versions of these
steps: http:/ / planningandactivity.unc.edu / Activities%20and %20News.htm

1. “Decide to which neighbourhood each taxlot belongs:
a. Convert the taxlot polygons into centroids by using XTool;
b. Spatial join the neighbourhood polygons and the taxlot centroids so that each
taxlot would be assigned with a neighbourhood ID and all taxlot centroids that
are inside a neighbourhood will have the same neighbourhood ID;
2. Calculate the total area of each of the six land use types in each neighbourhood:
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a. Using the taxlot centroids attribute table, summarize the area of taxlots by each
land use type and by neighbourhood ID. The resulted table includes the
following fields: neighbourhood ID, land use type, and the total area by land use

e.

3. Calcula?eqzotal area of all land uses in each neighbourhood:

a. Using the taxlot centroids attribute table, summarize the area of taxlot by
neighbourhood ID.

4. Based on the common neighbourhood ID, join the table created from step 3 to the table
created from step 2. The new table includes the following fields: Neighbourhood ID,
land use type, area by land use type, and total neighbourhood area.

5. Using the table created from step 4, divide the area of each single lancbuse type by total
neighbourhood area. New fields — proportions of each land use type (') — are added to
the table.

6. Calculate (p,)(In p;) and create the new fields with the values.

7. Calculate{) ,[(p;)(In p,)]}: Summarize the field (p;)(In p;) for all 6 land use types by
neighbourhood ID and create new fields.

8. Finally calculate entropy index for each neighbourhood wusing the formula:

Entropy ={- z [(p;)(In p;)1}/(Ink).” (Song and Rodriguex 2005b)

6. GIS Steps
No additional GIS Steps were taken for this measurement. All calculations were done in Excel based on
previous GIS work for Percentage of Total Land Area in Major Uses (Section 5.1).

5.10 Herfindahl-Hirschman Index, HHI (new in Version 2.1)

1. Basic Concept

This is a measurement based on work by Daniel Rodriguez and colleagues at the University of
North Carolina (Song and Rodriguez 2005). Please contact us before using this measure as we are still
checking it and making sure that we are using similar scales and other characteristics to the UNC team.

As they outline:

“Definition: The Herfindahl-Hirschman Index (HHI index), a commonly accepted
measure of market concentration used to detect market monopoly, can be used to assess
the level of land use mixture. The HHI index is the sum of squares of the percentages of
each type of land uses in the user-defined neighbourhoods. If there is only one land use
type in the neighbourhood, HHI index will equal 10,000. The higher the value of HHI
Index, the lower the level of land use mixture.

Unit of analysis: Neighbourhoods. (Song and Rodriguez 2005, 9)”

As Song and Rodriguez (2005b) elaborate: “Following the same notation as the entropy index,
the formula of calculating HHI among k uses of land is:

HHI (k) —ZK:(Pi *100)?

where P is the percentage of each type of land use in the neighbourhood, and K is the number
of land use types.”

The UNC team’s web site is
http:/ / planningandactivity.unc.edu / Activities%20and %20News.htm
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2. Basic Formula

The Herfindahl-Hirschman Index = the percentage of land use type 1 times 100 and then
squared, plus the percentage of land use type 2 times 100 and then squared (and so on for the
seven major types (residential, commercial, office, industrial, institutional, park and recreation,
vacant).

3. Detailed Formula
As above.

4. Comments and Explanations
Similar to the calculations of the Entropy Index, we used buffers (neighborhoods) of 200m,
400m, and 800m around each individual.

In addition, we based our area calculations on the range of seven major land uses defined in
section 5.1.

5. GIS Approach

This is taken directly from draft work by Song and Rodriguez and should be cited as being by
them. The citation is Song, Yan and Daniel A. Rodriguez. 2005b. Steps for Computing the
Dissimilarity, Entropy, Herfindahl-Hirschman and Accessibility (Gravity with Competition)
Indices. Draft Manuscript. Please, however, check their web site for updated versions of these
steps: http:/ / planningandactivity.unc.edu / Activities%20and %20News.htm

1. “Using the table created from step 4 in the entropy index, divide the area of each single
land upe type by total neighbourhood area. New fields — proportions of each land use
type (') — are added to the table.

2. For each newly created field in step 1, calculate (p; -100)° and create i new fields with
these new values.

3. Calculate g: (P, *100)? : Summarize the field created in step 2, (p, *100)*, for all k land
use types by neighbourhood ID and create new fields” (Song and Rodriguez 2005b).

6. GIS Steps
No additional GIS Steps were taken for this measurement. All calculations were done in Excel based on
previous GIS work for Percentage of Total Land Area in Major Uses (Section 5.1).

Employment Per Unit Land Area (see 3.6 in density section)

5.11 Retail Employment per Unit Area

1. Basic Concept
Retail uses are thought to promote walking.

2. Basic Formula
Retail Employment per Unit Area = Total retail employees per unit land area (excluding water).

3. Detailed Formula
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Retail Employment per Unit Area = Total retail (SIC codes 5200-5999) employees per unit land
area (excluding water).

4. Comments and Explanations
We used SIC codes to correspond with earlier research. In later versions of these protocols we
will provide the NAICS equivalent.

Retail data came from Dun and Bradstreet but were checked against other employment data.

In an earlier version of the protocols we proposed that the measure be made in increments of
100*100 meter grid cells. However, we gained access to point data and could then use standard
buffers.

5. GIS Approach

Divide the retail employment in each grid cell by that cell’s area (excluding water). To
determine retail employment density for an entire focus or context area, summarize the
attributes of the grid cells by focus or context area ID and include the sum of the total
employment field and the sum of the grid cell hectares field.

The process is similar for other geographies such as buffers, though a decision needs to be made
whether grid cells that are cut by a measurement geography have their value included,
excluded, or apportioned.

6. GIS Steps
The following procedures were completed using ArcMap (ArcInfo) 8.3.

To follow this protocol you will need:

Study site layer (polygon) with unique ID field

Participant locations layer (point)

Employment data (point)

Water features layer (polygon)

XTools extension (available from the Downloads section of the ESRI website)

QIR CORIOR

Create participant buffers:
Add the participant locations layer to your Map Document

2. Under the Tools dropdown menu, select “Buffer wizard”

3. In the Buffer Wizard window, under “The features of a layer” select your participant locations
layer and click on Next
Click “At a specified distance” and enter XX (your desired distance)
After “Distance units are:” select meters
Click Next
After “Dissolve barriers between” select No
Give the layer a name and save as a new layer
Click Finish

SCRCRR SOOI

Query the employment data to show only retail businesses:

1. Add the employment layer to your Map Document.

2. Right click on the employment layer in the Table of Contents and choose Properties

3. Click the Definition Query tab

4. Click on the Query Builder button

5. Construct a query that will identify all retail employment businesses (in our case, “SIC_RET” = 1)

6. Click OK to close the Query Builder and OK again

7. The employment layer should be updated to show only retail businesses in the data view
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Perform a spatial join between the participant buffers and employment layer

1. Right click the buffer layer and choose Joins and Relates>Join

2. In the top drop down box, make sure it is set to Join data from another layer based on spatial
location

3. In the next item down, select the employment layer to be the layer to join to the buffers

4. Click to button to select Each polygon will be given a summary of the numeric attributes... and
check the box below next to Sum

5. At the bottom, choose a name and location for the output file

6. Click on OK

The resulting file will have a field in its Attribute Table called Sum_EMPL or similar (depending on the
name of the field containing the number of employees in the original employment layer). The new layer
should have the same number of features as the buffer layer.

Refer to the protocol 2.1 for calculating Net Land Area (excluding water). Create a study site polygon
layer that has had water features erased from it and area data updated. Join the attribute table of the layer
created in the spatial join above to the Attribute Table of the study site layer with water removed based
on the ID field.

1. Add anew field to the Attribute Table of type double called RetPerHect or similar.

2. Right click on this field and choose Calculate Values

3. In the Field Calculator, double click the field containing the sum of retail employees, click the /
button, and then double click the Hectares field from the study site table

4. HitOK

The RetPerHect field now contains the number of employees per hectare (excluding the area of water
features).

5.12 Density of Employees in Major Retail Subcategories (Separate
Measures): General Merchandise (old SIC 53xx); Food Stores (54xx);
Eating and Drinking Places (58xx); Miscellaneous Retail (59xx).

1. Basic Concept

While retail in general is thought to be an important predictor of walking, there is considerable
interest as to whether a smaller subset of retail is the most important (Krizek 2003a, 2003b). This
protocol enables these retail subcategories to be measured individually and as a combination,
rather as the major land uses protocol above did.

2. Basic Formula
Density of Employees in Major Retail Subcategories = Total retail employees in each of the four
categories above (or all four together) per unit land area (excluding water).

3. Detailed Formula
Density of Employees in Major Retail Subcategories = Total retail employees in each of the four
categories above (or all four together) per unit land area (excluding water).

4. Comments and Explanations
We used SIC codes to correspond with earlier research. In later versions of these protocols we
will provide the NAICS equivalent.
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These data will come from both state employment figures and Dunn and Bradstreet—however,
so far we have only received the Dunn and Bradstreet data. Data are for businesses in that SIC
code with fewer than 200 employees (following Krizek 2003a, 2003b).

In an earlier version of the protocols we proposed that the measure be made in increments of
100*100 meter grid cells. However, we gained access to point data and could then use standard
buffers.

5. GIS Approach

Divide the general merchandise employment in each grid cell by that cell’s area (excluding
water). To determine general merchandise employment density for an entire focus or context
area, summarize the attributes of the grid cells by focus or context area ID and include the sum
of the general merchandise employment field and the sum of the grid cell hectares field.

The process is similar for other geographies such as buffers, though a decision needs to be made
whether grid cells that are cut by a measurement geography have their value included,
excluded, or apportioned.

Repeat for food stores, eating and drinking places, and miscellaneous retail.

6. GIS Steps
The following procedures were completed using ArcMap (ArcInfo) 9.0.

To complete this protocol you will need:

Participant buffer layer (polygon)

Employment data (point)

Water features layer (polygon)

XTools extension (available from the Downloads section of the ESRI website)

Start a new ArcMap document and add the employment layer and buffer layer to the view (see Protocols
2.5 or 2.6 for steps to create buffers)

Query the employment data to show only general merchandise businesses:

Add the employment layer to your Map Document.

Right click on the employment layer in the Table of Contents and choose Properties

Click the Definition Query tab

Click on the Query Builder button

Build a query that will identify all general merchandise businesses (in our case, “SIC_GM” = 1)
Click OK to close the Query Builder and OK again

The employment layer should be updated to show only general merchandise businesses in the
data view

N O W e

Perform a spatial join between the participant buffers and employment layer

1. Right click the buffer layer and choose Joins and Relates>Join

2. In the top drop down box, make sure it is set to Join data from another layer based on spatial
location

3. In the next item down, select the employment layer to be the layer to join to the buffers

4. Click to button to select Each polygon will be given a summary of the numeric attributes... and
check the box below next to Sum

5. At the bottom, choose a name and location for the output file

6. Click on OK
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The resulting file will have a field in its Attribute Table called Sum_Empl or similar (depending on the
name of the field containing the number of general merchandise employees in the original employment
layer). The new layer should have the same number of features as the buffer layer.

Refer to the protocol 2.1 for calculating Net Land Area (excluding water). Create a study site polygon
layer that has had water features erased from it and area data updated. Join the attribute table of the layer
created in the spatial join above to the Attribute Table of the study site layer with water removed based
on the ID field.

1. Add anew field to the Attribute Table of type double called GMPerHect or similar.

2. Right click on this field and choose Calculate Values

3. In the Field Calculator, double click the field containing the sum of general merchandise
employees, click the / button, and then double click the Hectares field from the study site table

4. HitOK

The GMPerHect field now contains the number of general merchandise employees per hectare (excluding
the area of water features).

5.13 Distance to Nearest Facility with Employees in Major Retail
Subcategories (Separate Measures): General Merchandise (old SIC 53xx);
Food Stores (54xx); Eating and Drinking Places (58xx); Miscellaneous
Retail (59xx).

1. Basic Concept
More important than the density of retail may be the distance to the nearest retail establishment.

2. Basic Formula
Distance to Nearest Facility = Straight line or network distance to the centroid of the nearest
facility of a certain type.

3. Detailed Formula
Same as above.

4. Comments and Explanations

The straight line distance part of this measurement uses an ArcView extension called Nearest
Features. It can be downloaded here:

http:/ /www.jennessent.com/arcview /nearest features.htm

The network distance to nearest part of this measurement uses an ArcView extension called
Multiple Closest Facilities. It can be downloaded from the ESRI website at
http:/ /arcscripts.esri.com / details.asp?dbid=13125

5. GIS Approach

The GIS approach involves determining the straight line and network distance between an
origin (in this case participant locations) and the closest of the possible destinations (in this case,
locations of various subcategories of retail.

6. GIS Steps

I. Straight line distance to nearest facility
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The following procedures were completed using ArcView 3.3.

To complete this protocol you will need:
5. Roads layer (polyline)
6. A set of origin features—in this example, participant locations (point)
7. A set of retail subcategory locations (point)
8. The Nearest Features extension for ArcView

Prepare the view and data:
7. Add the roads theme and the participant locations/ retail location themes to a new view
8. Go to the View menu and choose Properties
9. Set the map units and distance units appropriate for the coordinate system of the layers
10. Go to the File menu and choose Extensions
11. Find the Nearest Features extension and check the box to turn it on
12. Click OK

Calculate distance to nearest feature

11. Click on the Nearest Features button in the toolbar

12. In the first dialog box, select the theme of participant locations and the field in its table that
contains a unique ID

13. Click OK

14. In the next dialog box, select one or more destination themes (if you want to calculate the
distance to nearest feature for more than one kind of feature at a time), and for each theme choose
a field containing a unique ID

15. Click Add for each combination of feature and unique ID

16. Click OK when finished

17. In the next dialog box, enter the number of nearest features you want to find (1 = nearest feature,
2 = nearest and second-nearest features, etc) and check the boxes for Comparison Feature ID and
Distance to Centroid

18. Click OK

19. In the final dialog box, you may choose to draw lines connecting each participant location and its
nearest retail location (this will increase processing time)

20. Click OK to begin the processing

The output will be a table containing the unique ID of each participant location, the unique ID of the
nearest retail location, and the distance between them in the chosen units of the view.

II. Network distance to nearest facility
The following procedures were completed using ArcView 3.3.

To complete this protocol you will need:
11. Roads layer (polyline)
12. A set of origin features—in this example, participant locations (point)
13. A set of destination features—in this example, retail subcategory employment locations (point)
14. The Network Analyst extension for ArcView
15. The Multiple Closest Facilities extension for ArcView

Calculate network distance to nearest facility
27. Start a new ArcView project and create a blank View
a. Open the View menu and choose Add Theme
b. Add the roads, origins, and destinations layers to the View
c.  Open the View menu and choose Properties
d. Make sure the map units (meters, feet, etc.) match the units of the data layers
e. Open the File menu and choose Extensions
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f. Check the box next to the Multiple Closest Facilities extension and click OK

28. Open the Network Tools menu that has been added and choose Multiple closest facilities

29. In the dialog box that appears, select the participant locations layer in the From dropdown box

30. Select the unique ID of the participant locations layer in the From ID field dropdown box

31. In the To dropdown box, select the retail locations layer

32. Choose the unique ID of the retail locations layer in the To ID field dropdown box

33. In the Network dropdown box, select the roads layer

34. For Facilities to find, enter 1

35. Set the Cutoff Distance to 0

36. The Search Tolerance is a distance in the current map units that Network Analyst will search away
from the road features to find points. Make this number large enough so the process will not miss
any of the participant locations

37. Click Travel to facility

38. Check the box for Create Join Table

39. Hit Process

When the process ends, the extension will add a new polyline feature to the View consisting of the
network segments that trace the shortest path from each participant location to its nearest retail location.
The table of the new layer contains an Origin field with the unique ID of the participant location layer, a
Destin field with the unique ID of the closest retail location, and a Length field with the distance in the
current map units between the participant location and the closest retail location.

5.14 Distance to Nearest Facility for Comparison with NQLS Survey

1. Basic Concept

This set of measures has two purposes. It starts with a set of facilities that have been identified
in the Neighborhood Quality of Life Survey (NQLS) developed by James Sallis and others.
Using GIS we measure the physical distance between homes of subjects and these facilities. We
can then assess (a) whether walking and physical activity is associated with measured distance
to these facilities and (b) the correlations between the distances to the facilities measured using
GIS and the survey responses (perceived distances).

2. Basic Formula
Distance to Nearest Facility = Straight line or network distance to the centroid of the nearest
facility of a certain type.

3. Detailed Formula
Same as above.

4. Comments and Explanations

The NQLS survey includes a listing of “stores, facilities, and other things in your
neighborhood.” Respondents can say I they are within the following walking distances: 1-5
minutes, 6-10, 11-20, 20-30, or 30+. The following land uses are asked about in the NQLS survey
but only those highlighted in bold were available in land use data at a detailed level in our area.

1. convenience/small grocery store
2. supermarket

3. hardware store

4. fruit/vegetable market
5.laundry/dry cleaners

6. clothing store
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7. post office

8. library

9. elementary school

10. other schools

11. book store

12. fast food restaurant

13. coffee place

14. bank/credit union

15. non-fast food restaurant
16. video store

17. pharmacy /drug store
18. salon/barber shop

19. your job (available from survey)
20. bus or trolley stop

21. park

22. recreation center

23. gym or fitness facility

To do this one has to convert walking times to distances. We used 3 miles per hour as the
comparison and took the outer limit of the time (i.e. 5 minutes, 10, 20, 30, and further).

5. GIS Approach
[To add.]

6. GIS Steps
[To Add]

5.15 Gravity Measure with Competition (new in Version 2.1)

1. Basic Concept
This is a measurement based on work by Daniel Rodriguez and colleagues at the University of
North Carolina (Song and Rodriguez 2005). Please contact us before using this measure as we are still
checking it and making sure that we are using similar scales and other characteristics to the UNC team.
As they describe:
Definition: The simplest gravity-based measure of land use mix can be defined as the
sum of accessibility of residential land use to all other given type of non-residential land
uses, discounted by the distance decay function between these two points.
Unit of analysis: Individual land parcels or neighbourhoods. (Song and Rodriguez 2005,
6).

Mathematically, Song and Rodriguez (2005b) outline the following;:

n Ad;”
AG; =Y
1N

k=1

B

J

=

“where
AG; = accessibility of residential land use (e.g., house units or neighbourhoods) i to non-
residential land use (e.g., non-residential land parcels or activity centres) j

ENVIRONMENT AND PHYSICAL ACTIVITY: GIS PROTOCOLS VERSION 2.3, August 2005, WORK IN PROGRESS 122
University of Minnesota, Twin Cities Walking Study, Metropolitan Design Center



A = attractiveness of non-residential land use j, in this case, it's measured by floorspace
of retailing stores

d; or d,; = distance from residential use i, or housing unit k, to non-residential use j
dijfﬂ or d o impedance function based on the inverse power function

[ = distance decay parameter

N = number of one type of non-residential land uses

M = number of residential land uses.”

The UNC team’s web site is
http:/ / planningandactivity.unc.edu / Activities%20and %20News.htm

2. Basic Formula
See above.

3. Detailed Formula
See above.

4. Comments and Explanations

We are still coordinating the exact operation of this measurement with the University of North
Carolina team. The specific geography still needs to be defined and some of the variables need
to be more clearly defined.

5. GIS Approach

This is taken directly from draft work by Song and Rodriguez and should be cited as being by
them. The citation is Song, Yan and Daniel A. Rodriguez. 2005b. Steps for Computing the
Dissimilarity, Entropy, Herfindahl-Hirschman and Accessibility (Gravity with Competition)
Indices. Draft Manuscript. Please, however, check their web site for updated versions of these
steps: http:/ / planningandactivity.unc.edu/ Activities%20and %20News.htm

1. “Import the attribute table of single family taxlots to Microsoft Access database named
as “dbl.mdb” and name the table as “SFR”.

2. Import the attribute table of commercial stores to “dbl.mdb” database and name the

table as “STORE”.

3. Create a new table named as “RES” to store the information on distances and store
floorspaces. Modify the table by applying the developed C++ program.

4. Create a new table named as “NEWSTORE” to store the information on the summation
of distances among single family housing units to commercial stores. Apply the
developed C++ program to obtain the values.

5. Create a new table named as “ACCESS” to store the final values of the index. Apply the

developed C++ program to obtain the final values.

Note: You need Microsoft Visual C++ along with ADO to run the developed C++ program.
The code snippet is available upon request. “

6. GIS Steps
[To Add]
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6. STREET PATTERN

Chapter by: Ann Forsyth (drafting, conceptual issues and formulae, some comment text) and Jason
Zimmerman (all the terrific illustrations, most comments, GIS Steps and the GIS approach text);
comment text represents discussions between Ann Forsyth, Joel Koepp, and Jason Zimmerman.

Compared with Version 2.0 of these protocols there are few changes, except for moving the Link-Node
ratio to the end and to add an explanation to 6.2. There were basically no changes between versions 2.1
and 2.2.

Background

Streets and paths are the routes that people generally use to move about the environment
although this is not always the case as people can take short cuts and cuts-through in such
environments as parks and parking lots.

In general, street pattern measures get at issues such as the number and directness of routes for
pedestrians. Pedestrians appreciate the option of direct routes because they are exposed to the
weather and they appreciate options for reasons of variety and safety.

In the first round of Active Living Research grants Jennifer Dill (2003) was funded to examine
the issue of measures of street pattern and we drew on her work in creating this chapter.
Subsequent versions will also draw on more recent research by Steiner et al. (2004).

The next version of this chapter will contain more detail about these conceptual issues,
including more of a review of how earlier studies have dealt with the issue of street pattern.

One last issue is the construction of GIS databases. In some, every street segment is made of one
or more lines (in ArcGIS called “arcs” that begin and end with “nodes”). In others, multiple
segments are contained in one line. This has implications for how street intersections are
counted.

- ++ The vast majority of our roads have
nodes only at the beginning and end of

t the arc. This image shows both kinds—
the nodes in the middle of the cul-de-

sac segment get a valence of 2 and
can be identified and ignored with a
’ ? query when counting intersections.
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6.1 Average Census Block Area

1. Basic Concept

The average census block area is an easy-to-calculate approximation for street pattern. Simply

put, bigger blocks have fewer streets and / or more culs-de sac and unless they also have many
additional pedestrian routes they will be harder to get around. As Dill (2003, 3) explains, block
size is only an approximation as the shape of the blocks also affects the street pattern. This has

been often used in previous research because it uses some form of census block which is easily
available and average block size is easy to calculate in the ArcGIS programs (Hess et al 1999, 1-
2,10; Krizek 2003 (APA), 269; Cervero and Duncan 2003, 1480).

However, in general we used median block size rather than average. This is because medians
are, statistically, a preferred measure. As was explained in chapter one, this meant that we
picked up a number of areas with mostly small blocks but one large land use (e.g. a golf course
or large industrial area) that gave them a medium average block size but a low median.

[In a future version of these protocols we will discuss other related measures such as Ewing et
al (2003, 50-51.)]

2. Basic Formula
Average Census Block Area = Average area for census blocks with a centroid falling within the
measurement geography.

3. Detailed Formula
Same as above.

4. Comments and Explanations
The Centroid Rule
Because the whole block size is what matters, it is not possible to clip the blocks to the
measurement geography. However, this leaves the question of which census blocks to include
in the measure. We examined a number of options including;:

e All census blocks that intersect the measurement geography

e All census blocks with a centroid within the measurement geography

e All census blocks completely contained within the measurement geography
The middle approach was selected because with this approach and a measurement geography
that divided up an entire study area, for example into uniform grid cells, each block would fall
within one and only one cell but also, every block would be counted as part of some cell.

Centroid Calculations—What Can Go Wrong

¢  When using version 8.3 of Arc GIS, We calculated centroids using XTools, which creates a
separate point file. XTools uses a centroid calculation method that does not require the
centroid to be within the boundaries of the shape. That is, in the coordinate system, it places
the centroid at the average of the shape's minimum/maximum X and Y values. However,
the Select by Location tool in ArcMap, from all the evidence, requires the "center" of a shape
to be inside that shape's boundaries. In Arc 9 the toolbox for calculating centroids of
polygons allows you to explicitly choose whether or not the centroid must be located within
the bounds of the polygon, however the choice is still important in particular circumstances
such as odd shaped census blocks (e.g. that bend around lakes). In this case results are
different.
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For consistency we used XTools, that is these protocols do not require the centroid to be within
the polygon. For processes requiring selecting features based on whether or not their centroids
are inside a focus/ context area, that selection process needs to use an actual centroid point file
in the Select by Location dialog, instead of using the polygons from which those centroids were
derived and letting ArcMap use its different "have their centers in" method. [This will be
explained more clearly in future versions of the manual.]

5. GIS Approach

Identify all census blocks with centroids in the measurement geography. Use a spatial join or an
intersect to associate each census block with the ID of the measurement geography in which it is
located. Summarize the attributes by the measurement geography ID, calculating the average of
the Hectares field in the process.

6. GIS Steps
The following procedures were completed using ArcMap (ArcInfo) 8.3.

To complete this protocol you will need:
1. Site layer (polygon)
2. Census block layer (polygon)
3. XTools extension (available from the Downloads section of the ESRI website)

The basic steps are:
e  Create Centroid Layer
Select Census Blocks
Calculate Census Block Areas
Calculate Average Census Block Areas for each Site

Create Centroid Layer:
1. From the XTools drop-down menu, select “Feature Conversions” and choose “Shapes to
Centroids”.
2. Under “Select the layer you wish to convert:” select your census block layer.
3. Give the layer a name and click on “OK”.
4. The new layer will be added to your map document.

Select Census Blocks:

1. Add the census block layer, the centroid layer, and the study site layer to your Map Document.
From the “Selection” drop-down menu, choose “Select by Location...”.

3. Under “I want to:” choose “select features from”.

4. Under “the following layers:” select your centroid layer.

5. Under “that” choose “have their center in”.

6. Under “the features in this layer:” select your study site layer.

7. Hit “Apply”. Now the centroids that fall inside your study sites will be selected.

8. From the “Selection” drop-down menu, choose “Select by Location...”.

9. Under “I want to:” choose “select features from”.

10. Under “the following layers:” select your census block layer.

11. Under “that” choose “contain”.

12. Under “the features in this layer:” select your centroid layer.

13. Be sure the button for “Use selected features” is checked.

14. Hit “Apply”. Now the census blocks that contain the selected centroids will be selected.

15. Right click on your census block layer and select “Data” and then “Export Data...”

16. After “Export:” choose selected features.

17. Choose “Use the same Coordinate System as this layer’s source data.

18. Give the new layer a name and click on OK.
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19. When prompted, add the new layer to the Map Document.

Calculate Census Block Areas:

1.

2.

From the XTools menu, select “Table Operations” and then “Calculate Area, Perimeter, Length,
Acres, and Hectares” (follow instructions included with the extension for XTools installation).
a. Under “Select layer to measure”, select your new census block layer
b. Under “Desired output units”, choose your units (depending on the census block size, try
Miles, Meters, or Feet, for example)
c. If youdonot with to generate a parameter, such as Perimeter, Length, or Hectares,
deselect it now (leave Area and Hectares selected)
d. Hit “OK”
New fields called “Area” and “Hectares” will be created in the attribute table of your new census
block layer with the areas of each polygon calculated in the units you chose (Area) and in
hectares (Hectares).

Calculate Average Census Block Areas for multiple non-overlapping Sites:

1.
2.

3
4.
5

6.
7.

If the site layer does not have unique IDs or names for each site, create them now.

Using a Spatial Join, assign the IDs from the sites to each census block in the new census block
layer.

Open the attribute table of the new census block layer and select the field that contains the IDs.
Right-click on the field name and select Summarize.

Under “2. Choose one or more summary statistics...” expand the box labeled “Hectares” and
check the box marked “Average”.

Select or create an output file name and hit OK.

The output .dbf file will contain the average size, in hectares, of the census blocks from each
study site.

Calculate Average Census Block Areas for multiple overlapping Sites:

1.
2.
3

SO

If the site layer does not have unique IDs or names for each site, create them now.
Using your site polygon layer, select (highlight) the first study site.
Perform a “Select By Location”.
Under “I want to:” choose select features from
Under “the following layers:” choose your census block layer
Under “that:” choose have their center in
Under “the features in this layer:” choose your site polygon layer
Make sure the box for “Use selected features” is checked
f. Hit “Apply”
Open the attribute table of the census block layer.
Right-click on the “Hectares” field and select “Statistics”.
Included in the list of field statistics will be the result of the data calculation for “Mean” (or
average) Hectares for the selected study site.
Record this number elsewhere (in a spreadsheet or Word file).
Repeat steps 2-7 for each study site.

eon T

6.2 Median Census Block Area

1. Basic Concept

As with the average census block area, the median block area is an approximation for street
pattern where bigger blocks have fewer streets and / or more culs-de sac and unless they also
have many additional pedestrian routes they will be harder to get around.

This measure is not as easy to calculate as an average as the calculation needs to be done partly
in Excel.
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2. Basic Formula
Median Census Block Area = Median area for census blocks with a centroid falling within the
measurement geography.

3. Detailed Formula
Same as above.

4. Comments and Explanations
The centroid rule and the inconsistent centroid calculations issues in the previous protocol are
the same for this one.

5. GIS Approach
There are two versions of this protocol.

In the first version, the GIS approach is to perform a spatial intersect between the census block
centroids and study sites. The attribute table of the resulting layer is imported into Microsoft
Access and summarized using the PivotTable feature. This creates a list of all the census blocks
whose centroids are in a given study site. The information is imported from Access into Excel
where the median area can be calculated automatically.

In the second version, which would work if Microsoft Access was not available for use, the
identification of the census block centroids in a study site is done by breaking the study sites
into two groups. Sites that do not overlap can be done in one group by selecting the census
block centroids and exporting the attributes to Excel for calculating the median area. For sites
that do overlap, they must be done one by one, again selecting the census block centroids and
exporting to Excel to calculate the median area.

6. GIS Steps

Version 1
The following procedures were completed using ArcMap (ArcInfo) 8.3.

To complete this protocol you will need:

Site layer (polygon)

Census block layer (polygon)

XTools extension (available from the Downloads section of the ESRI website)
Microsoft Access

Microsoft Excel

S = (2 D)=

The basic steps are:
e Calculate Census Block Areas
e Create Centroid Layer
o  Select Census Blocks
o Intersect Census Blocks and Study Sites
e Manipulate output in Access and export to Excel spreadsheet
o Calculate Median Census Block Areas for each Site

Calculate Census Block Areas:
1. From the XTools menu, select “Table Operations” and then “Calculate Area, Perimeter, Length,
Acres, and Hectares” (follow instructions included with the extension for XTools installation).
a. Under “Select layer to measure”, select your new census block layer
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b. Under “Desired output units”, choose your units (depending on the census block size, try
Miles, Meters, or Feet, for example)
c. If youdonot with to generate a parameter, such as Perimeter, Length, or Hectares,
deselect it now (leave Area and Hectares selected)
d. Hit “OK”
New fields called “Area” and “Hectares” will be created in the attribute table of your new census
block layer with the areas of each polygon calculated in the units you chose (Area) and in
hectares (Hectares).

Create Centroid Layer:

1.

2.
3
4

From the XTools drop-down menu, select “Feature Conversions” and choose “Shapes to
Centroids”.

Under “Select the layer you wish to convert:” select your census block layer.

Give the layer a name and click on “OK”.

The new layer will be added to your map document.

Select Census Blocks:

Add the census block centroid layer and the study site layer to your Map Document.
From the “Selection” drop-down menu, choose “Select by Location...”.

Under “I want to:” choose “select features from”.

Under “the following layers:” select your centroid layer.

Under “that” choose “have their center in”.

Under “the features in this layer:” select your study site layer.

Hit “Apply”. Now the centroids that fall inside your study sites will be selected.
From the “Selection” drop-down menu, choose “Select by Location...”.

Under “I want to:” choose “select features from”.

. Under “the following layers:” select your census block centroid layer.

. Under “that” choose “are completely within”.

. Under “the features in this layer:” select your study site layer.

. Hit “Apply”. Now the census blocks centroids that are inside the study sites will be selected.
. Right click on your census block centroid layer and select “Data” and then “Export Data...”

. After “Export:” choose selected features.

. Choose “Use the same Coordinate System as this layer’s source data.

Give the new layer a name and click on OK.

. When prompted, add the new layer to the Map Document.

Open the GeoProcessing Wizard.

1.

SCINESCORID

Choose Intersect two layers and click Next

Select the exported subset of census block centroids from the previous step as the input layer
Select your study site layer as the overlay layer

Choose a name and location for the output layer

Click Finish

The new layer will be added to the Map Document

Import data into Microsoft Access

1.
2.

QSRSUONOINERC)

Open the Attribute Table of the layer created in the previous intersect step

Choose “Export” and select a location and name for the output DBF. NOTE: make the filename 8
characters or less so it can be imported into an Access database.

Open Microsoft Access and create a new blank database.

Go to File->Get External Data->Import

Find the DBF table you exported from ArcMap above and import it

Open the newly imported table

From the View menu, select PivotTable View

In the Field List window, select the name of the unique study site ID and drag it onto the large
window where it says “Drop Column Fields Here”

ENVIRONMENT AND PHYSICAL ACTIVITY: GIS PROTOCOLS VERSION 2.3, August 2005, WORK IN PROGRESS 129
University of Minnesota, Twin Cities Walking Study, Metropolitan Design Center



9.

From the Field List, drag the field containing the Area onto the large window where it says
“Drop Totals or Detail Fields Here”

Copy data into Microsoft Excel and calculate median

2.

Open a new blank Microsoft Excel spreadsheet

In Access, click and drag the column headings to select them, and then do CTRL-C to copy them

3. Switch to Excel and do CTRL-V to paste them (NOTE: if you have more than 255 study site IDs,
you will need to paste into multiple worksheet tabs, as Excel worksheets are limited to 255
columns)

4. Find the row beneath the last row to contain any values (each column will have a different
number of values depending on how many census block centroids were found in each
measurement geography)

5. Calculate the median of all the cells above containing area values

Version 2

The following procedures were completed using ArcMap (ArcInfo) 8.3.

To complete this protocol you will need:

6.
7.
8.

Site layer (polygon)
Census block layer (polygon)
XTools extension (available from the Downloads section of the ESRI website)

The basic steps are:

Create Centroid Layer

Select Census Blocks

Calculate Census Block Areas

Calculate Median Census Block Areas for each Site

Create Centroid Layer:

5.

6.
7.
8

From the XTools drop-down menu, select “Feature Conversions” and choose “Shapes to
Centroids”.

Under “Select the layer you wish to convert:” select your census block layer.

Give the layer a name and click on “OK”.

The new layer will be added to your map document.

Select Census Blocks:

19.
20.
21.
22.
23.
24.
25.
26.
27.
28.
29.
30.
31.
32.
33.
34.
35.
36.
37.

Add the census block layer, the centroid layer, and the study site layer to your Map Document.
From the “Selection” drop-down menu, choose “Select by Location...”.

Under “I want to:” choose “select features from”.

Under “the following layers:” select your centroid layer.

Under “that” choose “have their center in”.

Under “the features in this layer:” select your study site layer.

Hit “Apply”. Now the centroids that fall inside your study sites will be selected.

From the “Selection” drop-down menu, choose “Select by Location...”.

Under “I want to:” choose “select features from”.

Under “the following layers:” select your census block layer.

Under “that” choose “contain”.

Under “the features in this layer:” select your centroid layer.

Be sure the button for “Use selected features” is checked.

Hit “Apply”. Now the census blocks that contain the selected centroids will be selected.
Right click on your census block layer and select “Data” and then “Export Data...”
After “Export:” choose selected features.

Choose “Use the same Coordinate System as this layer’s source data.

Give the new layer a name and click on OK.

When prompted, add the new layer to the Map Document.
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Calculate Census Block Areas:

3.

4.

From the XTools menu, select “Table Operations” and then “Calculate Area, Perimeter, Length,
Acres, and Hectares” (follow instructions included with the extension for XTools installation).
a. Under “Select layer to measure”, select your new census block layer
b. Under “Desired output units”, choose your units (depending on the census block size, try
Miles, Meters, or Feet, for example)
c. Ifyoudonot with to generate a parameter, such as Perimeter, Length, or Hectares,
deselect it now (leave Area and Hectares selected)
d. Hit “OK”
New fields called “Area” and “Hectares” will be created in the attribute table of your new census
block layer with the areas of each polygon calculated in the units you chose (Area) and in
hectares (Hectares).

Calculate Median Census Block Areas for multiple non-overlapping Sites:

1.
2.

SN ORI

QOR

If the site layer does not have unique IDs or names for each site, create them now.

Using a Spatial Join, assign the IDs from the sites to each census block in the new census block
layer.

Open the attribute table of the new census block layer.

Under the XTools drop-down menu, select “Table Operations” and then “Export to Excel”.
Under “Select source table:” select your census block layer.

Under “Select fields to export:” select the field that contains the IDs and the field labeled
“Hectares”.

Hit “OK”.

The two fields will be exported into a new Excel worksheet. Use the Excel formula commands to
calculate the median size of the census blocks in each study site.

Calculate Median Census Block Areas for multiple overlapping Sites:

1.
2.
3

=10 0N o Uk

0.

11.
12.

If the site layer does not have unique IDs or names for each site, create them now.
Using your site polygon layer, select (highlight) the first study site.
Perform a “Select By Location”.
a. Under “I want to:” choose select features from
b. Under “the following layers:” choose your census block layer
c.  Under “that:” choose have their center in
d. Under “the features in this layer:” choose your site polygon layer
e. Make sure the box for “Use selected features” is checked
f. Hit “Apply”
Open the attribute table of the census block layer.
Click on the “Show: Selected” button at the bottom of the screen.
Under the XTools drop-down menu, select “Table Operations” and then “Export to Excel”.
Under “Select source table:” select your census block layer.
Under “Select fields to export:” select the field labeled “Hectares”.
Hit “OK”.
The “Hectares” field will be exported into a new Excel worksheet. Use the Excel formula
commands to calculate the median size of the census blocks in the study site.
Record this number elsewhere (in a spreadsheet or Word file).
Repeat steps 2-11 for each study site.

6.3 Ratio of Area within X Street Distance to Area within X Distance Radius

1. Basic Concept
Also called the effective walking area (Dill 2003) this is a measure of how connected the street
pattern is. As can be seen in the diagram below, the area that can be reached along the street
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network (the central, red area), is smaller in the loop and cul-de-sac road arrangement than in
the more gridded street pattern to the right.

l

B R N , |

Both diagrams show two 0.5 mile/402 meter buffers—a straight line or crow flies buffer and 0.5
mile/402 meter street distance buffer. The left diagram was generated in an area with many
loops and culs-de-sac and the right in a more gridded area with smaller median block size. As
can be seen visually, the ratio of the area within a network buffer to area within the crow flies
buffer is much smaller in the loop and cul-de-sac area than in the gridded area, indicating that it
is harder to get around.

Previous work in this area had looked at the ratio of number of parcels within the network
distance to parcels within the crow flies distance (Dill 2003, 5). We, however, decided to look at
the areas.

It should be noted that the network buffer diagram shapes generate a set of points along the
road network at x distance from the starting point, then join the points. This means that this is
an approximation of the area people can walk to as it cuts through large parcels. It also uses the
street network rather than the pedestrian network as the base and some researchers think this
may be a less accurate measure of pedestrian accessibility in the suburbs where cuts-through
parks and parking lots are typical (Moudon 200X). However, as an approximation it seems to be
relevant.

2. Basic Formula
Ratio of Area within X Street Distance to Area within X Distance Radius = Ratio of area within a
x distance network buffer distance divided by area within a x distance crow flies buffer.

3. Detailed Formula

Ratio of Area within X Street Distance to Area within X Distance Radius = Ratio of area within a
x distance network buffer distance divided by area within a x distance crow flies buffer with
water excluded from both measures.
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4. Comments and Explanations
As was explained in Chapter 2, Network Analyst is currently only available in ArcView so
those using ArcGIS will need to use this second program.

5. GIS Approach

Use the Buffer tool to create 400 meter buffers, then use Network Analyst to create the 400
meter network buffers. Use XTools to calculate the area of each buffer and then divide the area
of the network buffer by the area of the crow flies bulffer.

6. GIS Steps
The following procedures were completed using ArcMap (ArcInfo) 9.0 and ArcView 3.3.

To follow this protocol you will need:

1

.
3.
4

Site layer (polygon)

Participant locations layer (point)

Road centerline layer (polyline)

XTools extension (available from the Downloads section of the ESRI website)

Calculate area of straight line buffers

SUCHICINS

8.

Start an ArcMap 9.0 document and add the participant locations to the view
In Arc Toolbox, open Analysis Tools 2Proximity, and select Buffer.
In the Buffer tool window, under Input Features select your participant locations layer
Under Output Feature Class, choose a name and location for the output shapefile
For Distance, click Linear Distance , enter 400, and select meters from the drop-down list
Click OK
From the XTools menu, select “Table Operations” and then “Calculate Area, Perimeter, Length,
Acres, and Hectares” (follow instructions included with the extension for XTools installation).
a. Under “Select layer to measure”, select the new buffer layer
b. Under “Desired output units”, choose your units (depending on the parcel size, try
Meters or Feet, for example)
c. If you do not with to generate a parameter, such as Perimeter, Length, or Hectares,
deselect it now (leave Hectares selected)
d. HitOK
A field called Hectares will be added to the Attribute Table of the straight line buffer layer.

Calculate area of network buffers

1. Start an ArcView 3.3 project and add the roads layer and participant locations layer to a new
view
a. Go to the View menu and select Properties to set the map and distance units
b. Go to the File menu and select Extensions
c. Check the box to turn on the Network Analyst extension
2. Open the participant locations table
3. Go to the Table menu and choose Start Editing
4. Go to the Edit menu and choose Add Field
5. Name the field REPORTCOST and set it to type Number, then hit OK
6. Click the heading of the new REPORTCOST field, open the Field menu, and choose Calculate
7. Type 400 and hit OK
8. Go to the Table menu and choose Stop Editing, then click Yes when prompted to save edits
9. Select the roads theme in the View
10. Go to the Network menu and choose Find Service Area
11. Click the Load Sites button and choose the participant locations layer
12. Make sure Travel from site is selected
13. Click the button in the upper right of the window with the grid and black arrow to begin the
processing
14. When finished, click on the Sareal theme in the View
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15. Go to the Theme menu and choose Convert to shapefile
16. Select a name and location for the new shapefile
17. Switch to ArcMap and add this new shapefile to the view
18. From the XTools menu, select “Table Operations” and then “Calculate Area, Perimeter, Length,
Acres, and Hectares” (follow instructions included with the extension for XTools installation).
a. Under “Select layer to measure”, select the new network buffer layer
b. Under “Desired output units”, choose your units (depending on the parcel size, try
Meters or Feet, for example)
c. If youdonot with to generate a parameter, such as Perimeter, Length, or Hectares,
deselect it now (leave Hectares selected)
d. HitOK
19. A field called Hectares will be added to the Attribute Table of the network buffer layer

For each study site, divide the area of its network buffer by the area of its straight line buffer to calculate
the ratio.

6.4 Number of Access Points

1. Basic Concept
Access points are a measure of the amount of connection an area has to its surroundings. We are
not convinced it is a good measure of walkability but we are testing it.

At its most extreme one can imagine a gated neighborhood which inside the neighborhood had
small blocks and a highly connected street pattern, but had only one way in and out. In this case
walking to destinations outside the development would be made far more complex. Access
point measures create a measurement geography, generally a grid cell, and measure how
porous its edges are (Southworth 1997; McNally and Kulkarni 1997, 109).

2. Basic Formula
Number of Access Points = Number of times a road crosses the edge of the measurement

geography.

3. Detailed Formula
Number of Access Points = Number of times a road crosses the edge of the measurement
geography with divided at-grade roads counted once and limited access highways excluded.

4. Comments and Explanations

Access points are points of intersection between road
centerlines and site boundaries excluding points resulting
from the intersections of site boundaries with Interstates, on-
and off-ramps, and other limited access highways.

S In the diagram to the left, the four green points are access

| points created by the intersection of the site boundary and an
___——+——— . Interstate and its on- and off-ramps, and therefore are

|7 ‘ | ‘ ‘\ excluded from the analysis. The red point is a valid access

N point.
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analysis.

5. GIS Approach

5

Also, site boundary intersections with divided at-grade
roads, such as parkways, are counted once (as one access
point) instead of twice. The green point in the diagram to the
left is half of a set of paired access points created by the
intersection of the site boundary and a divided parkway.
Only the red access points are included in the analysis.

Many access points, as measured, are somewhat marginal
in their quality. That is, these points may exist but not
provide significant access to the site, or may fall just inside
the site boundary and therefore not be counted (see
examples below).The red point in the middle of the image
is technically an access point because the road centerline
just crosses the site boundary, even though it provides no
significant access to the site. However, it is extremely
complex to develop rules to exclude such points—see next
image for more examples.

The three purple circles identify points that should be
included in the analysis, since they provide significant
access to the site, but are not because the road
centerlines lie just inside the site boundary and do not
intersect it.

We experimented with methods of buffering these points
and derived various rules for exclusion or inclusion, but in
the end determined that this opened the door to many
subjective decisions. It seemed that the number of access
points included that probably should be excluded would
roughly offset the number of access points excluded that
probably should be included and therefore we decided to
set aside the issue of marginal access points in our

A point file was created that contained all points were road centerlines intersected site
boundaries. From this set, Interstate points were deselected. For any divided roads (those with
two distinct centerlines, such as parkways), one half of the access points were deselected. The
total number of access points for each study site were summed.

6. GIS Steps
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The following procedures were completed using ArcMap (ArcInfo) 8.3.

To complete this protocol you will need:
1. Site layer (polygon)
2. Site boundary layer (polyline)
If you only have a polygon site layer, convert the polygons to polylines using the XTools
extension (available from the Downloads section of the ESRI website).
3. Road centerline layer (polyline)
4. AddPointsAtCrossings ArcScript available from the Downloads section of the ESRI website

The basic steps are:
e Create the Access Point file
o Correct for Interstate Access Points
o Correct for Parkway Access Points
e Remove Unwanted Access Points from View/Table
o Summarize Access Point Counts for each Site

Create the Access Point file:
1. Using ArcMap, install the AddPointsAtCrossings script following the instructions included with
the file.
Add to your Map Document the road centerline and the site boundary layers.
In ArcCatalog, create a point file (layer) that will eventually contain the output of the access point
procedure.
Begin editing the point layer.
Highlight the two polyline layers.
Run the AddPointsAtCrossings macro.
Your point layer will now contain points created from the intersections of the two polyline layers.

@
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Correct for Interstate Access Points:
1. Open the attribute table of the access point layer.

Click on the “Options” button at the bottom of the window and select “Add Field”

Enter the field name “Corrected”.

Hit “OK”

In your view, manually select the access points that result from the intersection of a site boundary

and an Interstate or its on- or off-ramps.

6. Return to the attribute table of your access point layer.

7. Click on the “Show: Selected” button at the bottom of the screen.

8. Right click on the field name you just created (“Corrected”).

9. Select “Calculate Values”.

10. Assign these records a value of “1”.

11. Click on the “Show: All” button at the bottom of the screen.

12. Click on the “Options” button at the bottom of the screen and select “Clear Selection”. Close the
attribute table.

QI SCONS

Correct for Parkway Access Points:
1. Inyour view, manually select one of each of the pair of access points resulting from divided
parkways.
Open the attribute table of the access point layer.
Click on the “Show: Selected” button at the bottom of the screen.
Right click on the field name you just created (“Corrected”).
Select “Calculate Values”.
Assign these records a value of “2”.
Click on the “Show: All” button at the bottom of the screen.
Click on the “Options” button at the bottom of the screen and select “Clear Selection”. Close the
attribute table.

29 N @)1 = 09 D)
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Remove Unwanted Access Points from View /Table:

1.

29 N @)1 = 99 )

Right click on your access point layer and select “Properties”.

Click the tab that says “Definition Query”.

Click the button that says “Query Builder”.

Under “Fields” double-click on the field you just created (“Corrected”).

Click or type “=". Under “Unique Values:” double-click on “0”.

Hit “OK”. The Query Builder window will close.

Hit “OK”. The Layer Properties window will close.

Now, access points resulting from the intersection of a site boundary and an Interstate or its on-
and off-ramps and one of the paired divided parkway points will not be displayed. To display all
access points again, repeat steps 1-7 but remove the existing equation in the “Query Builder”.

Summarize Access Point Counts for multiple non-overlapping sites without shared edges:

N P = 9 [ 1=

If the site layer does not have unique IDs or names for each site, create them now.

Using a Spatial Join, assign the IDs from the sites to each access point.

Open the attribute table of the access point layer and select the field that contains the IDs.
Right-click on the field name and select Summarize.

Select or create an output file name and hit OK.

The output .dbf file will contain the counts of access points in each site.

Summarize Access Point Counts for multiple non-overlapping sites with shared edges:

1.
2.
3

4.

3
6.
7

If the site layer does not have unique IDs or names for each site, create them now.

Using a Spatial Join, assign the IDs from the site to each access point (use “closest distance”
features).

Access points that fall on shared edges will each have two records in the attribute table. When
joined, both points will be given the same ID. Each shared access point must have one of the two
IDs changed manually in the table.

Once step 3 is complete, open the attribute table of the access point layer and select the field that
contains the IDs.

Right-click on the field name and select Summarize.

Select or create an output file name and hit OK.

The output .dbf file will contain the counts of access points in each site.

Summarize Access Point Counts for multiple overlapping sites:

52l 2 OO SHESSH =

If the site layer does not have unique IDs or names for each site, create them now.
Using your site polyline layer, select (highlight) the first study site.

Perform a “Select By Location”.

Under “I want to:” choose select features from

Under “the following layers:” choose your access point layer

Under “that:” choose are within a distance of

Under “the features in this layer:” choose your site polyline layer

Make sure the box for “Use selected features” is checked

Check the box for “Apply a buffer...of:” and fill in a very small distance (e.g., 1 meter)

. Hit “Apply”
. Open the attribute table of the access point layer.
. Text at the bottom of the window should show you how many access points are selected. This is

the number of access point for the study site you currently have selected.

. Record this number elsewhere (in a spreadsheet or Word file).
. Repeat steps 2-6 for each study site.

6.5 Road Length per Unit Area

1. Basic Concept
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Road length per hectare is related to both block size and connectivity.

The next version of these protocols will contain more detailed about earlier uses of this
measurement.

2. Basic Formula
Road Length per Unit Area = Length of road with both interstates and ramps removed and
divided roads averaged, per measurement area.

3. Detailed Formula
Road Length per Unit Area = Length of road with both interstates and ramps removed and
divided roads averaged, per measurement area with water removed from land area calculation.

4. Comments and Explanations

Road lengths are simply the sums of the lengths of all road centerlines bounded by the study
sites. Similar to the process used for access points, we ignored non-pedestrian lengths by
removing Interstates and on- and off-ramps from our calculations. Also, we removed one of
each pair of centerlines from all parkways and other divided at-grade roads in order to count
their lengths once instead of twice.

Once this was done we used the area of each site to calculate the road length per hectare figures
for each site.

5. GIS Approach

Delete all Interstates and on- and off-ramps. Delete one of each pair of centerlines for parkways
and at-grade divided roads. Intersect the roads layer with the measurement geographies.
Recalculate the length of the road segments. Summarize the intersected layer by the
measurement geography ID, calculating the sum of the Length field in the process. Divide the
resulting sum of road lengths by the area in hectares of the associated measurement geography.

6. GIS Steps
The following procedures were completed using ArcMap (ArcInfo) 8.3.

To follow this protocol you will need:
1. Site layer (polygon)
2. Road centerline layer (polyline)
3. XTools extension (available from the Downloads section of the ESRI website)
4. The protocol for determining Net Land Area (without water)

The basic steps are:
e  Calculate Road Lengths
o Correct for Interstate Road Segments
e Correct for Divided At-grade Road Segments
e Remove Unwanted Road Segments from View/Table
e  Summarize Road Lengths
e Determine Net Land Area (without water) for each Site
o  Calculate Road Length per Hectare

Calculate Road Lengths:
1. Using the GeoProcessing Wizard, intersect the road centerline layer with the site polygon layer.
a. Under the Tools menu, select “GeoProcessing Wizard”.
b. Select “Intersect Two Layers” and click on “Next”.
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2.

c. Under “Select the input layer to intersect:” choose your road layer.
d. Under “Select a polygon overlay layer:” choose your site layer.
e. Give your file a name and hit “Finish”.
Using XTools, recalculate the length of the road segments in the newly intersected layer.
a. Under the XTools menu, select “Table Operations”.
b. Choose “Calculate Area, Perimeter, Length, Acres, and Hectares”.
c.  Under “Select layer to measure:” choose your new road layer.
d. Choose your desired output units.
e. Hit “OK”. The lengths of the road segments in the Length field will be recalculated.

Correct for Interstate Road Segments:

Open the attribute table of your new road layer (right-click on the layer).

Click on the “Options” button at the bottom of the window and select “Add Field”

Enter a name for a field that will indicate if a road segment is an Interstate or an on- or off-ramp.
Hit “OK”

In your view, manually select the road segments that are Interstates or on- or off-ramps.

Return to the attribute table of your road layer.

Click on the “Show: Selected” button at the bottom of the screen.

Right click on the field name you just created.

Select “Calculate Values”.

. Assign these records a value of “1”.
. Click on the “Show: All” button at the bottom of the screen.
. Click on the “Options” button at the bottom of the screen and select “Clear Selection”. Close the

attribute table.

Correct for Divided At-grade Road Segments:

1.
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17.
18.

Open the attribute table of your new road layer.

Click on the “Options” button at the bottom of the window and select “Add Field”

Enter a name for a field that will indicate if a road segment is a divided at-grade road segment.
Hit “OK”

Click on the “Options” button at the bottom of the window and select “Add Field”

Enter a name for a field that will indicate it contains an average length of a divided at-grade road
segment.

Hit “OK”

For each site that contains divided at-grade road segments, select the pair of roadways that make
up the divided at-grade road.

Return to the attribute table of your road layer.

Click on the “Show: Selected” button at the bottom of the screen.

Right click on the field name you just created.

Select “Calculate Values”.

Assign these records a value of “1”.

Calculated the total length of the two roadways.

Divide by 2 to find the average length.

Enter this length into the new AVERAGE field of any one record of those currently selected
(leave the remained selected records as 0).

Repeat steps 8-16 for each set of divided at-grade roads in the site.

Repeat steps 8-17 for each site.

Remove Unwanted Road Segments from View / Table:

1.
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Right click on your access point layer and select “Properties”.

Click the tab that says “Definition Query”.

Click the button that says “Query Builder”.

Under “Fields” double-click on the field you just created for Interstates and on- and off-ramps.
Click or type “=". Under “Unique Values:” double-click on “0”.

Hit “OK”. The Query Builder window will close.

Hit “OK”. The Layer Properties window will close.
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8. Now, only those road segments that are NOT Interstates or on- and off-ramps will be displayed.
To display all road segments again, repeat steps 1-7 but remove the existing equation in the
“Query Builder”.

Summarize Road Lengths:

Open the attribute table of the new roads layer.

Click on the “Options” button at the bottom of the window and select “Select by Attributes”.

Under “Fields” double-click on the field you created for divided at-grade roadways.

Click or type “=". Under “Unique Values:” double-click on “0”.

Hit “Apply”. (You may now close the “Select by Attributes” window at any time.)

Click on the “Show: Selected” button at the bottom of the screen. Only the non-divided road

segments will now be displayed.

7. Right-click on the ID field name and select Summarize.

8. In the window that opens, under step 2 select the Length field and check the box marked sum.

9. Select or create an output file name and hit OK.

10. At the bottom of the window check the box marked “Summarize on the selected records only”.

11. The output .dbf file will contain the sums of the lengths of non-divided roads in each site.

12. Click on the “Options” button at the bottom of the window and select “Switch selection”. The
divided road segments will now be selected.

13. Click on the “Show: Selected” button at the bottom of the screen. Only the divided road segments
will now be displayed.

14. Right-click on the ID field name and select Summarize.

15. In the window that opens, under step 2 select the Average Length field and check the box
marked sum.

16. Select or create an output file name and hit OK.

17. At the bottom of the window check the box marked “Summarize on the selected records only”.

18. The output .dbf file will contain the sums of the average lengths of divided roads in each site.

19. In Excel or other spreadsheet program, open the two .dbf files and sum the road lengths to arrive
at the total road lengths for each site.

N Q1 = o)) =

Determine Net Land Area (without water) for each Site:
1. Follow the steps outlined in the protocol above.

Calculate Road Length per Hectare:

Open the attribute table of the site layer and right click on the ID field name. Select Summarize.
In the window that opens, under step 2 select the Hectares field and check the box marked sum.
Select or create an output file name and hit OK.

The output .dbf file will contain the total hectares in each site.

In Excel or other spreadsheet program, combine your total road length figures and your total
hectares figures based on the site ID numbers.

For each site, divide total road length by total hectares to arrive at road length per hectare figures.
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6.6 Intersections per Unit Area

1. Basic Concept

The number of intersections per hectare is a measure of the connectivity of the street network
(Cervero and Kockelman 1996, 8; McNally and Kulkarni 1997, 109). However, as can be seen
from this and later protocols, judging an intersection can be complex, particularly in older areas
in particular, where intersections are not regularly spaced, road rights of way have varying
sizes, and centerlines may be slightly offset within the right of way creating false positives in
terms of intersection counts (see below for more detail).
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This is obviously an area where more research would help, to discover how much of a jog in an
intersection is needed before it is perceived as two intersections. In the absence of such research,
we spent some time observing difficult cases in the field.

2. Basic Formula
Intersections per Unit Area = Number of intersections per unit land area.

3. Detailed Formula

Intersections per Unit Area = Number of intersections per unit land area excluding freeways
with land area excluding water. Intersections are measured raw, and buffered by 10 meter and
15 meter buffers to deal with slightly offset centerlines and divided roads.

4. Comments and Explanations

As was explained in the introduction to this chapter, a key issue in measuring intersections is
how the streets are entered into the GIS database—as a series of segments that end at each
intersection or as long lines that overlap. These instructions are for the segment-by-segment
type of database—other types will need to use slightly different ArcGIS operations although the
concepts will be basically the same.

All of our intersection counts excluded intersections
formed by the convergence of Interstates and on- or
off-ramps (see diagram to left), but included
intersections between on- and off-ramps and local
streets.

We also tried to correct for intersections where roads converged on an area but did not perfectly
align and therefore failed to provide our GIS operations with a single intersection point. To do
this, we created buffers around each intersection point (both 10 meter and 15 meter buffers),
merged them where they overlapped, and created new centroids to act as intersection points for
our new intersection polygons (see diagrams below).
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This diagram shows the buffering process where two road centerlines are slightly offset,
creating two T intersections in the GIS measurement but in the field, because the road has a
width on either side of the center line, they would be perceived as one 4-way intersection. In
these cases we used buffering to merge the two intersections into one.

A buffer distance of 20 meters was also tried, but it was determined though fieldwork by the
environmental measurement team, and then independently by the Principal Investigator, that
the distance between roads was too great to consider the area as a singular functional
intersection. In order to make these judgments we took two field trips. First, the environmental
team walked key intersections at the university and measured them to get a sense of road
dimensions. Second, the Principal Investigator located part of the study area with nearby
intersections that were 20 (10 meter buffers), 30, and 40 meters apart and went out on a sunny
afternoon and observed how walkers were using the intersections. The first two functioned as
one intersection, the last did not, although the specific case could vary with the width of the
paved areas, the presence or absence of sidewalks, and the location of street trees.)

5. GIS Approach

Remove Interstates from the road centerline file. Use the Calculate Fnode Tnode script to create
the intersection point file. Remove points with a valence of 1 or 2. Buffer intersections with 10
and 15 meter buffers and create new intersection centroids. Intersect point file with
measurement geography and summarize intersection counts per unit area.

6. GIS Steps
The following procedures were completed using ArcMap (ArcInfo) 8.3.

To follow this protocol you will need:

Site layer (polygon)

Road centerline layer (polyline)

Calculate Fnode Tnode ArcScript available from the Downloads section of the ESRI website
XTools extension (also available from the Downloads section of the ESRI website)

The protocol for determining Net Land Area (without water)
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The basic steps are:
o Create the Intersections file
o  Clip Intersections to Study Sites
o Correct for Interstate/Ramp Intersections
e  Remove Unwanted Intersection from View/Table
o  Create Buffered Intersections
e  Summarize Intersection Counts for each Site
o  Determine Net Land Area (without water) for each Site
o Calculate Intersections per Hectare for each Site

Create the Intersections file:

1. Using ArcMap, install the Calculate Fnode Tnode script following the instructions included with
the file.

2. Add to your Map Document the road centerline layer.

3. Create a point file (layer) that will eventually contain the output of the intersection node
procedure.

4. Run the Calculate Fnode Tnode tool.

5. When prompted, select your rode centerline layer as your polyline layer and the new point layer
as your point layer.

6. Select 0 as the beginning ID number for the nodes.

ENVIRONMENT AND PHYSICAL ACTIVITY: GIS PROTOCOLS VERSION 2.3, August 2005, WORK IN PROGRESS 142
University of Minnesota, Twin Cities Walking Study, Metropolitan Design Center



After the procedure concludes, your point layer will now contain points created from the nodes
of the road centerline layer. The numbers in the “valence” field represent the number of roads
that converge to create the node (e.g., a valence of 1 means the node is a dead end or cul-de-sac; a
valence of 3 indicates a 3-way intersection; etc.).

Clip Intersections to Study Sites:

1.

2.

Using GeoProcessing Wizard, clip the intersection layer to your study site(s).
a. Inthe GeoProcessing Wizard, select Clip one layer based on another
b. Click on Next
c.  Under Select the input layer to clip, select your intersection layer
d. Under Select a polygon clip layer, select your study site layer
e. Give your clipped layer a name and click on Finish
The new clipped layer will open separately.

Correct for Interstate/Ramp Intersections:
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Open the attribute table of the (clipped) intersection layer.

Click on the “Options” button at the bottom of the window and select “Add Field”

Enter the field name “Corrected”.

Hit “OK”

In your view, manually select the intersections formed by the convergence of Interstates and on-
or off-ramps.

Return to the attribute table of your intersection layer.

Click on the “Show: Selected” button at the bottom of the screen.

Right click on the field name you just created (“Corrected”).

Select “Calculate Values”.

. Assign these records a value of “1”.
. Click on the “Show: All” button at the bottom of the screen.
. Click on the “Options” button at the bottom of the screen and select “Clear Selection”. Close the

attribute table.

Remove Unwanted Intersections from View /Table:

1.
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Right click on your intersection layer and select “Properties”.

Click the tab that says “Definition Query”.

Click the button that says “Query Builder”.

Under “Fields” double-click on the field you just created (“Corrected”).

Click or type “=". Under “Unique Values:” double-click on “0”.

Click or type “AND”.

Under “Fields” double-click on “valence”.

Click or type “>". Under “Unique Values:” double-click on “2”.

Hit “OK”. The Query Builder window will close.

Hit “OK”. The Layer Properties window will close.

Now, only those intersections NOT formed by the convergence of Interstates and on- or off-
ramps AND created by the intersection of 3 or more road segments (no cul-de-sacs) will be
displayed. To display all intersections again, repeat steps 1-10 but remove the existing equation
in the “Query Builder”.

Create Buffered Intersections:

1. Under the Tools dropdown menu, select “Buffer wizard”.
a. In the Buffer Wizard window, under “The features of a layer” select your (clipped)
intersection layer and click on Next
b. Click “At a specified distance” and enter XX (your desired distance)
c. After “Distance units are:” select meters
d. Click Next
e. After “Dissolve barriers between” select Yes
f.  Give the layer a name and save as a new layer
g. Click Finish
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2. Using XTools, select “Feature Conversions” and then “Shapes to Centroids”.
a. Select the new buffer layer (polygon)
b. Give the point layer you are about to create a name and click OK
3. The new layer will contain points that represent merged intersections — those resulting from two
intersections that are within 2(XX) meters of each other (a XX meter radius around each
intersection) and essentially functioning as one intersection for the purposes of this analysis.

Summarize Intersection Counts for multiple non-overlapping sites:

If the site layer does not have unique IDs or names for each site, create them now.

Using a Spatial Join, assign the IDs from the sites to each intersection.

Open the attribute table of the intersection layer and select the field that contains the IDs.
Right-click on the field name and select Summarize.

Select or create an output file name and hit OK.

The output .dbf file will contain the counts of intersection nodes in each site.
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Summarize Intersection Counts for multiple overlapping sites:

If the site layer does not have unique IDs or names for each site, create them now.

Using your site polygon layer, select (highlight) the first study site.

Perform a “Select By Location”.

Under “I want to:” choose select features from

Under “the following layers:” choose your intersection node layer

Under “that:” choose have their center in

Under “the features in this layer:” choose your site polygon layer

Make sure the box for “Use selected features” is checked

Hit “Apply”

4. Open the attribute table of the intersection node layer.

5. Text at the bottom of the window should show you how many intersections are selected. This is
the number of intersections in the study site you currently have selected.

6. Record this number elsewhere (in a spreadsheet or Word file).

7. Repeat steps 2-6 for each study site.
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Determine Net Land Area (without water) for each Site:
1. Follow the steps outlined in the protocol above.

Calculate Intersections per Hectare for each Site:

1. Open the attribute table of the site layer and right click on the ID field name. Select Summarize.

2. In the window that opens, under step 2 select the Hectares field and check the box marked sum.

3. Select or create an output file name and hit OK.

4. The output .dbf file will contain the total hectares in each site.

5. In Excel or other spreadsheet program, combine intersection node counts and your total hectares
figures based on the site ID numbers.

6. For each site, divide the number of intersection nodes by total hectares to get the number of

intersections per hectare.

6.7 Ratio of 4-Way Intersections to All Intersections

1. Basic Concept

Four-way intersections are an indicator of grid street patterns, thought to be more connected.
However, one can imagine a high proportion of four way intersections in an area with
enormous blocks, so the density of intersections should also be considered.

2. Basic Formula
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Ratio of 4-Way Intersections to All Intersections = Raw percent of 4-way intersections versus
other intersections (valence 3+).

3. Detailed Formula
Ratio of 4-Way Intersections to All Intersections = Same as above although with the added
complication that some higher valence intersections are actually 3-way and 4-way intersections.

4. Comments and Explanations

As outlined in Intersections per Unit Area, intersection counts in our study sites (1) did not
include intersections formed by the convergence of Interstates and on- or off-ramps and (2)
corrected for mis-aligned intersections by creating buffers around each intersection node,
merging them where they overlapped, and creating a centroid for each new intersection

polygon.

In order to be able to classify these new nodes, we created “rules” to assign types (3-way, 4-
way) to the intersections. These assignments were based on the sum of the valences of the
original intersections (the valence of an intersection, based on the script that creates the
intersection nodes, is the count of the number of road segments that converge to create the node
—a valence of 1 is a dead end or cul-de-sac; a valence of 3 is a 3-way intersection; a valence of 4
is a 4-way intersection; etc.).

In particular, we realized that intersections with valences of 6 were typically the result of two
intersections that were not quite aligned but that functioned as 4-way intersections.
Intersections with valences of 8 were almost always the result of intersections of divided and
non-divided roads that functioned as 4-way intersections. Intersections with valences of 16 were
the result of intersections of two divided roads that functioned as 4-way intersections.

4-way intersections:

Valence of 4 Valence of 6 Valence of 8
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Valence of 16

Likewise, we found that most newly formed intersections with valences of 7 were the result of
3-way intersections of divided and non-divided roads. Similarly, about half of the intersections
with valences of 12 were the result of 3-way intersections of two divided roads. These seemed to
function as 3-way intersections.

3-way intersections:

)
-

Valence of 3 Valence of 7 Valence of 12

There were some intersections with valences of 7 and 12 that did not conform. Specifically, there
were a handful of merged intersections with valences of 7 and 12 that were the formed by the
convergence of the gridded street pattern with a diagonal. In addition, there was one
intersection with a valence of 12 that seemed to function more like a 4-way intersection. Because
there were only three intersections of valence 12 using 10 meter buffers (two 3-way and one 4-
way) and five using 15 meter buffers (two 3-way and three 4-way), we chose to apply our 3-way
and 4-way intersection rules by hand instead of using a blanket rule. The images below were
classed as 4-way.

PN
5 1
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Valence of 7(b) Valence of 12(b) Valence of 12(c)

Finally, there were a number of other new intersection types that were more complex than
either 3-way or 4-way intersections. These were partly an artifact of our trying to deal with
classifying functional 3- and 4- way intersections, through buffering. These are intersections that
show a high level of connectivity which is the point of the 4-way intersection count, so they
were counted as 4 way intersections. Note, the intersection being referred to is outlined with a
dotted oval.

et G

Valence of 5(a) Valence of 5(b) Valence of 9 (shéuld‘really be 13)

Valence of 10(a) Valence of 10(b) Valence of 10(c)

N b e
ol 1

Valence of 11(a) Valence of 11(b) Valence of 13
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Valence of 14

For all our intersection counts, we ran our numbers three times. During the first run, we
counted intersections without any buffers. During the second run, we counted intersections that
were buffered 10 meters and adjusted for valences of 6, 7, 8, 12, and 16 and other adjustments as
detailed above. Finally, in our third run, we counted intersections that were buffered 15 meters
and adjusted for valences of 6, 7, 8, 12, and 16 and other adjustments as detailed above.

5. GIS Approach

Remove Interstates from the road centerline file. Use the Calculate Fnode Tnode script to create
the intersection point file. Remove points with a valence of 1 or 2. Buffer intersections with 10
and 15 meter buffers and create new intersection centroids with reassigned valences. Intersect
point file with measurement geography and calculate ratios of 4-way intersection counts to total
intersection counts.

6. GIS Steps [Note: These need to be adjusted for valences over 4.]
The following procedures were completed using ArcMap (ArcInfo) 8.3.

To follow this protocol you will need:

Site layer (polygon)

Road centerline layer (polyline)

Intersection node layer (point)

Calculate Fnode Tnode ArcScript available from the Downloads section of the ESRI website
XTools extension (also available from the Downloads section of the ESRI website)

O Total intersection counts from protocol for calculating Intersections per Unit Area

S0 eNo o

The basic steps are:
o  Create the Intersections file
o Clip Intersections to Study Sites
o Correct for Interstate/Ramp Intersections
e Remove Unwanted Intersections from View/Table
o  Create Buffered Intersections
o  Assign New Valences to Buffered Intersections
o Summarize 4-way Intersection Counts for each Site
o Calculate 4-way Intersection Ratios for each Site

Create the Intersections file:
1. Using ArcMap, install the Calculate Fnode Tnode script following the instructions included with
the file.
2. Add to your Map Document the road centerline layer.
3. Create a point file (layer) that will eventually contain the output of the intersection node
procedure.
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Run the Calculate Fnode Tnode tool.

When prompted, select your rode centerline layer as your polyline layer and the new point layer
as your point layer.

6. Select 0 as the beginning ID number for the nodes.

7. After the procedure concludes, your point layer will now contain points created from the nodes
of the road centerline layer. The numbers in the “valence” field represent the number of roads
that converge to create the node (e.g., a valence of 1 means the node is a dead end or cul-de-sac; a
valence of 3 indicates a 3-way intersection; etc.).

Tl

Clip Intersections to Study Sites:

Using GeoProcessing Wizard, clip the intersection layer to your study site(s).
In the GeoProcessing Wizard, select Clip one layer based on another

Click on Next

Under Select the input layer to clip, select your intersection layer

Under Select a polygon clip layer, select your study site layer

Give your clipped layer a name and click on Finish

The new clipped layer will open separately.

SUCICIES 2

Correct for Interstate/ Ramp Intersections:

Open the attribute table of the (clipped) intersection layer.

Click on the “Options” button at the bottom of the window and select “Add Field”
Enter the field name “Corrected”.

Hit “OK”

In your view, manually select the intersections formed by the convergence of Interstates and on-
or off-ramps.

6. Return to the attribute table of your intersection layer.

7. Click on the “Show: Selected” button at the bottom of the screen.

8

9
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Right click on the field name you just created (“Corrected”).
. Select “Calculate Values”.
10. Assign these records a value of “1”.
11. Click on the “Show: All” button at the bottom of the screen.
12. Click on the “Options” button at the bottom of the screen and select “Clear Selection”. Close the
attribute table.

Remove Unwanted Intersections from View /Table:

1. Add the intersection layer to your Map Document.

Right click on the intersection layer and select “Properties”.

3. Click the tab that says “Definition Query”.

4. Click the button that says “Query Builder”.

5. Under “Fields” double-click on the field “Corrected”.

6. Click or type “=". Under “Unique Values:” double-click on “0”.

7. Click or type “AND”.

8. Under “Fields” double-click on “valence”.

9. Click or type “>". Under “Unique Values:” double-click on “2”.

10. Hit “OK”. The Query Builder window will close.

11. Hit “OK”. The Layer Properties window will close.

12. Now, only those intersections NOT formed by the convergence of Interstates and on- or off-
ramps AND created by the intersection of 3 or more road segments (no cul-de-sacs) will be
displayed. To display all intersections again, repeat steps 1-10 but remove the existing equation
in the “Query Builder”.

Create Buffered Intersections:
1. Under the Tools dropdown menu, select “Buffer wizard”.
2. In the Buffer Wizard window, under “The features of a layer” select your (clipped) intersection
layer and click on Next
3. Click “At a specified distance” and enter XX (your desired distance)
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After “Distance units are:” select meters

Click Next

After “Dissolve barriers between” select Yes

Give the layer a name and save as a new layer

Click Finish

Using XTools, select “Feature Conversions” and then “Shapes to Centroids”.

. Select the new buffer layer (polygon)
. Give the point layer you are about to create a name and click OK
. The new layer will contain points that represent merged intersections — those resulting from two

intersections that are within 2(XX) meters of each other (a XX meter radius around each
intersection) and essentially functioning as one intersection for the purposes of this analysis.

Assign New Valences to Buffered Intersections:

1. Perform a Spatial Join on your new buffer layer
a. Right click on your new layer and select Joins and Relates and then Join...
b. Under “What do you want to join to this layer?” select Join data from another layer based on
spatial location
c.  Under “1. Choose the layer to join to this layer” select your clipped intersection layer
(point)
d. Under “2. You are joining:” select the first option Each polygon will be given a summary...
e. Under “How do you want the attributes to be summarized?” check the box for Sum
f.  Under “3. The result of the join will be saved...” give your new layer a name
g. Click on OK
2. Open the attribute table of your new layer and remove all fields except Count_ and Sum_valenc
(TIP: use XTools for multiple-field deletes)
3. Perform a Spatial Join on your centroid layer (created in the previous step)
a. Right click on your centroid layer and select Joins and Relates and then Join...
b. Under “What do you want to join to this layer?” select Join data from another layer based on
spatial location
c.  Under “1. Choose the layer to join to this layer” select your newly joined buffer layer
d. Under “2. You are joining:” select the first option it fall inside
e. Under “3. The result of the join will be saved...” give your new layer a name
f. Click on OK
4. Open the attribute table of your new layer and remove all fields except Count_ and Sum_valenc.
5. Click on the “Options” button at the bottom of the screen and select “Add Field...”.
6. Give your field the name “New_valenc” and click on OK.
7. Right click on “New_valenc” and select “Calculate Values...”
8. Double-click on “Sum_valenc” and click on OK. The values from the Sum_valenc field will have
been copied over to the New_valenc field.
9. Click on the “Options” button and select “Select by Attributes”.
10. Set “Count” > 1.
11. Click on “Apply”.
12. Click on the “Show: Selected” button at the bottom of the screen.
13. Click on the “Options” button and select “Select by Attributes” (this window may still be open).
14. After “Method:” select Select from current selection.
15. Set “Sum_valenc” = 6.
16. Right click on “New_valenc” and select “Calculate Values...”.
17. Enter 4 in the box below “New_valenc =" and click on OK.
18. Repeat steps 9 through 17 twice using “Sum_valenc” = 8 and = 16 in step 15.
19. Click on the “Show: All” button at the bottom of the screen.
20. Click on the “Options” button at the bottom of the screen and select “Clear Selection”.
21. Right click on the layer and select “Properties...”
22. Click the tab that says “Definition Query”.
23. Click the button that says “Query Builder”.
24. Under “Fields” double-click on the field “New_valenc”.
25. Click or type “=". Under “Unique Values:” double-click on “4”.
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26. Hit “OK”. The Query Builder window will close.
27. Hit “OK”. The Layer Properties window will close.
28. Now, only those intersections with a valence of 4 (four-way intersections) will be displayed. To

display all intersections again, repeat steps 21-27 but remove the existing equation in the “Query
Builder”.

Summarize 4-way Intersection Counts for multiple non-overlapping sites:

If the site layer does not have unique IDs or names for each site, create them now.

Using a Spatial Join, assign the IDs from the sites to each intersection.

Open the attribute table of the intersection layer and select the field that contains the IDs.
Right-click on the field name and select Summarize.

Select or create an output file name and hit OK.

The output .dbf file will contain the counts of intersection nodes in each site.

N @ = o [ 1=

Summarize 4-way Intersection Counts for multiple overlapping sites:

If the site layer does not have unique IDs or names for each site, create them now.
Using your site polygon layer, select (highlight) the first study site.

Perform a “Select By Location”.

Under “I want to:” choose select features from

Under “the following layers:” choose your intersection node layer

Under “that:” choose have their center in

Under “the features in this layer:” choose your site polygon layer

Make sure the box for “Use selected features” is checked

Hit “Apply”

Open the attribute table of the intersection node layer.

Text at the bottom of the window should show you how many intersections are selected. This is
the number of intersections in the study site you currently have selected.

Record this number elsewhere (in a spreadsheet or Word file).

. Repeat steps 2-6 for each study site.
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Calculate 4-way Intersection Ratios for each Site
1. Inaspreadsheet program such as Excel, open the file containing the summary of total
intersection counts for each site created in protocol for Intersections per Unit Area.
2. Open the file containing the summary of 4-way intersection counts for each site.
3. Divide the numbers of 4-way intersections by the total numbers of intersections to get the 4-way
intersection ratios for each site.

6.8 4-way Intersections per Unit Land Area

1. Basic Concept

Four-way intersections are an indicator of grid street patterns, thought to be supportive for
walking. The measure of 4-way intersections per hectare adjusts this measure to reflect different
block sizes.

2. Basic Formula
4-way Intersections per Unit Land Area = Number of 4-way intersections per unit land area.

3. Detailed Formula

4-way Intersections per Unit Land Area = Number of 4-way intersections per unit land area
excluding water where 4-way intersections are defined as defined in the comments and
explanations.

4. Comments and Explanations

ENVIRONMENT AND PHYSICAL ACTIVITY: GIS PROTOCOLS VERSION 2.3, August 2005, WORK IN PROGRESS 151
University of Minnesota, Twin Cities Walking Study, Metropolitan Design Center



For a discussion of what we counted as 4-way intersections see the previous protocol on the
Ratio of 4-way Intersections to all Intersections.

5. GIS Approach

For each study site, the 4-way intersection counts were matched to the net land area through the
site ID numbers. The intersection counts were divided by the net hectares to get the number of
4-way intersections per hectares for each study site.

6. GIS Steps
The following procedures were completed using ArcMap (ArcInfo) 8.3.

To follow this protocol you will need:
1. 4-way intersection counts from protocol for calculating Ratio of 4-way Intersections to all
Intersections
2. The protocol for determining Net Land Area (without water)

The basic steps are:
o  Determine Net Land Area (without water) for each Site
e  Calculate 4-way Intersections per Hectare for each Site

Determine Net Land Area (without water) for each Site:
1. Follow the steps outlined in the protocol above.

Calculate 4-Way Intersections per Hectare for each Site:
1. In Excel or other spreadsheet program, combine the 4-way intersection counts and your net land
area figures based on the site ID numbers.
2. For each site, divide the number of 4-way intersections by net hectares to get the number of 4-
way intersections per hectares.

6.9 Ratio of 3-way Intersections to All Intersections

1. Basic Concept
This is another take on the issue of street connections.

2. Basic Formula
Ratio of 3-way Intersections to All Intersections = Raw percent of 3-way intersections versus
other intersections (valence 3+).

3. Detailed Formula

Same as above except to note that some higher valence intersections were reclassified as 3-way
if that is how they operated i.e. some valences of 7 and of 12. Buffering was at both 10 and 15
meters.

4. Comments and Explanations

As outlined in Intersections per Unit Area, intersection counts in our study sites (1) did not
include intersections formed by the convergence of Interstates and on- or off-ramps and (2)
corrected for mis-aligned intersections by creating buffers around each intersection node,
merging them where they overlapped, and creating a centroid for each new intersection

polygon.
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In order to be able to classify these new nodes, we created “rules” to assign types (3-way, 4-
way) to the intersections. And are described above in the protocol on the Ratio of 4-way
Intersections to all Intersections.

For our intersection ratios, we ran our numbers three times. During the first run, we counted
intersections without any buffers. During the second run, we counted buffered intersections,
but did not adjust for new valence figures (therefore, a valence of 7 resulting from the
intersection of roads with valences of 3 and 4 would remain a valence of 7). Finally, in our third
run, we included some valences of both 7 and of 12 in our count of 3-way intersections.

5. GIS Approach

Remove Interstates from the road centerline file. Use the Calculate Fnode Tnode script to create
the intersection point file. Remove points with a valence of 1 or 2. Buffer intersections with 10
and 15 meter buffers and create new intersection centroids with reassigned valences. Intersect
point file with measurement geography and calculate ratios of 3-way intersection counts to total
intersection counts.

6. GIS Steps [Also check this for manual corrections to valence=7 and =12]
The following procedures were completed using ArcMap (ArcInfo) 8.3.

To follow this protocol you will need:
1. Site layer (polygon)
Road centerline layer (polyline)
Intersection node layer (point)
Calculate Fnode Tnode ArcScript available from the Downloads section of the ESRI website
XTools extension (also available from the Downloads section of the ESRI website)
Total intersection counts from protocol for calculating Intersections per Unit Area

SNOINESCORD

The basic steps are:
o Create the Intersections file
o Clip Intersections to Study Sites
o Correct for Interstate/Ramp Intersections
e Remove Unwanted Intersections from View/Table
o Create Buffered Intersections
o Assign New Valences to Buffered Intersections
o Summarize 3-way Intersection Counts for each Site
o  Calculate 3-way Intersection Ratios for each Site

Create the Intersections file:

1. Using ArcMap, install the Calculate Fnode Tnode script following the instructions included with
the file.

2. Add to your Map Document the road centerline layer.

3. Create a point file (layer) that will eventually contain the output of the intersection node
procedure.

4. Run the Calculate Fnode Tnode tool.

5. When prompted, select your rode centerline layer as your polyline layer and the new point layer
as your point layer.

6. Select 0 as the beginning ID number for the nodes.

7. After the procedure concludes, your point layer will now contain points created from the nodes
of the road centerline layer. The numbers in the “valence” field represent the number of roads
that converge to create the node (e.g., a valence of 1 means the node is a dead end or cul-de-sac; a
valence of 3 indicates a 3-way intersection; etc.).
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Clip Intersections to Study Sites:

Using GeoProcessing Wizard, clip the intersection layer to your study site(s).
In the GeoProcessing Wizard, select Clip one layer based on another

Click on Next

Under Select the input layer to clip, select your intersection layer

Under Select a polygon clip layer, select your study site layer

Give your clipped layer a name and click on Finish

The new clipped layer will open separately.

S ISARCIRE=RCRI DN

Correct for Interstate/ Ramp Intersections:
1. Open the attribute table of the (clipped) intersection layer.

Click on the “Options” button at the bottom of the window and select “Add Field”

Enter the field name “Corrected”.

Hit “OK”

In your view, manually select the intersections formed by the convergence of Interstates and on-

or off-ramps.

6. Return to the attribute table of your intersection layer.

7. Click on the “Show: Selected” button at the bottom of the screen.

8. Right click on the field name you just created (“Corrected”).

9. Select “Calculate Values”.

10. Assign these records a value of “1”.

11. Click on the “Show: All” button at the bottom of the screen.

12. Click on the “Options” button at the bottom of the screen and select “Clear Selection”. Close the
attribute table.

CINESCONS

Remove Unwanted Intersections from View /Table:

1. Add the intersection layer to your Map Document.

Right click on the intersection layer and select “Properties”.

3. Click the tab that says “Definition Query”.

4. Click the button that says “Query Builder”.

5. Under “Fields” double-click on the field “Corrected”.

6. Click or type “=". Under “Unique Values:” double-click on “0”.

7. Click or type “AND”.

8. Under “Fields” double-click on “valence”.

9. Click or type “>". Under “Unique Values:” double-click on “2”.

10. Hit “OK”. The Query Builder window will close.

11. Hit “OK”. The Layer Properties window will close.

12. Now, only those intersections NOT formed by the convergence of Interstates and on- or off-
ramps AND created by the intersection of 3 or more road segments (no cul-de-sacs) will be
displayed. To display all intersections again, repeat steps 1-10 but remove the existing equation
in the “Query Builder”.

Create Buffered Intersections:
1. Under the Tools dropdown menu, select “Buffer wizard”.
2. In the Buffer Wizard window, under “The features of a layer” select your (clipped) intersection
layer and click on Next
Click “At a specified distance” and enter XX (your desired distance)
After “Distance units are:” select meters
Click Next
After “Dissolve barriers between” select Yes
Give the layer a name and save as a new layer
Click Finish
Using XTools, select “Feature Conversions” and then “Shapes to Centroids”.
Select the new bulffer layer (polygon)
Give the point layer you are about to create a name and click OK
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12.

The new layer will contain points that represent merged intersections — those resulting from two
intersections that are within 2(XX) meters of each other (a XX meter radius around each
intersection) and essentially functioning as one intersection for the purposes of this analysis.

Assign New Valences to Buffered Intersections:

1.

2 SOOI

28.

Perform a Spatial Join on your new buffer layer

a. Right click on your new layer and select Joins and Relates and then Join...

b. Under “What do you want to join to this layer?” select Join data from another layer based on

spatial location

c.  Under “1. Choose the layer to join to this layer” select your clipped intersection layer
(point)
Under “2. You are joining:” select the first option Each polygon will be given a summary...
Under “How do you want the attributes to be summarized?” check the box for Sum
Under “3. The result of the join will be saved...” give your new layer a name
. Click on OK
Open the attribute table of your new layer and remove all fields except Count_ and Sum_valenc
(TIP: use XTools for multiple-field deletes)
Perform a Spatial Join on your centroid layer (created in the previous step)

a. Right click on your centroid layer and select Joins and Relates and then Join...

b. Under “What do you want to join to this layer?” select Join data from another layer based on

spatial location

c.  Under “1. Choose the layer to join to this layer” select your newly joined buffer layer

d. Under “2. You are joining:” select the first option it fall inside

e. Under “3. The result of the join will be saved...” give your new layer a name

f. Click on OK
Open the attribute table of your new layer and remove all fields except Count_ and Sum_valenc.
Click on the “Options” button at the bottom of the screen and select “Add Field...”.
Give your field the name “New_valenc” and click on OK.
Right click on “New_valenc” and select “Calculate Values...”
Double-click on “Sum_valenc” and click on OK. The values from the Sum_valenc field will have
been copied over to the New_valenc field.
Click on the “Options” button and select “Select by Attributes”.

w e A

. Set “Count” > 1.
11.
12.
13.
14.
15.
16.
17.
18.
19.
. Click on the “Options” button at the bottom of the screen and select “Clear Selection”.
21.
22.
23.
24.
25.
26.

Click on “Apply”.

Click on the “Show: Selected” button at the bottom of the screen.

Click on the “Options” button and select “Select by Attributes” (this window may still be open).
After “Method:” select Select from current selection.

Set “Sum_valenc” =7.

Right click on “New_valenc” and select “Calculate Values...”.

Enter 3 in the box below “New_valenc =” and click on OK.

Repeat steps 9 through 17 using “Sum_valenc” = 12 in step 15.

Click on the “Show: All” button at the bottom of the screen.

Right click on the layer and select “Properties...”

Click the tab that says “Definition Query”.

Click the button that says “Query Builder”.

Under “Fields” double-click on the field “New_valenc”.

Click or type “=". Under “Unique Values:” double-click on “3”.

Hit “OK”. The Query Builder window will close.

Hit “OK”. The Layer Properties window will close.

Now, only those intersections with a valence of 3 (3-way intersections) will be displayed. To
display all intersections again, repeat steps 21-27 but remove the existing equation in the “Query
Builder”.

Summarize 3-way Intersection Counts for multiple non-overlapping Sites:

1.

If the site layer does not have unique IDs or names for each site, create them now.
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Using a Spatial Join, assign the IDs from the sites to each intersection.

Open the attribute table of the intersection layer and select the field that contains the IDs.
Right-click on the field name and select Summarize.

Select or create an output file name and hit OK.

The output .dbf file will contain the counts of intersection nodes in each site.
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Summarize 3-way Intersection Counts for multiple overlapping Sites:

If the site layer does not have unique IDs or names for each site, create them now.
Using your site polygon layer, select (highlight) the first study site.

Perform a “Select By Location”.

Under “I want to:” choose select features from

Under “the following layers:” choose your intersection node layer

Under “that:” choose have their center in

Under “the features in this layer:” choose your site polygon layer

Make sure the box for “Use selected features” is checked

Hit “Apply”

Open the attribute table of the intersection node layer.

Text at the bottom of the window should show you how many intersections are selected. This is
the number of intersections in the study site you currently have selected.

Record this number elsewhere (in a spreadsheet or Word file).

. Repeat steps 2-6 for each study site.
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Calculate 3-way Intersection Ratios for each Site
1. In a spreadsheet program such as Excel, open the file containing the summary of total
intersection counts for each site created in protocol for Intersections per Unit Area.
2. Open the file containing the summary of 3-way intersection counts for each site.
3. Divide the numbers of 3-way intersections by the total numbers of intersections to get the 3-way
intersection ratios for each site.

6.10 Connected Node Ratio

1. Basic Concept

This is a measure of the street pattern and is a ratio of the number of intersections (presumably
valence 3 or more) divided by the number of intersections plus culs-de sac (with culs de sac
valence 1) (Song and Knaap 2004, 214; Dill 2003, 3). A value close to one means that there are
few culs-de-sac and therefore the street pattern is more highly connected.

Of course there could be a perfect grid with enormous blocks that were hard to get around and
such a pattern would fare well on this measure so it is not a perfect indicator

2. Basic Formula

Connected Node Ratio = Number of street intersections divided by number of intersections plus
culs-de-sac (Dill 2003, 3)

3. Detailed Formula
Connected Node Ratio = Number of street intersections (valence 3 or more) divided by the
number of intersections plus culs-de-sac (valence 1) (Dill 2003, 3)

4. Comments and Explanations
A connected node ratio is the ratio of total intersections to intersections plus cul-de-sacs in a
given study site. The maximum value of a connected node ratio is 1.00, indicated that there are
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no cul-de-sacs within the study site. Dill (2003, 3) reports that ratios of 0.70 are preferred by
those promoting highly connected street patterns.

For our analysis, we calculated connected node ratios with the intersections created between
Interstates and on- and off-ramps removed. Given the coarse nature of the measure and the fact
that the main distinction is between valence 1, valence 2 (omitted), and all other valences there
is not much difference between using buffered or unbuffered intersections. However we
calculated all three types--non-buffered, 10m buffer, and 15m buffer--to be consistent with our
other intersection counts.

5. GIS Approach

From the intersection node layer, all cul-de-sacs were selected (valence of 1) and a new cul-de-
sac layer created. For each study site, the number of cul-de-sacs and the number of total
intersections were summarized and the ratio of intersections to intersections plus cul-de-sacs
was calculated.

6. GIS Steps
The following procedures were completed using ArcMap (ArcInfo) 8.3.

To follow this protocol you will need:
1. Site layer (polygon)
2. Intersection node layer (point)
3. Total intersection counts from protocol for calculating Intersections per Unit Area (these have been
buffered)

The basic steps are:
e  Create Cul-de-sac Layer
o  Summarize Cul-de-sac Counts for each Site
o Calculate Connected Node Ratios for each Site

Create Cul-de-sac Layer:
1. Right click on your intersection layer and select “Properties”.

a. Click the tab that says “Definition Query”.

b. Click the button that says “Query Builder”.

c. Under “Fields” double-click on “valence”.

d. Click or type “=". Under “Unique Values:” double-click on “1”.

e. Hit “OK”. The Query Builder window will close.

f.  Hit “OK”. The Layer Properties window will close.

g. Now, only those intersections created by 1 road segment (cul-de-sacs) will be displayed.
2. Right click on your 1ntersect10n layer and select “Data”.

Select “Export Data...

In the “Export Data” window:

Under “Export:” select All features

Check Use the same Coordinate System as this layer’s source data

Create a name for your new cul-de-sac layer and hit OK

The new cul-de-sac layer will open separately.

t click on your intersection layer and select “Properties”.

Click on the tab that says “Definition Query”.

Click on the button that says “Query Builder”.

Your previous entry of “valence = 1” should still be shown. Change “=1" to “>2".
Hit “OK”. The Query Builder window will close.

Hit “OK”. The Layer Properties window will close.

Now, the intersection layer will once again only show intersections that are created by 3
or more road segments.

moap o

-

3. Rig

moap o
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Summarize Cul-de-sac Counts for multiple non-overlapping Sites:
1. Using a Spatial Join, assign the IDs from the sites to each cul-de-sac point.
2. Open the attribute table of the cul-de-sac layer and select the field that contains the IDs.
3. Right-click on the field name and select Summarize.
4. Select or create and output file name and hit OK.
5. The output .dbf file will contain the total number of cul-de-sacs in each site.

Summarize Cul-de-sac Counts for multiple overlapping Sites:
1. Using your site polygon layer, select (highlight) the first study site.
2. Perform a “Select By Location”.
Under “I want to:” choose select features from
Under “the following layers:” choose your cul-de-sac layer
Under “that:” choose have their center in
Under “the features in this layer:” choose your site polygon layer
Make sure the box for “Use selected features” is checked
f. Hit“Apply”
3. Open the attribute table of the cul-de-sac layer.
4. Text at the bottom of the window should show you the number of cul-de-sacs in the study site
you currently have selected.
5. Record this number in the spreadsheet.
6. Repeat steps 1-5 for each site.

pon T

Calculate Connected Note Ratios for each Site:
1. In aspreadsheet program such as Excel, open the file containing the summary of total intersection
counts for each site created in protocol for Intersections per Unit Area.
2. Open the file containing the counts of cul-de-sacs in each site.
3. Add the total intersection counts to the counts of cul-de-sacs in each site.
4. Divide the [number of intersections] by the [number of intersections plus cul-de-sacs] (from step
3) to get the connected node ratio for each site.

6.11 Median Perimeter of Block

1. Basic Concept
This is a measure of the road length per block, and captures the issue of curvilinear street
patterns that might have smaller block areas but circuitous routes.

Future drafts of these protocols will examine how other researchers have used this measure
(Song 2003).

2. Basic Formula
Median Census Block Perimeter = Median perimeter for census blocks with a centroid falling
within the measurement geography.

3. Detailed Formula
Same as above.

4. Comments and Explanations
None.

5. GIS Approach
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The GIS approach is to select all census blocks that have their centers in the measurement
geography. Next, use XTools to calculate the perimeter of the identified census blocks. Perform
a spatial intersect between the identified census blocks and the measurement geography.
Import the Attribute Table of the resulting layer into Microsoft Access and analyze it using the
PivotTable feature. Finally, copy the desired data out to an Excel spreadsheet and calculate the
median perimeter.

6. GIS Steps
The following procedures were completed using ArcMap (ArcInfo) 8.3.

To complete this protocol you will need:

Site layer (polygon)

Census block layer (polygon)

XTools extension (available from the Downloads section of the ESRI website)
Microsoft Access

Microsoft Excel

QIR SCONDRES

The basic steps are:
o  Calculate Census Block Perimeters
o  Create Centroid Layer
e  Select Census Blocks
o Intersect Census Blocks and Study Sites
e Manipulate output in Access and export to Excel spreadsheet
o  Calculate Median Census Block Perimeters for each Site

Calculate Census Block Areas:
1. From the XTools menu, select “Table Operations” and then “Calculate Area, Perimeter, Length,
Acres, and Hectares” (follow instructions included with the extension for XTools installation).
a. Under “Select layer to measure”, select your new census block layer
b. Under “Desired output units”, choose your units (depending on the census block size, try
Miles, Meters, or Feet, for example)
c.  Uncheck all boxes except Perimeter
d. Hit “OK”
2. Anew field called “Perimeter” will be created in the attribute table of your new census block
layer with the perimeter of each polygon calculated in the units you chose.

Create Centroid Layer:
1. From the XTools drop-down menu, select “Feature Conversions” and choose “Shapes to
Centroids”.
2. Under “Select the layer you wish to convert:” select your census block layer.
3. Give the layer a name and click on “OK”.
4. The new layer will be added to your map document.

Select Census Blocks:

1. Add the census block centroid layer and the study site layer to your Map Document.
From the “Selection” drop-down menu, choose “Select by Location...”.

3. Under “I want to:” choose “select features from”.

4. Under “the following layers:” select your centroid layer.

5. Under “that” choose “have their center in”.

6. Under “the features in this layer:” select your study site layer.

7. Hit “Apply”. Now the centroids that fall inside your study sites will be selected.

8. From the “Selection” drop-down menu, choose “Select by Location...”.

9. Under “I want to:” choose “select features from”.

10. Under “the following layers:” select your census block centroid layer.
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11.
12.
13.
14.
15.
16.
17.
18.

Under “that” choose “are completely within”.

Under “the features in this layer:” select your study site layer.

Hit “Apply”. Now the census blocks centroids that are inside the study sites will be selected.
Right click on your census block centroid layer and select “Data” and then “Export Data...”
After “Export:” choose selected features.

Choose “Use the same Coordinate System as this layer’s source data.

Give the new layer a name and click on OK.

When prompted, add the new layer to the Map Document.

Open the GeoProcessing Wizard.

1.

A O s ES,

Choose Intersect two layers and click Next

Select the exported subset of census block centroids from the previous step as the input layer
Select your study site layer as the overlay layer

Choose a name and location for the output layer

Click Finish

The new layer will be added to the Map Document

Import data into Microsoft Access

1.
2.

CORNONCINERCS

5

Open the Attribute Table of the layer created in the previous intersect step

Choose “Export” and select a location and name for the output DBF. NOTE: make the filename 8
characters or less so it can be imported into an Access database.

Open Microsoft Access and create a new blank database.

Go to File....Get External Data....Import

Find the DBF table you exported from ArcMap above and import it

Open the newly imported table

From the View menu, select PivotTable View

In the Field List window, select the name of the unique study site ID and drag it onto the large
window where it says “Drop Column Fields Here”

From the Field List, drag the field containing the Perimeter onto the large window where it says
“Drop Totals or Detail Fields Here”

Copy data into Microsoft Excel and calculate median

5

Open a new blank Microsoft Excel spreadsheet

In Access, click and drag the column headings to select them, and then do CTRL-C to copy them
Switch to Excel and do CTRL-V to paste them (NOTE: if you have more than 255 study site IDs,
you will need to paste into multiple worksheet tabs, as Excel worksheets are limited to 255
columns)

Find the row beneath the last row to contain any values (each column will have a different
number of values depending on how many census block centroids were found in each
measurement geography)

Calculate the median of all the cells above containing perimeter values

The following variables are not proposed to be used in the study, so only a
brief description and detailed formula are included.

6.12 Link-Node Ratio

This is the ratio of segments to nodes (intersections or the ends of culs-de-sac i.e. valences apart
form 2). A perfect gird has a ratio of 2.5 (Dill 2003, 4). Given the character of the data in the
Twin Cities Walking Study, this was very complicated to calculate.
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Link-Node Ratio = Number of segments divided by the number of nodes in a measurement
geography where a node is an intersection or an end of a cul-de-sac (i.e. valence 1 or 3 and
above).
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CHAPTER 7. OTHER BUILT ENVIRONMENT
RELATED/SPATIAL VARIABLES

Initial outline by Ann Forsyth

Overview

The initial part of this manual focused on measuring the built environment, with a focus on
residential areas. This chapter expands those measurements to the work environment (although
most of the measures are virtually identical) and to other related topics such as crime, climate
and air quality, and traffic.

This section will be expanded in subsequent versions.

Work Environments

Work environments have tended to be less studied than residential ones. This has been for
theoretical reasons—everyone has a home environment but not all have a work one; the
residential environment is an important environment in the parts of one’s day with
discretionary time. It is also for practical reasons—it is easy to get census data about where
people reside but not where they work.

In the Twin Cities Walking Study we collected survey data including work addresses. However,
it should be noted that not everyone goes to (paid) work. Many people are retired,
homemakers, or unemployed. Others are at colleges or universities that they do not class as
work. Still others work part time or in multiple locations. Overall, studying the work
environment is a complex matter.

Subsequent versions of this manual will outline the specific measurements we make of the work
environment.

Crime

Crime affects where, when, and how much people walk. However, there are good theoretical
reasons to consider that perceptions of crime are more important than the reality of crime. The
Twin Cities Walking Study asked participants to respond to a number of statements about
crime, taken from the Neighborhood Quality of Life Survey (NQLS):

1. My neighborhood streets are well lit at night.

2. Walkers and bikers on the streets in my neighborhood can be easily seen by people in
their homes.

3. I'see and speak to other people when I am walking in my neighborhood.

4. There is a high crime rate in my neighborhood.

5. The crime rate in my neighborhood makes it unsafe to go on walks during the day.
6. The crime rate in my neighborhood makes it unsafe to go on walks at night.

As local crime statistics were very unevenly available in the study area, we used these
perception variables.

ENVIRONMENT AND PHYSICAL ACTIVITY: GIS PROTOCOLS VERSION 2.3, August 2005, WORK IN PROGRESS 162
University of Minnesota, Twin Cities Walking Study, Metropolitan Design Center



Climate and Air Quality

Climate and air quality both vary with a region and have some differences within a region. The
Twin Cities Walking Study only measured individuals in the warmer months of April to
November.

Climate data are available from central sources and we will use these data in our analyses.
Air quality is very complex to measure and the variation is not very different in the Twin Cities.

Traffic
Traffic affects where, when, and how much people walk. The Twin Cities Walking Study asked
a number of questions about perceptions of traffic:

1. There is so much traffic along the street I live on that it makes it difficult or
unpleasant to walk in my neighborhood.

2. There is so much traffic along nearby streets that it makes it difficult or unpleasant to
walk in my neighborhood.

3. The speed of traffic on the street I live on is usually slow (30 mph or less).

4. The speed of traffic on most nearby streets is usually slow (30 mph or less).

5. Most drivers exceed the posted speed limits while driving in my neighborhood.

6. There are crosswalks and pedestrian signals to help walkers cross busy streets in my
neighborhood.

7. The crosswalks in my neighborhood help walkers feel safe crossing busy streets.

8. When walking in my neighborhood there are a lot of exhaust fumes (such as from
cars, buses).

While significant data are available for traffic, each has a number of problems of coverage or
relevance. We investigated the following potential measures:

e Traffic counts. These were only available for major roads which were spaced quite
widely. Many of the smaller measurement geographies did not overlap with any of
these roads.

e DPosted traffic speed. This was available for all roads in the study area, however, there
was a huge range of roads with a posted speed of 30 miles per hour including some of
the most and least busy. As a measurement it did not seem useful.

¢ Functional classification. This was available for all roads in the study area. It more
accurately reflects the “busy-ness” of major streets.

7.1 Proportion of High Functional Classifications

1. Basic Concept
Functional classifications of roads divides roads into a hierarchy. In the Metropolitan Council’s
dataset prepared by The Lawrence Group the classifications are modified versions of the US
Census Bureau’s classification in TIGER Line Files including many subclasses of the following
road types (U.S. Census 2005, 3-28).

*  Primary Highway With Limited Access—mostly interstates

* Primary Road Without Limited Access—mostly US and state highways
» Secondary and Connecting Road—mostly state and some county highways
* Local, Neighborhood, and Rural Road
* Vehicular Trails
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This measure assesses the ratio of higher road classes to local and neighborhood roads. It would
also be possible to examine the density of higher classifications.

2. Basic Formula
Proportion of High Functional Classifications = Proportion of primary, secondary, and
connecting roads to all roads.

3. Detailed Formula
Proportion of High Functional Classifications = Proportion of primary, secondary, and
connecting roads to all roads excluding vehicular trails, and gated roads.

4. Comments and Explanations
We currently plan to convert the following local road classifications to classifications of high
functional classes:

A10 213 Primary highway with limited access
A20 122 Primary road without limited access
A25 388 Primary road without limited access
Primary road without limited access, US highways, separated
A30 2144 Secondary and connecting road
A63 348 Road with special characteristics
Access ramp, the portion of a road that forms a cloverleaf or limited access interchange
A64 34 Road with special characteristics

Service drive, the road or portion of a road that provides access to businesses, facilities,
and rest areas along a limited-access highway

Other roads:

A40 13651  Local, neighborhood, and rural road

A71 47 Road as other thoroughfare
Walkway or trail for pedestrians, usually unnamed

A73 3 Road as other thoroughfare
Alley, road for service vehicles, usually unnamed, located at the rear of buildings and
property

Excluded:

A66 114 Road with special characteristics
Gated barrier to travel

A98 5 * not listed *

This is the University's bus transitway which has bike but not pedestrian access.

5. GIS Approach
[To come]

6. GIS Steps
[To come.]
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CHAPTER 8. DATA STORAGE AND SHARING

By Jason Zimmerman, Joel Koepp, and Ann Forsyth

Note: This was new in version 2.2.

Steps/problems with obtaining our data

MetroGIS data server

In the Twin Cities, MetroGIS — an organization that coordinates data sharing among a number
of local governments — maintains a data server that allows access to a number of metro-wide
data sets free of charge (municipal boundaries, water bodies, and land use data sets are among
those provided). These data have been aligned and cleaned as much as possible to provide
consistency across municipalities. Much of our base data was obtained from the DataFinder
web site (http:/ /www.datafinder.org).

User license agreements (Regional parcels)

In order to access the regional parcel data set (an item on the MetroGIS DataFinder), it was
necessary to enter a separate license agreement. At the time the data was requested, this
involved two license agreements — one that covered six of the seven metro counties and another
that covered the seventh. This second agreement proved to be a much harder agreement to
reach, and involved exchanges of agreement language between University attorneys and
attorneys for the county. By the time this hurdle was completed, however, a new wrinkle
emerged. At the end of the approaching calendar year the contract for data sharing between
MetroGIS and the seven counties expired and was in the process of being renegotiated. This
ended up taking many months to finalize, greatly extending the time before we were able to
finally obtain access to the regional parcel data set.

Luckily, while all of this was going on, we were able to rely on our previous relationships with
two of the counties to use their parcel data free of charge. We did, however, need to purchase
small areas of parcel data from two additional counties where the largest buffers of our study
area spilled over across county boundaries.

[-35W Coalition agreement/Access to Ramsey County/St. Paul data

A memorandum of understanding with the I-35W Coalition (a coalition of seven cities within
two counties) allowed us to access a large amount of high-quality data for free (a significant
lump sum was paid to the Coalition to cover time for the GIS Coordinator to assist with data
problems, but there was no charge to access the data itself).

This arrangement had additional benefits when we begin to look for data outside the
boundaries of the Coalition. The Coalition’s membership in the Ramsey County Users Group
allowed us to access data for the whole of Ramsey County — not just for the Ramsey portion of
the Coalition cities. However, it would have been possible just to join the Ramsey County Users
Group and in the end this would likely have been less expensive. This highlights some of the
challenges in deciding which of many complex arrangements one must decide on in accessing
data.

Data for the City of St. Paul (which lies within Ramsey County but is not a member of the
Coalition) was also easier to obtain because of this relationship although we spent some time in
negotiations.
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Problems that arose in obtaining data from the City of St. Paul were mostly due to the dispersed
nature of the data. Data for street trees needed to be obtained directly from the Parks
Department. Data for sidewalks and street lights needed to be obtained from Public Works.
Difficulty in coordinating messages, confirming approvals, and exchanging data was the
biggest obstacle in obtaining information from St. Paul.

Storing/Sharing data

Central server

GIS data, documentation, and tracking spreadsheets are all stored on a single file server. With a
small project team issues of file locking are infrequent and easily handled. All data are backed
up to a separate dedicated server on an incremental basis nightly, with a fresh full backup
occurring once a week.

Working files kept locally

Many measurements require several large processing operations on data before it is ready for
final calculations. To aid the efficiency of computationally intensive GIS tasks, working data
files are kept on local machines rather than on a network. For example, in the process of
calculating median block size for 1600m straight line buffers of the 715 participants with good
addresses, one of the files generated contained over 2.5 million features and consumed nearly a
gigabyte of disk space. This intermediate file then had to be broken into smaller pieces so
ArcGIS would be able to process them. Even working off local hard drives these processes are
intensive, and it would take much longer even on the fastest of local networks if the files were
saved on a server due to network latency.

“Final” files on server

Important base data and final versions of modified files are stored on a central file server for
access by multiple users. Rather than storing shapefiles and dealing with the resulting clutter of
having dozens of layers in separate folders, we used the geodatabase storage format, introduced
to ArcGIS in version 8. The geodatabase can store multiple layers and tables together in one
large file (which is actually a modified Microsoft Access database). We created several
geodatabases named by topic, e.g. Street Features, Density, Buffers, etc. Among the benefits of
using the geodatabase format is that line and polygon features automatically have their length
and area fields recalculated when modified. It is important to note that the file size of a
geodatabase cannot exceed 2 GB, so when working with very large datasets, multiple
geodatabases may be needed.

Issues with multiple users

While the geodatabase is convenient for data storage, one limitation is that the basic ArcGIS or
ArcINFO install does not support some of the advanced features of the format. With an
installation of the ESRI product ArcSDE (designed for file servers that share and manage GIS
data), it is possible for multiple users to edit a geodatabase layer simultaneously. The other
capability afforded by ArcSDE is versioning, which would help keep track of changes made to a
layer throughout the stages of geoprocessing performed on base data.

Our college did not have a license for ArcSDE.
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Tracking changes/updates
Work was tracked in a number of ways:

Shapefile tracking sheet

This Excel spreadsheet is to keep track of which layers get put in the geodatabases on the
central server. There are fields for the name of the layer, the geodatabase in which it is found,
the date created, the date last modified, the features in the layer, and miscellaneous notes. It is
updated each time a layer is added or replaced. This is a way of avoiding having to purchase
ArcSDE.

Decision logs

Logs are kept by both GIS Research Fellows throughout the study. These documents, updated
at least weekly, record key decisions that were made regarding GIS, conversations that were
held, and tasks that were performed. These logs carry out two functions: they allow the
Principal Investigator to be kept in the loop and they act as a record of GIS-related information
over time that can be reviewed when question arise at a later date.

Updating/tracking measurement results
A master measurement spreadsheet with tabs for each variable stores variables.

Checklist

A checklist of variables was maintained, with numbering from Protocols, required geographies
in columns, and filled in with name and date when completed. A version of this checklist is in
Appendix 1D.

Other issues

Projections

Thé standard coordinate system for MetroGIS datasets is Universal Transverse Mercator (UTM)
North American Datum 1983 (NAD83), Zone 15. Any working or final files created from
MetroGIS data was kept in the same coordinates. Some data layers which came from individual
cities or from Ramsey County—such as street lights, street trees, and sidewalks—came in the
Ramsey-Hennepin coordinate system. Because ArcGIS has the capability to correctly display
data from multiple projections in the same view, these layers remained in Ramsey-Hennepin
coordinates.

Much of the street feature data was hand digitized using high resolution color aerial photos of
Ramsey County. Imagery cannot have coordinate system information attached to it like
shapefiles or geodatabase feature classes, so the data view must be set to the known coordinates
of the imagery. As a result, when the hand digitized features were saved from graphics to a
shapefile, they were saved in Ramsey-Hennepin coordinates.

Converting Measures: Blocks and Minutes to Meters

A number of survey measures asked participants to estimate distances in blocks. We
investigated how long to make the block. Susan Liss from the National Household
Transportation Survey indicated 1/9 of a mile as appropriate. However, other experts including
Kevin Krizek used 1/10 of a mile as a rule of thumb. We estimated the median block length in
the area as closer to 1/10 of a mile or 160 meters and used that measure.
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APPENDICES

Note: If there is a specific author for each section he, she, or it is named at the beginning of the
section. Appendices 1D and 1F are new in version 2.3.

Appendix 1A: I-35W Corridor Coalition Land Use Metadata

North Metro I-35W Corridor Coalition
Land Use Designations

(Definitions Adopted as of 1/15/98)
(Updated 1/19/99)

Following are the Land Use designations, definitions, notes, and samples developed and
adopted by the North Metro I-35W Corridor Coalition.

General Notes:
"Land use designations, unless otherwise specified, refer to the predominant identifiable
land use on a parcel or portion thereof.

*The sample uses listed after each category indicate the types of land uses that fit into
each land use category assuming they meet the criteria outlined in the definition. Some
land uses may fit into more than one category (for example, gas stations may be
categorized as Neighborhood Commercial, Community Commercial, or

Highway /Convenience Commercial depending on there size, location, etc.). Sample
land uses are simply intended to give the user an idea of the typical land uses within
each category. They are not intended to be the only criteria for categorizing land use.

’The land use categories, definitions, and samples outlined below were developed to
serve areas ranging from first-ring suburbs to outer-ring suburbs. These categories and
definitions may not be sufficient for rural or core urban areas.

Agricultural (AG)

Definition:

Land used for agricultural purposes, including farming, dairying, pasturage, horticulture,
floriculture, viticulture, and animal and poultry husbandry and accessory uses; provided that
such accessory uses shall be incidental to the agricultural activities.

Note:
! Agricultural properties with a residential density of less than one unit per twenty acres
may be considered Residential if a majority of the land is not used for agricultural
roduction (Hobby Farms).
Some traditional Agricultural uses may not be considered Agricultural if they conform
more closely with definitions and samples for commercial or industrial land uses.

Samples:

Agricultural land uses would typically include any of the following that meet the previously
defined criteria:

Cash Grain or General Farm

Other Agricultural Use
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Sod Farms

Residential (RES)

Note: This section contains a general definition of residential land use followed by several
subset definitions. It is intended that land uses falling within a subset definition meet the
criteria outlined in the general definitions plus the additional criteria outlined in the subset
definition.

General Definition:

Land containing a building or portion thereof used exclusively for residential purposes,
including one-family, two-family, and multiple-family dwellings, but not including hotels,
motels, and boarding and lodging houses, nursing homes, or elderly care facilities; or open
space within or related to a residential development, not in individually owned lots or
dedicated for public use, but which is designed and intended for the common use or enjoyment
of the residents of the development.*

‘Note: Residential properties with a density of less than one unit per twenty acres may
be designated as Agricultural if a majority of the land is used for agricultural production
(Hobby Farms).

i.) Rural (R)

Definition:

Land meeting the general definition of residential and which is outside the MUSA boundary
containing a residential building with not more than one dwelling unit entirely surrounded by
open space on the same lot.

ii.) Single-Family, Detached (SFD)

Definition:

Land meeting the general definition of residential and containing a residential building with not
more than one dwelling unit entirely surrounded by open space on the same lot.

Single Family Dwelling, Platted Lot

Mobile Home on Real Estate

iii.) Single-Family, Attached (SFA)
Definition:
Land meeting the general definition of residential and containing one or more buildings
containing two or more dwelling units, each of which has primary ground floor access to the
outside and which are attached to each other by party walls without openings.

Two Family Dwelling, Platted Lot

Conversion

Three Family Dwelling, Platted Lot

Double Dwelling

Townhome-Inner

Townhome-Outer

Townhome Non-Tax Outlot
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iv.) Multifamily (MF)

Definition:

Land meeting the general definition of residential and containing one or more buildings
containing three or more dwelling units, one or more of which does not have primary ground
floor access to the outside and which are attached to each other by party walls without
openings.

Apartments, 1-9 Rental Units
Apartments, 10-19 Rental Units
Apartments, 20-49 Rental Units
Apartments, 50 or More Units
Apartment Misc. Improvements
Condominium

Condominium Non-Tax Lot

v.) Manufactured Housing Park (MHP)

Definition:

Land meeting the general definition of residential and under single ownership that has been
planned and improved for the placement of manufactured housing for dwelling purposes.

Trailer or Mobile Home Park

Commercial/Retail

i.) Neighborhood (NC)

Definition:

Land use primarily engaged in the provision of goods or services with a primary service radius
of 1 to 1.5 miles. Neighborhood Commercial/Retail Land Uses would typically be located in a
predominantly residential area and have a Gross Leasable Area (GLA) of approximately 25,000
square feet or less.

Samples:
Neighborhood Commercial/Retail land uses would typically include any of the following that
meet the previously defined criteria:

Small (Under 10,000 sq. ft.) Detached Retail

Neighborhood Shopping Centers

Restaurant, Cafeteria, and /or Bar

Dry Cleaning Plants and Laundries

Automotive Service Station

Barber/Beauty Shops

ii.) Community (CC)

Definition:

Land use principally engaged in the provision of goods or services with a primary service
radius of 3 to 5 miles. Community Commercial/Retail Land Uses would typically be located in
a small commercial/retail center with a Gross Leasable Area (GLA) of approximately 50,000 to
150,000 square feet.

Samples:
Community Commercial/Retail land uses would typically include any of the following that

meet the previously defined criteria:
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Supermarkets

Discount Stores & Jr. Dept. Stores
Community Shopping Center
Other Retail Structures

Funeral Homes

Full Service Banks

Savings & Loans

Auto Car Sales and Services
Bowling Alleys

Restaurant, Cafeteria, and /or Bar
Automotive Service Station
Other Commercial Structures
Car Wash

Day Care Centers

iii.) Regional (RC)

Definition:

Land use principally engaged in the provision of goods or services with a primary service
radius of 10 or more miles. Regional Commercial/Retail Land Uses would typically be located
in or near a large commercial/ retail center with a Gross Leasable Area (GLA) of approximately
350,000 square feet or more.

Samples:

Regional Commercial /Retail land uses would typically include any of the following that meet
the previously defined criteria:
Nurseries
Full Line Department Stores
Regional Shopping Center
Parking Garage Structure & Lots
Parking Ramps
Theaters
Drive-in Theaters
Lodge Halls and Amusement Parks
Marine Service Facilities
Sport/Public Assembly Facility

iv.) Highway/Convenience (HC)

Definition:

Land use principally engaged in the provision of goods or services that primarily services
customers attracted from a nearby major transportation arterial.

Samples:
Highway /Convenience Commercial /Retail land uses would typically include any of the

following that meet the previously defined criteria:
Motels and Tourist Cabins
Hotels
Drive-in Rest/Food Service Facility
Gas Station
Automotive Service Station
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Office (OFC)
Definition:
Land use predominantly involved in administrative, professional, or clerical services.

Samples:
Office land uses would typically include any of the following that meet the previously defined

criteria:
Office Building, 1-2 Stories
Office Building, 3 or More Stories Walkup
Office Building, 3 or More Stories Elevator
Veterinary Clinic
Medical Clinics and Offices

Mixed Use (MU)

Definition:

Land containing a building with significant amounts of residential uses in combination with
commercial and/or office uses.

Notes:
"Land is identified as Mixed Use only if it contains buildings with stacked or multiple
uses in which there is a significant amount of residential use. Properties with only a
small amount of residential use (such as caretakers quarters, etc.) are assigned the
predominant land use.

Samples:
Mixed Use land would typically include any of the following that meet the previously defined
criteria:

Residential apartments over commercial or

office uses

Industrial

i.) Light (LI)

Definition:

Land used primarily in the manufacture, processing, fabrication, assembly, packaging,
incidental storage, sales, and distribution of predominantly previously prepared materials,
finished products or parts. Light Industrial land uses would typically have all processing within
buildings, require limited exterior storage, generate limited amounts of truck or rail traffic, and
be free of hazardous or objectionable elements such as noise, odor, dust smoke, glare, or other
pollutants.

Samples:
Light Industrial land uses would typically include any of the following that meet the previously
defined criteria:

Greenhouses, Vegetables & Floriculture

Food & Drink Process Plants and Storage

Manufacturing & Assembly, Light

Small Shops (Machine, Tool & Die, etc.)

Other Industrial Structures
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Flex Industrial Center
Mini Warehouse
Research and Development Facility

ii.) Heavy (HI)

Definition:

Land used primarily in the manufacture and/or processing of products from large bulky,
predominantly raw, extracted, or hazardous materials; or use engaged in the storage of
flammable, explosive, or other materials that may pose a threat to public health or safety. Heavy
Industrial land uses may require exterior storage of large equipment or material, be engaged in
outside processing or assembly, generate significant amounts of truck and/or rail traffic, or
emit limited amounts of objectionable elements such as noise, odor, dust, smoke, glare, or other
pollutants.

Samples:
Heavy Industrial land uses would typically include any of the following that meet the

previously defined criteria:
Foundries & Heavy Manufacturing Plants
Grain Elevators
Commercial Warehouses
Commercial Truck Terminals

Institutional (IN)

Definition:

Land used for primarily religious, governmental, educational, social or health care facilities
excluding clinics.

“Notes:
' Symbols may be used to differentiate between different types of institutional uses.

Samples:
Institutional land uses would typically include any of the following that meet the previously

defined criteria:
Nursing Homes & Private Hospitals
Exempt Property Owned by USA
Exempt Property Owned by State of MN
Exempt Property Owned by Counties
Firestations
Exempt Property Owned by Municipalities
Sport/Public Assembly Facility
Library
Exempt Property Owned by Board of
Education
Exempt Property Owned by Private Schools
Charitable Exempt Hospital / Nursing Home
Welfare / Charitable Facility
Churches, Etc. Public Worship — Private
Graveyards Monuments, Cemeteries
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Sport/Recreation

i) Indoor (SRI)

Definition

Land containing a building(s) developed, used, and maintained primarily for recreational
activities.

Samples:
Indoor Sport/Recreation land uses would typically include any of the following that meet the
previously defined criteria:

Ice/Hockey Arenas

Indoor Soccer Fields

Domed recreational facilities

Large scale health/fitness clubs

Indoor swimming pools

Sport/public Assembly Facility

ii) Outdoor (SRO)

Definition:

Land used primarily for public recreation activities improved with playing fields, playground
or exercise equipment and associated structures.

Samples:
Outdoor Sport/Recreation land uses would typically include any of the following that meet the
previously defined criteria:

Baseball / Softball fields/stadiums

Soccer/football fields/stadiums

Golf Courses

Golf Driving Ranges
Mini Golf Courses
Playground equipment

Open Space

i.) Passive (OSP)

Definition:

Land used and maintained for resource protection, amenity, or buffer, which supports
unorganized public recreational activities and which may contain trails, picnic areas, public
fishing /boating docks, etc.

Samples:
Passive Open Space uses would typically include any of the following that meet the previously

defined criteria:
Exempt Cultural & Nature Exhibits

ii.) Natural (OSN)

Definition:

Predominantly undeveloped or unaltered land preserved in its natural state for environmental
or aesthetic purposes.
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Samples:
Natural Open Space uses would typically include any of the following that meet the previously

defined criteria:
Wetlands

Timber or Forest Lands
Nature Preserves

Utility (UTL)

Definition:

An area or strip of land, either public or private, occupied by a power plant or substation,
electric transmission line, oil or gas pipeline, water tower, municipal well, reservoir, pumping
station, water treatment facility, communications tower, or similar use.

Samples:
Utility uses would typically include any of the following that meet the previously defined

criteria:
Comm Ld & Impro Own by Pub Uti Th Rail

Transportation

i.) Vehicular/Pedestrian Right-of-Way (ROW)

Definition:

An area or strip of land, either public or private, on which an irrevocable right-of-passage has
been recorded for the use of vehicles or pedestrians or both.

Samples:
Transportation Right-of-Way uses would typically include any of the following that meet the

previously defined criteria:
Skyways
Street Right-of-Way
Sidewalks/Paths/Trails

ii.) Railway (RLW)
Definition:
An area or strip of land occupied or intended to be occupied by a railroad or other similar use.

Samples:
Railway uses would typically include any of the following that meet the previously defined

criteria:
Railroad Real Property Used in Operation
Railroad Real Property Not Used in
Operation

iii.) Airport (AP)

Definition:

Land Used for the operation of aircraft and associated accessory uses; provided accessory uses
are incidental to the airport activity.

Samples:
Airport land uses would typically include any of the following that meet the previously defined

criteria:
Landing strips/runways
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Airplane hangers
Helipads

Air-traffic control facilities
Boarding terminals

Vacant (VAC)

Definition:

Land not currently used for any defined purpose that may or may not contain buildings or
other structures.

Samples:
Vacant land uses would typically include any of the following that meet the previously defined

criteria:
Agricultural, Vacant Land
Industrial, Vacant Land
Commercial, Vacant Land
Apartment, Vacant Land
Residential, Vacant Land, Lot
Vacant Land
Exempt HRA Vacant Land

Open Water (WAT)
Definition:
Permanently flooded open water not including wetlands, or periodically flooded areas.

Samples:
Open Water would typically include any of the following that meet the previously defined

criteria:
Lakes
Rivers
Streams (not intermittent)
Ponds (permanently flooded)
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Appendix 1B: Excensus Metadata

Twin Cities Walking Study - Employment Summary
Prepared by Excensus LLC

Overview of Methodology for St. Paul Area

L Obtained database of current employers within study area from Dun & Bradstreet

(DNB)
II. Verified coverage of DNB dataset against requested geographies
II. Cleaned and standardized DNB employer records

Iv. Geocoded DNB employer records and resolved unmatched records

V. Manually reviewed points (with 5 or more employees) placed just outside of context

area boundaries to determine whether they should be included

VL Merged DNB data with previous employment data from I35W Corridor project

VII. At this stage there were two products. One assigned employer points to 100-meter
grid cells, taking into account overlapping context areas. The other gave the “raw”

data which was in fact what we used.

VII. Summarized employment counts in each cell, including the requested retail
breakouts

Structure of Employment Summary Shapefile (Employment_Summary_100m.shp)

Field Name Description

Shape Type of shapefile

ID 100-meter grid identifier

Context Area identifier

Group Allows context areas to be grouped into non-overlapping groups
Type Indicates whether grid cell is in a context or a focus area
Num_Empl Total number of employees within grid cell

Num_Retail Number of employees in retail businesses (SIC 52xx — 59xx)
Num_GenMer Number of employees in general merchandise businesses (SIC 53xx)
Num_Food Number of employees in food stores (SIC 54xx)

Num_EatDri Number of employees in eating & drinking establishments (SIC 58xx)
Num_MisRe Number of employees in miscellaneous retail businesses (SIC 59xx)
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Appendix 1C: GIS Digitizing and Fieldwork for Street Trees, Street Lamps,
and Sidewalks

By Joel Koepp

This is an account of how the research team created street tree, street lamp, and parcel data
layers for the 1.0°1.0 mile/1609*1609 meter context areas. Digitizing was done by two
undergraduate research assistants—Jorge Salcedo and Ian Kaminski-Couglin. Data conversion
was done by research fellows Joel Koepp and Jason Zimmerman. Joel Koepp did all field
checking of data. Ann Forsyth did a small amount of work to figure out a method for dense
stands of trees that had continuous canopies in the digital orthophotos.

Digitizing

The color high-resolution digital orthophotos served as the basis for the digitizing of street
features. The study areas were divided into groups so the undergraduate research assistants
could be working in parallel to complete the digitizing.

For places where no sidewalk data could be obtained from the cities, sidewalks identifiable in
the orthophotos were digitized using the basic drawing tools in ArcMap. A polyline was drawn
down the middle of the sidewalk for each sidewalk segment, starting and ending where the
sidewalk met the road. In the cases where a sidewalk meets a driveway and continues on the
other side, the line was drawn so that it continued across the driveway rather then being broken
into 2 separate lines. When all the sidewalks were digitized and checked, they were converted
into a GIS shapefile using the XTools extension, which can convert graphics into spatial data
with attributes.

Street lights were digitized by inspecting the orthophotos and using the drawing tools to place a
dot at the base of each light pole. The majority of street lights were identifiable due to the
unique shadows created on the ground. Along major arterials, particularly in the suburbs, most
lights consist of a pole and an attached arm that hangs out over the road. The shadow it created
was very distinctive, so it was not difficult to locate the base of the pole using this shadow. In
the City of Saint Paul, residential streets use one or two styles of light fixtures in a consistent
fashion throughout entire neighborhoods. They are located at regular intervals and so were
relatively easy to identify and digitize. In places where a street light could not be distinguished
from a utility pole or tree, the point was digitized and left to be resolved in field checking.

Trees were digitized in much the same way as street lights. The drawing tools were used to
place a point on each tree for all trees up to the front face of a house, and for a similar distance
away from the street in non-residential areas. In places where the density of trees was too high
to distinguish individual trees with enough accuracy, the cluster of trees was drawn using a
polygon. These polygons were to be field checked later to assign a tree density and arrive at a
count.

Field Checking

The laptop was loaded up with the GIS software (both ArcMap and ArcView) and all the
relevant data: focus and context areas, streets, parcels, and the digitized sidewalks, street trees,
and street lights. The GPS receiver was also taken.

In general terms, the goal of field checking was to verify the existence of the features we had
digitized in the office. Where necessary, features not found or not identifiable on the
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orthophotos would be added, and features mistakenly digitized (e.g., telephone pole mistaken
for light pole) would be removed. In addition, fieldwork also included taking photos of tree
stands where the tree density on the orthophotos was too high to distinguish individual trees.

The first context area was done in conjunction with two research assistants doing the separate
urban design inventory. For this area checking used paper maps and any changes ere marked
directly on them. Back at the office changes were made in GIS based on the map notations. This
checking also involved walking the streets, doing a small area on foot, then driving the car a
short distance to a new area, getting out and walking again.

After one day it was clear that walking was not a viable long-term option for completing field
work in the time frame the research team had laid out for it. It also turned out that the paper
maps strategy was cumbersome, because this involved making edits on the paper and then
having to repeat them in the GIS to change the actual data. From then on, edits were made
directly to the data in GIS, adding and deleting features as necessary.

To check data on a given street, the field checker drove slowly down the street and parked
along the side two or three times to check what he was looking at against the data on the screen.
In a few places there were streets that were either too busy to park on or where parking was not
allowed. For those situations he found a nearby place to park and walked with the laptop.

The first feature he would check was sidewalks, as it was the feature that required the least
amount of editing. Typically he could tell immediately by looking down the street if there were
sidewalks on one or both sides, or none at all. If a sidewalk was there that he didn't have data
for, he drew it in for the whole length of street by default. One or two times he would again edit
that sidewalk if it turned out not to extend to the end of the street. For streetlights, his normal
procedure was to count the number of lights on each side of the street and check against the
GIS. In suburban areas, lights were usually found only on one side of a street. On most streets in
Saint Paul, the pattern is to have evenly spaced streetlights on alternating sides of the street, and
then usually two lights on opposite corners at an intersection. In places where his GIS data
clearly indicated that he was missing a street light, he would locate it on the street and make a
note of how many houses away from the corner or end of the street it was. That information
allowed me to use the parcel data in the GIS as a reference for adding in the point. For trees, he
would check the number of trees in a front yard against what was on the screen, and in places
where the GIS data was missing a significant number of trees he digitized them in. Obviously
without using the GPS the tree locations were not precise, but for the purposes of the eventual
variable the number of trees is going to be crucial.

For keeping track of progress, the field checker checked off street segments on a paper map, as
this was quite a bit more efficient than doing the equivalent within GIS.

After every day of field work, he compressed the GIS data into a zipfile and transferred it to his
computer at work via FTP for backup purposes.

The field checker took all the tree photos with a digital camera. He began by erasing all data on
the camera memory card and all waypoints on the GPS. When he came to a stand of trees that
needed to be photographed (as indicated by the "dense tree area" polygons that Ian and he
digitized), he stopped the car, took a picture, and then immediately recorded his position with a
GPS waypoint. This way, each photo had a corresponding waypoint. At the end he had the
same number of photos and waypoints, and both were in the order in which he recorded them
so they could be easily associated with each other. he used the Garmin software and an
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ArcView extension called AVGarmin to retrieve the waypoints from the GPS and convert them
into a shapefile. Finally he created an ArcMap project with all the waypoints and linked in the
tree images.
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Appendix 1D: Matrix of Measures by Measurement Geography Used in
Twin Cities Walking Study

Measurement STRAIGHT NETWORK Dist.to P
Near a

r

C

el

200 400 800 1600 200 200 400 800 160 grid
a b 0

3.1 Raw Population per
Unit Land Area

3.15 Net Land Area

3.2 Population per Unit
Land Area (without
water)

3.3. Population per
Developed Land Area

3.4 Residential
Population in
Residential Parcels
(Residential Density)

3.5 Population plus
Employment per Unit
Land Area (excluding
water)

3.6 Employment per
Unit Land Area

3.7 Housing Units per
Unit Land Area (gross,
census data)

3.8 Lot Coverage

4.1 Sidewalk Length per
Unit Area

4.2 Sidewalk Length
Divided by Road Length

4.3 Sidewalks Length
divided by Major road
Length

4.4 Street Lights per
Length of Road

4.5 Street Trees (trees
within an X foot/ meter
buffer) per Length of
Road

4.6 Percent of Street
Segments with Marked
Pedestrian Crossings at
One or Both Ends
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4.7 Percent of Street
Segments with Visible
Litter, Graffiti, or
Dumpsters

4.8 Percent of Street
Segments with Traffic
Calming, Broadly
Defined

4.9 Other fieldwork based measurements of neighborhood identification, street crossing, street
characteristics, views, land uses, barriers, sidewalks, bicycle lanes, mid block crossing, steepness,

sidewalk amenities, street trees, buildings, windows, other features of buildings, garages, parking,
driveways, maintenance, lighting, freeways, traffic features, architecture/ design.

4.10 Distance to nearest
Bus Stop

4.11 Bus Stop Density

5.1 Percentage of Total
Parcel Area in Major
Land Uses (seven land
uses in this case)

5.2 Percentage of Land
Area in Night Time Uses

5.3 Percentage of Land
Area in Social Uses

5.4 Percentage of Land
Area in Retail Uses

5.5. Percentage of Land
Area in Industrial and
Auto-Oriented Uses

5.6 Dissimilarity Index,
Formula 1

5.7 Proportion of
Dissimilar Land Uses
Among Grid Cells in an
Area (Formula 1)

5.8 Dissimilarity Index,
Formula 2

5.9 Entropy Index

5.10 HH Index

5.11 Retail Employment
per Acre

5.12 Density of
Employees in Major
Retail Subcategories:
General Merchandise
(old SIC 53xx); Food
Stores (54xx); Eating and
Drinking Places (58xx);
Miscellaneous Retail
(59xx).
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5.13 Distance to nearest
gen merchansise

Food stores

Eating and drinking

Misc retail

5.14 Distance to nearest
facility (for comparison

with NQLS)

5.15 Gravity measure
with competition

UNC Measures e.g.
Entropy index; HHI
INdex

6.1 Average Census
Block Area

6.2 Median Census Block
Area

6.3 Ratio of Area within
X Street Distance to Area

within X Distance
Radius

6.4 Number of Access
Points

6.5 Road Length per
Unit Area

6.6 Intersections per Unit
Area

6.7 Ratio of 4-Way
Intersections to All
Intersections

6.8 4-way Intersections
per Unit Land Area

6.9 Ratio of 3-way
Intersections to All
Intersections

6.10 Connected Node
Ratio

6.11 Median Perimeter
of Block
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Appendix 1E: Other Data and Measurement Issues
By Joel Koepp and Jason Zimmerman with Ann Forsyth

1. Projections

For these measurements we used the UTM NADS83 Zone 15 coordinate system, which uses the
meter as its fundamental unit. This is the coordinate system used by the Metropolitan Council
for all of its endorsed regional datasets. Some datasets received from counties were used in their
native coordinate system, such as the Ramsey County parcels, which come in the Ramsey-
Hennepin coordinate system (this uses the foot as its fundamental unit). Datasets digitized from
the Ramsey County orthophotos (sidewalks, street trees, street lights) were created in Ramsey-
Hennepin coordinates originally but then converted to UTM coordinates later.

2. Transformation of Raw Data to Final Form
Water
Sources: Ramsey County water layer, Met Council hydro layer (from 2000 land use data)
Steps:
1. Merge Ramsey County and Met Council layers to get most complete coverage
2. Along Rice Creek in Anoka County, make manual corrections due to poor digitizing and
poor alignment of Ramsey and Anoka parcels

Parcels
Sources: Ramsey County, Anoka County, Hennepin County, Dakota County (or Met Council
Regional Parcel Dataset)
Steps:
1. Clip and merge parcels from various counties (or clip from Met Council data)
a. Remove Dakota right of way (included as a polygon)
Union water layer
Correct manually some parcels due to updates in parcel attribute information (see
below)
Create manually some new parcels along Mississippi (see below)
Correct old plat of right of way in Dakota County (along river)
Add manually a parcel in Mounds View that was left out
Manually adjust alignment of some parcels in St. Paul
Create road right of way layer from space left between parcels

® N

PN

Land Use

Sources: I-35W land use data (polygon matched to parcel lines), Ramsey County land use data
(parcel), Ramsey County on-line property information search, Ramsey County on-line maps
(parks), Metropolitan Council land use data (polygons), City of St. Paul park data (parcel data),
field-checked land use data in Anoka, Dakota, and Hennepin Counties (parcel data)

Steps:
1. Begin with complete parcel data set.
2. Add I-35W land use codes to parcels
a. Convert from polygons to parcels (check centroid locations)
3. Convert Ramsey County land use codes to I-35W codes; add to parcels
a. Correct missing parcels (due to differing dates of parcels and attribute data;
required some manual adjustments to parcel lines)
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b. Correct some parcel data without codes (common area around attached
townhomes)
4. Make corrections to Ramsey County data (too much vacant and institutional)
a. Add parks from St. Paul data
b. Add parks from Ramsey County web site (park layer)
Merge water layer (from two sources) and code as water
Correct vacant land use around water bodies (to open space)
Add land use data from field-checking in other counties
a. Use Met Council data to confirm use
b. Remove Dakota County parcel within highway right-of-way; code others to
vacant
8. Correct parcel slivers (usually changes to adjacent land uses)
9. Decide to leave government land uses (around Capitol) as institutional (not open space)
10. Carve out new open space parcels along Mississippi River
11. Recode parcels crossed by new Shepard Road
12. Check orthophotos or field-check for remaining mystery parcels
13. Convert to our 7 General Land Use Categories, as well as “Water” and “Other”
14. Based on Ramsey County land use codes, mark nighttime, social, retail, anti-pedestrian
uses); field-check commercial parcels outside Ramsey County or use on-line property
information search

N>

In addition:

Decided, for land use, to use our detailed land use data for inside the context areas and use
general Met Council data for areas outside the context areas (See Appendix 5C for more
information on determining land uses in context areas).

Met Council residential uses were considered to be the following:
e Farmstead
e Seasonal/vacation
¢ Single family detached

Manufactured housing park

Single family attached

Multifamily

Mixed use residential

Roads
Sources: The Lawrence Group centerline data

Steps:
1. Remove random Macalaster College road segments (for intersection analysis, adjust
these valences to reflect new intersection types)
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Appendix 1F: Detailed instructions for Downloading and Cleaning Census
Data

By Joel Koepp

Introduction

The US Census Bureau’s American FactFinder website (http:/ /factfinder.census.gov) is a quick
and easy way to obtain data for normal geographies—cities, counties, census tracts, etc—but is
very cumbersome for situations requiring non-standard geographies.

Documentation
http:/ /www.census.gov /prod /cen2000/doc/sfl.pdf
http:/ /www.census.gov /prod /cen2000/doc/sf3.pdf

The links above are the Technical Manuals for using Census Summary Files 1 and 3. They
explain the geographies and contain the complete documentation for all variables, along with
metadata.

Importing SF1 into Access
Begin by downloading the Access database template provided by the Census Bureau at
http:/ / www.census.gov /support/2000/SF1/ Access97.zip

Open this database and update it to the most recent version of the Access file format. This is
done by opening the Tools menu, then the Database Utilities submenu, and finally the Convert
Database option. You will be prompted to save the file as a new database with a new name. At
this point the database contains only empty tables that have the correct field names and types
for the data they will eventually contain.

The raw data is downloaded from the Census FTP site

(http:/ / www2.census.gov / census_2000/ datasets/) in compressed form. Individual files
uncompress into very large text files with .ufl file extensions. Each one must be renamed to
have a .txt extension before importing into Access (e.g., rename mn00009.ufl to mn00009.txt).
The benefit of downloading the Census Access template is to get the import specifications built
in. Import specifications ensure that when importing one of the text data files, all the fields are
assigned the correct data type and receive the proper names.

Summary File 1 is split into 39 segments and 1 geographic header file. Chapter 7 of the
Technical Manual contains a table matrix that shows the segment in which to find each table
and individual variable. The most commonly used segments will be 1-11 and 37-39, which
contain raw data at the block level. Segments 12-36 contain percentage tables.

With a segment file downloaded, uncompressed, and properly renamed, you can import it into
the database.

From the Access menu, choose File->Get External Data->Import...

Change the dropdown box Files of Type to look for text files

Select the file to import (e.g., mn00001.txt for Segment 1) and click Import

In the Import Text Wizard that appears, clicked the Advanced button at the lower left
Click Specs to choose an import specification

RN
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6. Find the import specification that matches the segment being imported (in this case,
SF10001 Import Specification) and click Open

7. Click OK

8. The wizard will correctly determine that the data is in a delimited format, so click Finish

9. When prompted to choose a table in which to store the data, select the existing empty
SF10001 table, click Next, and then Finish

10. Right click on the table and choose Design View

11. Right click on the LOGRECNO field and select Primary Key

12. Click Save to preserve the changes in the table

The geographic header file (called SF1GEO in the database, it gets imported just like the
segment files and has its own import specification) and one segment table are the minimum
requirements to start making custom queries.

Open the Tools menu and choose Relationships. Add the SF1GEO table and one of the segment
tables to the view. Drag the LOGRECNO field (which is the primary key in all tables) from
SF1GEO to SF10001. This establishes the one-to-one relationship between the two tables based
on that field. Create this relationship between SF1GEO and any other segment tables (SF10002,
SF10003, etc) you wish to use.

Basic Queries

The first piece of information necessary in constructing a query of Census variables is the
geography. It can be a county, a group of cities, a tract, a customized list of specific census
blocks, or a combination of multiple geographies. To get the right records out of the database, a
query requires the use of the proper summary level codes for the geographies. These are listed
in a table on page 83 (Chapter 4) of the Technical Manual. The more common codes are 160 for a
city, 080 for a census tract, and 101 for a census block.

The SF1GEO table contains one record for every census unit in a state. There are a number of
fields that can be used in a query to identify a desired geography. The most helpful are
SUMLEV, COUNTY, PLACE, TRACT, BLKGRP, BLOCK, and NAME. For example, to find all
the census blocks in Ramsey County, you would build a query that looks for records where
COUNTY = “123"” and SUMLEV = “101” (this

will be explained in more detail later). 5 - o=
Making Useful Extra Tables _ O
After doing a few queries it will probably i
become apparent that searching for a particular STUSAB
county or city using codes like “123” and SECOD
“40382” is not very intuitive. It may help save CHARITER
time in the long run to quickly create some i
tables that contain a correspondence between REGION
the county/place codes and the actual names. i
STATE -

In the main Access window, click on Queries. 7

Double click the icon on the right labeled — :
“Create query in Design View.” In the blank Field: [SUMLEV COUNTY NAME

query that appears, add the SF1GEO table and e ISFLE0 SEIGED SFIGED

click Close. Click and drag the following fields Show: = =

into the columns at the bottom of the query: i WIS

ar:

SUMLEV, COUNTY, and NAME. Under the
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Criteria for SUMLEV, enter “050” (this is the summary level code for a county, as found on page
83 in Chapter 4 of the Technical Manual). Click the red exclamation point icon in the toolbar to
run the query, which should display all the counties in the state. Save the query with a useful
name.

Another useful lookup query to have is one that matches place codes to city names. In the main
Access window, click on Queries. Double click the icon on the right labeled “Create query in
Design View.” In the blank query that appears, add the SF1GEO table and click Close. Click and
drag the following fields into the columns at the bottom of the query: SUMLEV, PLACE, and
NAME. Under the Criteria for SUMLEYV, enter “160” (this is the summary level code for a place,
as found on page 83 in Chapter 4 of the Technical Manual). Uncheck the box under SUMLEYV,
because it doesn’t need to be displayed in the query results. Under the NAME column, set the
Sort to be Ascending to display the city names alphabetically. Click the red exclamation point
icon in the toolbar to run the query, which should display all the counties in the state. Save the
query with a useful name.

Example Query: Population in all Hennepin County census blocks
This section will describe in detail how to use a query to identify a geography and link in a
segment table to pull out a specific Census variable.

In the main Access window, & =TT
click on Queries. Double click f -
the icon on the right labeled I O

“Create query in Design View.” lcoUsUB = [ =
In the blank query that appears, COUSUBCC e
add the SFIGEO and SF10001 i el
tables and click Close. The two |PLacECC |cIFs

|PLACEDIC | LOGRECHO

tables should automatically be
joined on the LOGRECNO field,
assuming a relationship was
established between them after
they were imported. Click and

|PLACESC
|TRACT
|BLKGRP
|BLOCK
Vs

|POO1001
|PODZO01
|PODz002
|PODZ003

drag the following fields from 10

SF1GEQ into the columns at the Field: [SUMLEV COUNTY ELOCK POOL001
bottom of the query: SUMLEY, Table: [SF1GEO SF1GED SFIGED SFL0001
COUNTY, and BLOCK. Then Sart:

click and drag the P001001 field o . v = i ] L

from the SF10001 table into a
column at the bottom. Under the
Criteria for SUMLEYV, enter
“101” (this is the summary level
code for a census block, as
found on page 83 in Chapter 4
of the Technical Manual).
Uncheck the box under

or

™|

SUMLEYV, because it doesn’t need to be displayed in the query results. Under the Criteria for
COUNTY, enter “053” (found using the county names query created earlier), which will match
Hennepin County. Click the red exclamation point icon in the toolbar to run the query.

Complex Queries and Calculating Fields
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Age data is a very frequently used part of Census Summary File 1. In addition to simply
querying variables, Access allows a user to perform calculations in a query and store the results
in a new field. Since the age ranges are stored in separate variables for male and female, it is
convenient to use an Access query that sums together a corresponding pair or pairs of variables
(e.g., adding together P012003 and P012027 from table SF10002 would yield the total population
of children under 5 years old). Similarly, several variables could be added together to identify a
particular group of ages, like the key 18 to 34 year old male demographic.

As an example, the following steps make a query that counts the number of children between
the ages of 5 and 14 at the block group level in Ramsey and Dakota Counties.

In the main Access window, click 51 Querys: Select Query ~alx
on Queries. Double click the icon on -l|
the right labeled “Create query in | [FATES— N
Design View.” In the blank query A ] e O

that appears, add the SFIGEO and M : Pl

SF10002 tables and click Close. The CHARITER | et

two tables should automatically be Lo@E0 = e

joined on the LOGRECNO field, S PRI

assuming a relationship was Loy S

established between them after they COUNTY - ot

were imported. Click and drag the

following fields from SFIGEO into |1

the columns at the bottom of the

Fisld: [SUMLEV COUNTY _|BLKGRD __|AgeStold: [PO12004]1 [PO12005]) [MO12028]) [M012020]
query: SUMLEV, COUNTY, and Table: [SFIGED SFIGEQ  |SFIGED
. . Sort!
BLKGRP. Under the Criteria for T 7 B )

COUNTY, enter “037” and “123” on S R
separate lines (these are the county

codes for Dakota and Ramsey |
Counties, respectively, as found
from the county code query created i
earlier). Under the Criteria for Jn

SUMLEYV, enter “091” on the top

two lines (this is the summary level code for a census block group, as found on page 83 in
Chapter 4 of the Technical Manual). In an empty column at the end of the query, enter the
following in the top row marked Field:

Agebtol4: P012004+P012005+P012028+17012029

This will create in new field in the output of the query named Age5tol14, and the values in that
column will be the sum of the four variables that contain the male and female children of ages 5
to 9 and 10 to 14 (see Chapter 7, Table P12 on page 243 of the SF1 Technical Manual).

New fields can be created using mathematical operations of all kinds—for example, a user
could sum together counts of various groups of the population and then calculate it as a
percentage of the total population in one line, rather than having to do the work in a
spreadsheet. Access also has many text manipulation functions, for concatenating multiple
strings of text or stripping off characters from the left or right ends of a string.

Combining GIS and a Census Database
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The ESRI website provides access to free Census GIS data for the entire United States. The
Census Bureau’s 2000 TIGER/Line data can be downloaded for individual counties after
selecting a state. The TIGER/Line data contains line features (roads, railroads, etc), landmarks,
and boundary files (census geographies, city and county boundaries, traffic analysis zones, etc).

Access Census data for download here:
http:/ /arcdata.esri.com/data/tiger2000/ticer download.cfm

Once a shapefile is downloaded, uncompressed, and added to an ArcGIS document, it is ready
for analysis or processing. Each census geography shapefile will have in its Attribute Table a
field called STFID which serves as the unique identifier for each feature. For example, a layer of
census tracts will have an eleven character value in the STFID field, with each value unique to a
particular census tract. A layer of block groups will have STFID values with twelve characters,
and census blocks will have fifteen character STFID values.

The STFID is created by concatenating the values of the STATE, COUNTY, TRACT, BLKGRP,
and BLOCK fields (as found in the SF1GEO table. The STATE portion is two characters,
COUNTY is three characters, TRACT is six characters, BLKGRP is one character, and BLOCK is
four characters. Note that the first character of the BLOCK field is identical to the BLKGRP
value.

To construct a value in the Census database that will match the STFID values in the GIS
shapefiles, use the following;:

Tract: [STATE] & [COUNTY] & [TRACT]
Block Group: [STATE] & [COUNTY] & [TRACT] & [BLKGRP]
Block: [STATE] & [COUNTY] & [TRACT] & [BLOCK]
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Appendix 4A: Modified Boarnet-Day Inventory, Now the Irvine-Minnesota
Inventory

By Ann Forsyth drawing on collaborative work by Kristen Day, Marlon Boarnet, and Mariela Alfonzo

Note, this is the inventory as used. However, a revised version has been created and will be
available on the Active Living Research web site. Called the Irvine-Minnesota Urban Design
Inventory, it includes reliability information.

In the inventory as used, a number of coding protocols were used to clarify skipped items in
particular and a revised version has been prepared that removes the “skip question and code as
9” type items but instead provides a skip/not applicable option in each question. A separate
paper is available that describes how this inventory was used (Forsyth et al 2004a).

It should be noted that the inventory was conducted on a 20% sample of roads with pedestrian
access with divided roads treated as one road (if both sides were selected, one was removed an
a new random segment drawn). Because the road data contained a number of very small
segments, those less than 50 feet long were excluded.
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Appendix 5A: Ramsey County Land Use Codes

Land Use
Code
109
300
310
320
340
390
399
400
401
402
403
404
405
406
410
411
412
415
420
421
422
423
424
425
426
428
429
430
431
432
435
437
441
442
444
447
448
449
450
451
452
453
454
456
458
460

Type

NNONNONONNNNANONONNNNNNNNANONNNNNZZEZZZZAN——————x5

Land Use Description

GREENHOUSES, VEGETABLES & FLORACULT.
INDUSTRIAL, VACANT LAND
FOOD&DRINK PROCESS PLANTS AND STORAE
FOUNDERIES&HEAVY MANUFACT PLANTS
MANUFACTURING & ASSEMBLY LIGHT
GRAIN ELEVATORS

OTHER INDUSTRIAL STRUCTURES
COMMERCIAL VACANT LAND
APARTMENTS 1-9 RENTAL UNITS
APARTMENTS 10-19 RENTAL UNITS
APARTMENTS 20-49 RENTAL UNITS
APARTMENTS 50 OR MORE UNITS
APARTMENT VACANT LAND
APARTMENT MISC IMPROVEMENTS
MOTELS AND TOURIST CABINS

HOTELS

NURSING HOMES & PRIVATE HOSPITALS
TRAILER OR MOBILE HOME PARK

SMALL (UNDER 10,000SF) DETACH RETAI
SUPERMARKETS

DISCOUNT STORES & JR. DEPT STORES
MEDIUM DETACHED RETAIL

FULL LINE DEPARTMENT STORES
NEIGHBORHOOD SHOPPING CENTER
COMMUNITY SHOPPING CENTER
VETERINARY CLINIC

OTHER RETAIL STRUCTURES

RESTURANT, CAFETERIA, AND/OR BAR
SMALL STRIP CENTER

CONVENIENCE STORE

DRIVE-IN REST/FOOD SERVICE FACILITY
DAY CARE CENTERS

FUNERAL HOMES

MEDICAL CLINICS AND OFFICES

FULL SERVICE BANKS

OFFICE BUILDING 1-2 STORIES

OFFICE BULD 3 OR MORE STORIES WALKUP
OFFICE BULD 3 OR MORE STORIES ELEVAT
CONDOMINIUM OFFICE UNITS

GAS STATION

AUTOMOTIVE SERVICE STATION

CAR WASHES

AUTO CAR SALES AND SERVICES
PARKING GARAGE STRUCTURE & LOTS
CI/CONDO/CO-OP NON-TAX OUTLOT
THEATERS
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463
464
465
479
480
481
482
499
500
501
510
511
515
520
521
525
530
540
545
546
550
552
555
570
573
575
577
579
600
610
615
620
635
640
641
642
644
645
646
647
649
650
660
670
680
682
685
687
690
830
840

CCcmmmmbmmmbmmmmmmmanmmmm AR AAAAAAIAA O IAIAAA”A DI AAZAZI DN NNNN

GOLF COURSES

BOWLING ALLEYS

LODGE HALLS AND AMUSEMENT PARKS
FLEX INDUSTRAIL CENTER

COMMERCIAL WAREHOUSES

MINI WAREHOUSE

COMMERCIAL TRUCK TERMINALS

OTHER COMMERCIAL STRUCTURES
RESIDENTIAL, VACANT LAND, LOT
RESID/EXEMPT VACANT LAND

SINGLE FAMILY DWELLING, PLATTED LOT
RES/EXEMPT SINGLE FAMILY DWELLING
TWO RESIDENCES ON ONE PARCEL

TWO FAMILY DWELLING, PLATTED LOT
RES/EXEMPT MULTI FAMILY DWELLING
CONVERSION

THREE FAMILY DWELLING, PLATTED LOT
DOUBLE DWELLING

1/2 DOUBLE DWELLING

RES/EXEMPT 1/2 DOUBLE DWELLING
CONDO/CO-OP

CONDO/CO-OP GARAGE OR STORAGE
CONDO/CO-OP NON-TAX OUTLOT
TOWNHOME-INNER
TOWNHOME-DETACHED
TOWNHOME-OUTER

TOWNHOME NON-TAX OUTLOT
RESIDENTIAL, TOWNHOME VACANT
EXEMPT PROPERTY OWNED BY USA

EXEMPT PROPERTY OWNED BY STATE OF MN
EXEMPT PROPERTY OWNED BY MET COUNCIL
EXEMPT PROPERTY OWNED BY COUNTIES
FIRESTATIONS

EXEMPT PROPERTY OWNED BY MUNICIPALS
EXEMPT LAND

EXEMPT CLINICS

SPORT/PUBLIC ASSESMBLY FACILITY
EXEMPT HRA VACANT LAND

EXEMPT CULTURAL & NATURE EXHIBITS
EXEMPT COMMUNITY RECREATIONAL FAC.
LIBRARY

EXEMPT PROPERTY OWNED BY BD OF EDUC.
EXEMPT PROPERTY OWNED PARK DIST.PUB
EXEMPT PROP OWNED BY PRIVATE SCHOOLS
CHARITABLE EXEMPT HOSP./NURSG HOMES
WELFARE/CHARITABLE FACILITY
CHURCHES ETC PUBLIC WORSHIP PRIVE
EXEMPT OFFICE BUILDINGS

GRAVEYARDS MONUMENTS, CEMETERIES
COMM LD&IMPRO OWN BY PUB UTI TH RAIL
RAILROAD REAL PROP USED IN OPERATION

ENVIRONMENT AND PHYSICAL ACTIVITY: GIS PROTOCOLS VERSION 2.3, August 2005, WORK IN PROGRESS
University of Minnesota, Twin Cities Walking Study, Metropolitan Design Center

201



850
880

U
U

RAILROAD REAL PROP NOT USED OPERATOS

PUB UTIL PER PROP OTHER THAN RRS

OTHERS NOT PRESENT IN STUDY SITES

101
108
120
190
370
407
427
440
445
457
461
462
485
490
496
509
519
529
539
549
559
560
598
599
625
695
821

CHomAMmAAARIRIAATONOONOONONNNNZ — B> >

CASH GRAIN OR GENERAL FARM
NURSERIES

TIMBER OR FOREST LANDS

OTHER AGRICULTURAL USE

SMALL SHOPS (MACHINE, TOOL & DIE ETC)
FRATERNITY/SORORITY HOUSE
REGIONAL SHOPPING CENTER

DRY CLEANING PLANTS & LAUNDRIES
SAVINGS AND LOAN

PARKING RAMP

DRIVE-IN THEATERS

GOLF DRIV RANGE & MINI GOLF COURSES
RESEARCH AND DEVELOPMENT FACILITY
MARINE SERVICE FACILITIES

MARINA (SMALL BOAT)

RESID, NEW PLATS INITIAL YEAR

RESID, NEW PLATS INITIAL + 1/3 DIFF
RESID, NEW PLATS INITIAL + 2/3 DIFF
RESID, NEW PLATS THIRD YEAR

RESID, PROBLEM VACANT PINS
RESIDENTIAL, CONDO/CO-OP VACANT
MOBILE HOME ON REAL ESTATE

EXEMPT OTHER RESIDENTIAL

OTHER RESIDENTIAL

ST PAUL AIRPORT & MAC PROPERTY
SKYWAYS

VACANT LAND
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Appendix 5B: I-35W Corridor Coalition Land Use Codes

AG
SFD
SFA
MF
MH
R
NC
CC
RC
HC
OFC
MU
LI
HI
IN
SRO
SRI
OSN
ospP
ROW
RR
UTL
VAC
WAT
AP

Agriculture

Single Family Detached
Single Family Attached
Multiple Family

Mobile Home Park
Rural Residential
Neighborhood Commercial
Community Commercial
Regional Commercial
Highway Convenience
Office

Mixed Use

Light Industrial

Heavy Industrial
Institutional

Outdoor Sport/Recreation
Indoor Sport/Recreation
Natural Open Space
Passive Open Space
Right-of-Way

Railway

Utility

Vacant

Water

Airport
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Appendix 5C: Determining Land Uses for Context Areas and Buffers

By Jason Zimmerman

Our land use analysis was the result of the merging of two separate measurement areas.
Outside of our Context Areas, land use data was based on the categories created as part of the
Metropolitan Council’s 2000 Land Use data set. Within the Context Areas, a more detailed set of
steps was carried out to achieve the most accurate data possible.

Process for determining Land Uses for parcels in our Context Areas developed as follows:

1.
2.
3.

4.

10.
11.
12.

Began with I-35W land use codes for parcels in Coalition cities

Added parcel data from other Ramsey County cities

Translated Ramsey County land use codes to I-35W land use codes (used I-35W land use
definitions and best estimates as to comparable categories)

Some Vacant and Institutional land uses were really Park and Recreation land uses.
Using a combination of a St. Paul parks layer, an on-line Ramsey County park map, and
county orthophotos, large vacant areas were checked to see if they should be recoded as
Park and Recreation. They were recoded if other sources indicated they were parks —
vacant parcels that were not clearly identified elsewhere as parks were left vacant.
Manually corrected some Ramsey County parcels with no codes (e.g., land surrounding
townhomes, typically common areas, re-coded from Vacant to Single Family Attached)
Manually corrected small slivers created through merging and clipping of parcel data
sets (coded to match surrounding land uses)

Added Hennepin, Dakota, and other Anoka County parcels and land uses field-checked
by staff

Railroad parcels inconsistently classified across cities and counties. In some places they
were some coded Exempt Land, others Operational RR, and still others Non-Operational
RR. We did not change this. As a result, some railroad parcels are coded Tax Exempt
and others Industrial.

When in doubt, used Met Council 2000 land use data, on-line property tax information,
and orthophotos to check questionable parcels

Overlaid Ramsey County water layer (most detailed available)

Outside Ramsey County, overlaid Met Council water layer (more general)

Parcel remnants around ponds were reassigned to open space categories—some had
been vacant (see below — Image 1 has the parcel surrounding the pond coded Vacant;
Image 2 is the orthophoto that shows the area is really open space; Image 3 is the
corrected data with the parcel coded as open space)
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Process for determining Land Uses for parcels outside our Context Areas (Buffers) developed as
follows:
1. Had to assign Met Council land use data from polygons to Regional parcel data using
centroids and a spatial join — this meant we had to correct by hand when parcel
centroids did not fall within land use polygons

The image below demonstrates this point. The colored areas are land use polygons, the
thin grey lines show parcel boundaries, and the points are parcel centroids. Oddly-
shaped parcels, such as the one outlined in purple, have centroids that may not fall
within the correct land use polygon. Here, the parcel centroid (highlighted in purple)
falls inside the lake. Assigning the underlying land use to the centroid, and thus to the
parcel, would result in the large open space parcel being coded as Water. Instead, the
centroid was manually coded as Park and Recreation.

12395

|

.‘.

:
(;\
:

T _

2. Converted general Met Council land use categories to our seven major land use

categories

Met Council Met Council Land

Code Use RWTJF Land Use

100 Agriculture OTHER

111 Farmsteads RESIDENTIAL
Single Family

112,113,116 Residential RESIDENTIAL
Multi-Family

114,115 Residential RESIDENTIAL

120 Commercial - Retail COMMERCIAL

130 Commercial - Office ~ OFFICE
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141

142

143
151
153
160

170

173
201
202
203
210
220

Mixed Use -
Residential
Mixed Use -
Industrial
Mixed Use -
Commercial
Industrial and Utility
Extractive
Institutional
Park, Rec, and
Preserve

Golf Course
Major Highway
Railway
Airport
Undeveloped
Water

OFFICE

INDUSTRIAL

COMMERCIAL
INDUSTRIAL
INDUSTRIAL
TAX EXEMPT
PARK AND
RECREATION
PARK AND
RECREATION
OTHER
INDUSTRIAL
OTHER
VACANT
WATER
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' Gross density was measured over a land area, i.e. excluding water, using census blocks.
Where blocks were cut by the edge of a focus area, population was apportioned in proportion to
their area (e.g. if 40% of a census block was in the focus area, it received 40% of its population).
Median block size as calculated for census blocks that had a centroid within the focus area.
More detail on measurement is forthcoming in a protocol document.

“The study sites were selected to represent a subset of the most extreme areas—ranking high or
low on each of these two dimensions—nine sites with high density and small blocks, nine with
high density and big blocks, nine with low density and small blocks, and nine with low density
and big blocks. Of course, given North American development patterns densities are not
particularly extreme in an international sense. Low population density was set at below 5
persons per gross acre for a 0.5*0.5mile area, high density we defined as 10 per acre and above.
All density calculations excluded the land area in water. Originally we had wanted to be closer
to 13 persons/acre but there were not enough candidates from which to sample, particularly for
large blocks. Small median block size was defined as below 5 acres which was related to
standard block sizes in the area. Large blocks were larger than 8 acres. Areas also had to have at
least 20 percent of their land area in residential land use” (Forsyth et al 2004a).

" One additional block was cut out of the sample because its population was only 60 people.
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